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Introduction

STM32CubeMX is a graphical tool for 32-bit ARM® Cortex® STM32 microcontrollers. It is
part of STMCube " initiative (see Section 1) and is available either as a standalone
application or as an Eclipse plug-in for integration in Integrated Development Environments
(IDEs).

STM32CubeMX has the following key features:

e Easy microcontroller selection covering whole STM32 portfolio.

e Board selection from a list of STMicroelectronics boards.

e Easy microcontroller configuration (pins, clock tree, peripherals, middleware) and
generation of the corresponding initialization C code.

e Easy switching to another microcontroller belonging to the same series by
importing a previously-saved configuration to a new MCU project.

e Generation of configuration reports.

e Generation of IDE ready projects for a selection of integrated development
environment tool chains. STM32CubeMX projects include the generated initialization C
code, STM32 HAL drivers, the middleware stacks required for the user configuration,
and all the relevant files needed to open and build the project in the selected IDE.

e Power consumption calculation for a user-defined application sequence.
e Self-updates allowing the user to keep the STM32CubeMX up-to-date.

e Download and update of STM32Cube™ embedded software required for user
application development (see Appendix E: STM32Cube embedded software packages
for details on STM32Cube embedded software offer).

Although STM32CubeMX offers a user interface and generates a C code compliant with
STM32 MCU design and firmware solutions, it is recommended to refer to the product
technical documentation for details on actual implementation of microcontroller peripherals
and firmware.

Reference documents

The following documents are available from http.//www.st.com:
e  STM32 microcontroller reference manuals
e  STM32 microcontroller datasheets

e  STM32Cube HAL driver user manuals for STM32F0 (UM1785), STM32F1 (UM1850),
STM32F2 (UM1940), STM32F3 (UM1786), STM32F4 (UM1725), STM32F7 (UM1905),
STM32L0 (UM1749), STM32L1 (UM1816) and STM32L4 (UM1884).
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UM1718 STM32Cube overview

1 STM32Cube overview

STMCube™ is an STMicroelectronics original initiative to ease developers life by reducing
development efforts, time and cost. STM32Cube covers STM32 portfolio.
STM32Cube includes:

e The STM32CubeMX, a graphical software configuration tool that allows to generate C
initialization C code using graphical wizards.

e A comprehensive embedded software platform, delivered per series (such as
STM32CubeF2 for STM32F2 series and STM32CubeF4 for STM32F4 series)

—  The STM32Cube HAL, an STM32 abstraction layer embedded software, ensuring
maximized portability across STM32 portfolio

— A consistent set of middleware components such as RTOS, USB, TCP/IP,
Graphics
—  All embedded software utilities coming with a full set of examples.
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Getting started with STM32CubeMX

Principles

Customers need to quickly identify the MCU that best meets their requirements (core
architecture, features, memory size, performance...). While board designers main concerns
are to optimize the microcontroller pin configuration for their board layout and to fulfill the
application requirements (choice of peripherals operating modes), embedded system
developers are more interested in developing new applications for a specific target device,
and migrating existing designs to different microcontrollers.

The time taken to migrate to new platforms and update the C code to new firmware drivers
adds unnecessary delays to the project. STM32CubeMX was developed within STM32Cube
initiative which purpose is to meet customer key requirements to maximize software reuse

and minimize the time to create the target system:

e  Software reuse and application design portability are achieved through STM32Cube
firmware solution proposing a common Hardware Abstraction Layer APl across STM32
portfolio.

e  Optimized migration time is achieved thanks to STM32CubeMX built-in knowledge of
STM32 microcontrollers, peripherals and middleware (LwIP and USB communication
protocol stacks, FatFs file system for small embedded systems, FreeRTOS).

STM32CubeMX graphical interface performs the following functions:

e Fast and easy configuration of the MCU pins, clock tree and operating modes for the
selected peripherals and middleware

e  Generation of pin configuration report for board designers

e  Generation of a complete project with all the necessary libraries and initialization C
code to set up the device in the user defined operating mode. The project can be

directly open in the selected application development environment (for a selection of
supported IDEs) to proceed with application development (see Figure 1).

During the configuration process, STM32CubeMX detects conflicts and invalid settings and
highlights them through meaningful icons and useful tool tips.

3
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Figure 1. Overview of STM32CubeMX C code generation flow
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Key features

STM32CubeMX comes with the following features:
Project management
STM32CubeMX allows creating, saving and loading previously saved projects:

When STM32CubeMX is launched, the user can choose to create a new project or
to load a previously saved project.
Saving the project saves user settings and configuration performed within the

project in an .ioc file that will be used the next time the project will be loaded in
STM32CubeMX.

STM32CubeMX also allows importing previously saved projects in new projects.
STM32CubeMX projects come in two flavors:

MCU configuration only: .ioc file are saved anywhere, next to other .ioc files.

MCU configuration with C code generation: in this case .ioc files are saved in a
dedicated project folder along with the generated source C code. There can be
only one .ioc file per project.

Easy MCU and STMicroelectronics board selection

When starting a new project, a dedicated window opens to select either a
microcontroller or an STMicroelectronics board from STM32 portfolio. Different filtering
options are available to ease the MCU and board selection.

Easy pinout configuration

From the Pinout view, the user can select the peripherals from a list and configure
the peripheral modes required for the application. STM32CubeMX assigns and
configures the pins accordingly.

For more advanced users, it is also possible to directly map a peripheral function
to a physical pin using the Chip view. The signals can be locked on pins to prevent
STM32CubeMX conflict solver from moving the signal to another pin.

Pinout configuration can be exported as a .csv file.

Complete project generation

The project generation includes pinout, firmware and middleware initialization C code
for a set of IDEs. It is based on STM32Cube embedded software libraries. The
following actions can be performed:

Starting from the previously defined pinout, the user can proceed with the
configuration of middleware, clock tree, services (RNG, CRC, etc...) and IP
peripheral parameters. STM32CubeMX generates the corresponding initialization
C code. The result is a project directory including generated main.c file and C
header files for configuration and initialization, plus a copy of the necessary HAL
and middleware libraries as well as specific files for the selected IDE.

The user can modify the generated source files by adding user-defined C code in
user dedicated sections. STM32CubeMX ensures that the user C code is
preserved upon next C code generation (the user C code is commented if it is no
longer relevant for the current configuration).

STM32CubeMX can generate user files by using user-defined freemarker .ftl
template files.

From the Project settings menu, the user can select the development tool chain
(IDE) for which the C code has to be generated. STM32CubeMX ensures that the
IDE relevant project files are added to the project folder so that the project can be
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directly imported as a new project within third party IDE (IAR™ EWARM, Keil™
MDK-ARM, Atollic® TrueSTUDIO and AC6 System Workbench for STM32).

Power consumption calculation

Starting with the selection of a microcontroller part number and a battery type, the user
can define a sequence of steps representing the application life cycle and parameters
(choice of frequencies, enabled peripherals, step duration). STM32CubeMX Power
Consumption Calculator returns the corresponding power consumption and battery life
estimates.

Clock tree configuration

STM32CubeMX offers a graphical representation of the clock tree as it can be found in
the device reference manual. The user can change the default settings (clock sources,
prescaler and frequency values). The clock tree is then updated accordingly. Invalid
settings and limitations are highlighted and documented with tool tips. Clock tree
configuration conflicts can be solved by using the solver feature. When no exact match
is found for a given user configuration, STM32CubeMX proposes the closest solution.

Automatic updates of STM32CubeMX and STM32Cube firmware packages

STM32CubeMX comes with an updater mechanism that can be configured for
automatic or on-demand check for updates. It supports STM32CubeMX self-updates
as well as STM32Cube firmware library package updates. The updater mechanism
also allows deleting previously installed packages.

Report generation

.pdf and .csv reports can be generated to document user configuration work.

Rules and limitations

C code generation covers only peripheral and middleware initialization. It is based on
STM32Cube HAL firmware libraries.

STM32CubeMX C code generation covers only initialization code for peripherals and
middlewares that use the drivers included in STM32Cube embedded software
packages. The code generation of some peripherals and middlewares, such as
cryptographic IPs and StemWin graphic library, is not yet supported.

Refer to Appendix A for a description of pin assignment rules.

Refer to Appendix B for a description of STM32CubeMX C code generation design
choices and limitations.
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3 Installing and running STM32CubeMX
3.1 System requirements
3.1.1 Supported operating systems and architectures

e Windows® XP: 32-bit (x86)

e Windows® 7: 32-bit (x86), 64-bit (x64)

e Windows® 8: 32-bit (x86), 64-bit (x64)

e Linux®: 32-bit (x86) and 64-bit (x64) (tested on RedHat, Ubuntu and Fedora)
e  MacOS: 64-bit (x64) (tested on OS X Yosemite)

3.1.2 Memory prerequisites

e Recommended minimum RAM: 2 Gbytes.

3.1.3 Software requirements

The following software must be installed:
e Java Run Time Environment for 1.7.0_45

If Java is not installed on your computer or if you have an old version, STM32CubeMX
installer will open the Java download web page and stop.

e  For Eclipse plug-in installation only, install one of the following IDE:
—  Eclipse IDE Juno (4.2)
—  Eclipse Luna (4.4)
—  Eclipse Kepler (4.3)
—  Eclipse Mars (4.5)

3.2 Installing/uninstalling STM32CubeMX standalone version

3.21 Installing STM32CubeMX standalone version

To install STM32CubeMX, follow the steps below:
1.  Download STM32CubeMX installation package from www.st.com/stm32cubemx.
2. Extract (unzip) stm32cubemx.zip whole package into the same directory.
3. Check your access rights and launch the installation wizard:
On windows:
a) Make sure you have administrators rights.

b) Double click the SetupSTM32CubeMX-VERSION.exe file to launch the installation
wizard.

On Linux:

a) Make sure you have access rights to the target installation director. You can run
the installation as root (or sudo) to install STM32CubeMX in shared directories.
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b) Double click (or launch from the console window) on the SetupSTM32CubeMX-
VERSION.linux file.

On MacOsS:
a) Make sure you have administrators rights.

b) Double click SetupSTM32CubeMX application file to launch the installation
wizard.

4. Upon successful installation of STM32CubeMX on Windows, STM32CubeMX icon is
displayed on your desktop and STM32CubeMX application is available from the
Program menu. STM32CubeMX .ioc files are displayed with a cube icon. Double-click
them to open up them using STM32CubeMX.

5. Delete the content of the zip from your disk.

If the proper version of the Java Runtime Environment (version 1.7_45 or newer) is not
installed, the wizard will propose to download it and stop. Restart STM32CubeMX
installation once Java installation is complete. Refer to Section 9: FAQ for issues when
installing the JRE.

When working on Windows, only the latest installation of STM32CubeMX will be enabled in
the program menu. Previous versions can be kept on your PC (not recommended) when
different installation folders have been specified. Otherwise, the new installation overwrites
the previous ones.

Installing STM32CubeMX from command line

There are 2 ways to launch an installation from a console window: either in console
interactive mode or via a script.

Interactive mode

To perform interactive installation, type the following command:
java —-jar SetupSTM32CubeMX-4.14.0.exe —-console

At each installation step, an answer is requested (see Figure 2 below).
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Figure 2. Example of STM32CubeMX installation in interactive mode

BN Administrator: C\Windows\system32hemd.exe
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Gelect target path [C:“Program Files“5TMicroelectronics~53TM32Cube~STMI2CubeM® ]
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[ Proceszing package: Help ¢3-3) 1
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Auto-install mode
At end of an installation, performed either using STM32CubeMX graphical wizard or console

mode, it is possible to generate an auto-installation script containing user installation
preferences (see Figure 3 below):

Figure 3. STM32Cube Installation Wizard

-

-
Ly 5TM32CubeMX Installation Wizard =01
R — .

Installation Finished Y

Installation has completed successfully.

An uninstaller program has been created in:

C:'Program Files\STMicroelectronics\STM32Cube\STM32CubeMy_4_8_ASYninstaller

@‘ Generate an automatic installation script |

STMicroelectronics

You can then launch the installation just by typing the following command:
java —-jar SetupSTM32CubeMX-4.14.0.exe auto-install.xml

3
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Figure 4. Auto-install command line
[ Administrator: C:\Windows\system32\cmd.exe {ilgli-j \
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3.3

3.3.1
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he STM32CubeM® installer you are attempting to run seems to have a copy already
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his could bhe from a previous failed installation attempt o» you may have accide
Intally launched
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the installer to start. If you are sure there is no other copy of the installer
running, click
the ’‘Yes’ button to allow this installer to run.

Are you sure you want to continue with this installation?
Enter ¥ for Yes, N for No:

Y
[ Starting automated installation 1]
set uninstallName=8TM32CubeMX{2>

Starting to unpack 1]

Processing package: Core <1/3> 1
Processing package: 0ld DataBases (2/3> 1
Processing package: Help <(3/3> 1
Unpacking finished 1

Writing the uninstaller data ... 1
Automated installation done ]

;:\Users\p »

Uninstalling STM32CubeMX standalone version

To uninstall STM32CubeMX on Windows, follow the steps below:
1. Open the Windows Control panel.

2. Select Programs and Features to display the list of programs installed on your
computer.

3. Right click on STM32CubeMX and select the uninstall function.

To uninstall STM32CubeMX on Linux, MacOS and Windows, follow the steps below:

e Use a file explorer, go to the Uninstaller directory of the STM32CubeMX installation,
and double click the startuninstall desktop shortcut.

e or launch manually the uninstallation with java -jar <install
path>/Uninstaller/uninstaller.jar.

Installing STM32CubeMX plug-in version

STM32CubeMX plug-in can be installed within Eclipse IDE development tool chain.
Installation related procedures are described in this section.

Downloading STM32CubeMX plug-in installation package

To download STM32CubeMX plug-in, follow the sequence below:
1. Go to http://www.st.com/stm32cubemx.
2. Download STM32CubeMX- Eclipse-plug-in .zip file to your local disk.

3
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3.3.2 Installing STM32CubeMX as an Eclipse IDE plug-in

To install STM32CubeMX as an Eclipse IDE plug-in, follow the sequence below:
1. Launch the Eclipse environment.

2. Select Help > Install New Software from the main menu bar. The Available Software
window appears.

3. Click Add. The Add Repository window opens.

4. Click Archive. The Repository archive browser opens.

5. Select the STM32CubeMX- Eclipse-plug-in .zip file that you downloaded and click
Open (see Figure 5).

6. Click OK in the Add Repository dialog box,

7. Check STM32CubeMX_Eclipse_plug-in and click Next (see Figure 6).

8. Click Next in the Install Details dialog box.

9. Click "I accept the terms of the license agreement” in the Review Licenses dialog box

and then click Finish.
10. Click OK in the Security Warning menu.

11. Click OK when requested to restart Eclipse IDE (see Section 3.4.2: Running
STM32CubeMX in command-line mode).

Figure 5. Adding STM32CubeMX plug-in archive

= Add Repository &J
MName: Local...

Location: jarfile;/C;/Users/JohnDoe/Temp/STM32CubeMX _eclipseplugi Archive...

'f?:' OK ] l Cancel ‘
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Figure 6. Installing STM32CubeMX plug-in
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3.3.3 Uninstalling STM32CubeMX as Eclipse IDE plug-in
To uninstall STM32CubeMX plug-in in Eclipse IDE, follow sequence below:

1. In Eclipse, right-click STM32CubeMX perspective Icon (see Figure 7) and select Close.

2. From Eclipse Help menu, select Install New Software.
3. Click Installed Software tab, then select STM32CubeMX and click Uninstall.
4. Click Finish in Uninstall Details menu (see Figure 8).

Figure 7. Closing STM32CubeMX perspective

I

Quick Access Ej’| Bg C/C++ [ STMBECubeMXl

= 0
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Figure 8. Uninstalling STM32CubeMX plug-in

= Uninstall l =) &J
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MName Version Id
§* STM32CubeMX 4,0.0.201402121115 com.st.mi¢
< | 11 | 3
Details
STM32CubeMX is a graphical tool enabling users to configure =
More...
@j Next = Finish l l Cancel
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3.4.2
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Launching STM32CubeMX

Running STM32CubeMX as standalone application

To run STM32CubeMX as a standalone application on Windows:
e select STM32CubeMX from Program Files > ST Microelectronics > STM32CubeMX.
e  or double-click STM32CubeMX icon on your desktop.

To run STM32CubeMX as a standalone application on Linux, launch the STM32CubeMX
executable from STM32CubeMX installation directory.

Running STM32CubeMX in command-line mode

To facilitate its integration with other tools, STM32CubeMX provides a command-line mode.
Using a set of commands, you can:

e Load an MCU

e Load an existing configuration

e  Save a current configuration

e  Set project parameters and generate corresponding code

e  Generate user code from templates.

Three command-line modes are available:
e Torun STM32CubeMX in interactive command-line mode, use the following command
line:
— On Windows:
java -jar STM32CubeMX.exe -1
—  On Linux and MacOS:
java -jar STM32CubeMX -1
The “MX>" prompt is then displayed to indicate that the application is ready to accept
commands.
e  Torun STM32CubeMX in command-line mode getting commands from a script, use
the following command line:
—  On Windows:
java -jar STM32CubeMX.exe -s <script filename>
—  On Linux and MacOS:
java -jar STM32CubeMX -s <script filename>

All the commands to be executed must be listed in the script file. An example of script
file content is shown below:

load STM32F417VETx

project name MyFirstMXGeneratedProject

project toolchain "MDK-ARM v4"

project path C:\STM32CubeProjects\STM32F417VETx
project generate

exit

3
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e Torun STM32CubeMX in command-line mode getting commands from a scripts and
without Ul, use the following command line:

—  On Windows:

java -jar STM32CubeMX.exe -g <script filename>

—  On Linux and MacOS:

java -jar STM32CubeMX -g <script filename>

Here again, the user can enter commands when the MX prompt is displayed.

See Table 1 for available commands.

Table 1. Command line summary

Command line Purpose Example
help Display the list of available help
commands
load STM32F101RCT:
load <mcu> Load the selected MCU o8 X

load STM32F101Z(F-G)Tx

config load <filename>

Load a previously saved
configuration

config load
C:\Cube\ccmram\ccmram.ioc

config save <filename>

Save the current configuration

config save
C:\Cube\ccmram\ccmram.ioc

config saveext <filename>

Save the current configuration
with all parameters, including
those for which values have
been kept to defaults
(unchanged by the user).

config saveext
C:\Cube\ccmram\ccmram.ioc

config saveas <filename>

Save the current project under
a new name

config saveas
C:\Cube\ccmram2\ccmram2.ioc

csv pinout <filename>

Export the current pin
configuration as a csv file. This
file could later be imported into
a board layout tool.

Csv pinout mypinout.csv

script <filename>

Run all commands in the script
file. There must be one
command per line.

script myscript.txt

project couplefilesbyip <0|1>

This code generation option
allows choosing between 0 for
generating the peripheral
initializations in the main or 1
for generating each peripheral
initialization in dedicated .c/.h
files.

project couplefilesbyip 1
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Table 1. Command line summary (continued)

Command line

Purpose

Example

generate code <path>

Generate only “STM32CubeMX
generated” code and not a
complete project that would
include STM32Cube firmware
libraries and Toolchains project
files.

To generate a project, use
“project generate”.

generate code C:\mypath

set tpl_path <path>

Set the path to the source folder
containing the .ftl user template
files.

All the template files stored in
this folder will be used for code
generation.

set tpl_path C:\myTemplates\

set dest_path <path>

Set the path to the destination
folder that will hold the code
generated according to user
templates.

set dest_path C:\myMXProject\inc\

get tpl_path

Retrieve the path name of the
user template source folder

get tpl_path

get dest_path

Retrieve the path name of the
user template destination folder.

get dest_path

project toolchain <toolchain>

Specify the tool chain to be
used for the project. Then, use
the “project generate”
command to generate the
project for that tool chain.

project toolchain EWARM
project toolchain “MDK-ARM V4~
project toolchain “MDK-ARM V5”
project toolchain TrueSTUDIO
project toolchain SW4STM32

project name <name>

Specify the project name

project name ccmram

project path <path>

Specify the path where to
generate the project

project path C:\Cube\ccmram

project generate

Generate the full project

project generate

exit

End STM32CubeMX process

exit

Running STM32CubeMX plug-in from Eclipse IDE

To run STM32CubeMX plug-in from Eclipse:
1. Launch Eclipse environment.

Once Eclipse IDE is open, click open new perspective:

iy

2.
3. Select STM32CubeMX to open STM32CubeMX as a perspective (see Figure 9).
4

STM32CubeMX perspective opens (see Figure 10). Enter STM32CubeMX user
interface via the Welcome menus.

To run STM32CubeMX as a standalone application on MacOS, double-click the
STM32CubeMX icon on your desktop.
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Figure 9. Opening Eclipse plug-in
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Figure 10. STM32CubeMX perspective
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Getting STM32Cube updates

STM32CubeMX implements a mechanism to access the internet and to:

e  Perform self-updates of STM32CubeMX and of the STM32Cube firmware packages
installed on the user computer

e Download new firmware packages and patches
Installation and update related sub-menus are available under the Help menu.

Off-line updates can also be performed on computers without internet access (see
Figure 16). This is done by browsing the filesystem and selecting available STM32Cube
firmware zip packages.

If the PC on which STM32CubeMX runs is connected to a computer network using a proxy
server, STM32CubeMX needs to connect to that server to access the internet, get self-
updates and download firmware packages. Refer to Section 3.5.1: Updater configuration for
a description of this connection configuration.

To view Windows default proxy settings, select Internet options from the Control panel and
select LAN settings from the Connections tab (see Figure 11).

Figure 11. Displaying Windows default proxy settings

= Y
\'.}‘ Internet Properties | T el
: General ] Securityl Privacy | Content | Connections | Programs | Advanced
—9 To set up an Internet connection, click ‘ Setup

Setup.

Dial-up and Virtual Private Network settings

| Add. |

‘ | addven. |

‘ Choose Settings if you need to configure a proxy
server for a connection.

‘ Never dial a connectior

‘ Local Area Network (LAN) settings

LAN Settings do not apply to dial-up
connections. Choose Settings above for dial-up
settings.

| 0K ‘ Cancel |

Several proxy types exist and different computer network configurations are possible:

e  Without proxy: the application directly accesses the web (Windows default
configuration).

e  Proxy without login/password

e  Proxy with login/password: when using an internet browser, a dialog box opens and
prompts the user to enter his login/password.

e Web proxies with login/password: when using an internet browser, a web page opens
and prompts the user to enter his login/password.
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If necessary, contact your IT administrator for proxy information (proxy type, http address,
port).

STM32CubeMX does not support web proxies. In this case, the user will not be able to
benefit from the update mechanism and will need to manually copy the STM32 firmware
packages from http://www.st.com/stm32cube to the repository. To do it, follow the sequence
below:

1.

Go to http://lwww.st.com/stm32cube and download the relevant STM32Cube firmware
package from the Associated Software section.

Unzip the zip package to your STM32Cube repository. Find out the default repository
folder location in the Updater settings tab as shown in Figure 12 (you might need to
update it to use a different location or name).

Updater configuration

To perform STM32Cube new library package installation or updates, the tool must be
configured as follows:

1.
2.

Select Help > Updater Settings to open the Updater Settings window.
From the Updater Settings tab (see Figure 12)

a) Specify the repository destination folder where the downloaded packages will be
stored.

b) Enable/Disable the automatic check for updates.

Figure 12. Updater Settings window

Updater Settings ﬁ

Updater Settings | Connection Parameters

Firmware Repository
Repository Folder
C:\Users\JohnDoe\STM32Cube \Repository

Check and Update Settings
) Manual Check

@ Automatic Check Interval between two Checks (days) 5

0K J I Cancel
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3. Inthe Connection Parameters tab, specify the proxy server settings appropriate for
your network configuration by selecting a proxy type among the following possibilities:

—  No Proxy (see Figure 13)
— Use System Proxy Parameters (see Figure 14)
On Windows, proxy parameters will be retrieved from the PC system settings.

Uncheck “Require Authentication” if a proxy server without login/password
configuration is used.

— Manual Configuration of Proxy Server (see Figure 15)

Enter the Proxy server http address and port number. Enter login/password
information or uncheck “Require Authentication” if a proxy server without
login/password configuration is used.

4. Uncheck Remember my credentials to prevent STM32CubeMX to save encrypted
login/password information in a file. This implies reentering login/password information
each time STM32CubeMX is launched.

5. Click the Check Connection button to verify if the connection works. A green check
mark appears to confirm that the connection operates
correctly [ /7 Check Connection ]Z

Figure 13. Connection Parameters tab - No proxy

i |
Updater Settings [ﬁ
Updater Settings | Connection Parameters |

Proxy Server Type

(7)1 Use System Proxy Parameters

(1 Manual Configuration of Proxy Server

Manual Configuration of Proxy Server

Proxy HTTP  |myproxy.mycompany.com Port |B030
Authentication
Require Authentication Remember my Credentials

User Login  (JohnDoe

Pass'r','ﬁl'd FRRERRERRRERREEN

[ /" Check Connection ]

[ oK H Cancel ]
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Figure 14. Connection Parameters tab - Use System proxy parameters

& Updater Settings

=)

Updater Settings | Connection Parameters |

Proxy Server Type
(71 Mo Proxy

(71 Use System Proxy Parameters

(@ Manual Configuration of Proxy Server

Manual Configuration of Proxy Server

Proxy HTTP  |\myproxy.mycompany.com

Authentication

Require Authentication Femember my Credentialg

User Login | JohnDoe

PESEI"\'Drd SRS ERBEERREEREEE

Port |3080

[ & Check Connection ]

[ oK H Cancel ]
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Figure 15. Connection Parameters tab - Manual Configuration of Proxy Server

i |
Updater Settings [é]
Updater Settings | Connection Parameters

Proxy Server Type

~) Mo Proxy
"1 Use System Proxy Parameters

@ Manual Configuration of Proxy Server

Manual Configuration of Proxy Server

Proxy HTTP  |\myproxy.mycompany.com Port 3030

Authentication

Require Authentication Remember my Credentials

User Login  |JohnDoe

Password [ IX XA}

l Q’?Che&Connecﬁon I

[ QK H Cancel I

6. Select Help > Install New Libraries sub-menu to select among a list of possible
packages to install.

7. Ifthe tool is configured for manual checks, select Help > Check for Updates to find out
about new tool versions or firmware library patches available to install.

3.5.2 Downloading new libraries

To download new libraries, follow the steps below:
1. Select Help > Install New Libraries to open the New Libraries Manager window.

If the installation was performed using STM32CubeMX, all the packages available for
download are displayed along with their version including the version currently installed
on the user PC (if any), and the latest version available from http.//www.st.com.

If no Internet access is available at that time, choose “Local File”. Then, browse to
select the zip file of the desired STM32Cube firmware package that has been
previously downloaded from st.com. An integrity check is performed on the file to
ensure that it is fully supported by STM32CubeMX.

The package is marked in green when the version installed matches the latest version
available from http.//www.st.com.

2. Click the checkbox to select a package then “Install Now” to start the download.

See Figure 16 for an example.
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Figure 16. New library Manager window

[ @ Mew Libraries Manager - - - - : - ﬁ1
| All softwares and Firmwares Releases
% Releases Information was last checked 4 days ago.
Sel. Description Installed Version Available version
STM32CubeMX Releases 3
[[] Software to configure and manage STM32 MCUs 4.11.0- 4.12.0

m

STM32CubeF7 Releases

. Firmware Package for Family STM32F7 1.1.0 110
B Firmware Package for Family STM32F7 1.0.0 1.0.0
[ t
STM32CubeF4 Releases
1l . Firmware Package for Family STM32F4 1.8.0 1.8.0
B Firmware Package for Family STM32F4 1.7.0 1.7.0
. Firmware Package for Family STM32F4 1.6.0 1.6.0
. Firmware Package for Family STM32F4 1.5.0 1.5.0
B Firmware Package for Family STM32F4 1.4.0 1.4.0
[T] Firmware Package for Family STM32F4 (Size : 149.93 ME) 1.3.0 i

Technical Description

3
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3.5.3 Removing libraries
Proceed as follows to clean up the repository from old library versions thus saving disk
space:
1. Select Help > Install New Libraries to open the New Libraries Manager window.
2. Click a green checkbox to select a package available in stm32cube repository.

3. Click the Remove Now button and confirm. A progress window then opens to show the
deletion status.

Refer to Figure 17 to Figure 19 for an example.

Figure 17. Removing libraries

Mew Libraries Manager - @

| All Softwares and Firmwares Releases

ﬁd Releases Information was last checked 4 days ago.

Sel. Description Installed Version Available Version
STM32CubeMX Releases

[7] Software to configure and manage STM32 MCUs 4.11.0 4.12.0

m

STM32CubeF7 Releases

Firmware Package for Family STM32F7 1.1.0 1.1.0

Firmware Package for Family STM32F7 1.0.0 1.0.0

STM32CubeF4 Releases

[ B Firmware Package for Family STM32F4 1L8.0 1.8.0
B Firmware Package for Family STM32F4 L7.0 1.7.0
. Firmware Package for Family STM32F4 1.6.0 1.6.0
. Firmware Package for Family STM32F4 1.5.0 1.5.0
B Firmware Package for Family STM32F4 1.4.0 1.4.0
[] Firmware Package for Family STM32F4 (Size : 149.93 ME) 1.3.0 i

Technical Description

STM32CubeF4 Firmware Package V1.6.0 / 28-May-2015
Main Changes

& Add support of System Workbench for STM32 (SW4STM32) toolchain
& Maintenance release to fix known defects, in HAL and Projects

\ Ges | [remmeren ]

1%

r
a
]
=]
)
i

=
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Figure 18. Removing library confirmation message

r N
Mew Library Manager &

— e —

‘o You are about to remove the following firmware pack(s) :
Please note: Once Firmware pack will be removed, You will not anymore be able to generate projects that were based on this pack.

- FW.F4.1.6.0 (C:\Users\frq09031\STM32Cube\Repositorny\STM32Cube_FW_F4_V1.6.0)

Please confirm firmware pack(s) deletion

Figure 19. Library deletion progress window
[ Remaove selected Firmware @1

Deleting 22962 items. .
|

Deleting Firmware STM32Cube_FW_F4_V1.6.0

3.54 Checking for updates

When the updater is configured for automatic checks, it regularly verifies if updates are
available. In this case, a green arrow icon *# appears on the tool bar.

When automatic checks have been disabled in the updater settings window, the user can
manually check if updates are available:

1. Click the icon to open the Update Manager window or Select Help > Check for
Updates. All the updates available for the user current installation are listed.

2. Click the check box to select a package, and then Install Now to download the update.

3
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4 STM32CubeMX User Interface

STM32CubeMX user interface consists of a main window, a menu bar, a toolbar, four views
(Pinout, Configuration, Clock Configuration, Power Consumption Calculator) and a set of
help windows (MCUs selection, Update manager, About). All these menus are described in
the following sections.

For C code generation, although the user can switch back and forth between the different
configuration views, it is recommended to follow the sequence below:

1. Select the relevant IPs and their operating modes from the Pinout view.

2. Configure the clock tree from the clock configuration view.

In the Pinout view, configure the RCC peripheral by enabling the external clocks,
master output clocks, audio input clocks (when relevant for your application). This
automatically displays more options on the Clock tree view (see Figure 23).

3. Configure the parameters required to initialize the IP operating modes from the
configuration view.

4. Generate the initialization C code.

4.1 Welcome page

The Welcome page is the first window that opens up when launching STM32CubeMX
program. It remains open as long as the application is running. Closing it closes down the
application. Refer to Figure 20 and to Table 2 for a description of the Welcome page.

Figure 20. STM32CubeMX Welcome page
+ STM32CubeMX Untitled o 5

File Project Window Help
Howe: &8 2P

New Project
Load Project

Help

3
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Table 2. Welcome page shortcuts

Name Description

Launches STM32CubeMX new project creation by opening the New
New Project project window (select an MCU from the MCU selector tab or a board

configuration from the Board selector tab).
Opens a browser window to select a previously saved configuration (.ioc
file) and loads it.

Load Project Caution: When upgrading to a new version of STM32CubeMX, make
sure to always backup your projects before loading the
new project (especially when the project includes user
code).

Help Opens the user manual.
4.2 New project window

3

This window shows two tabs to choose from:
e The MCU selector tab offering a list of target processors
e A Board selector tab showing a list of STMicroelectronics boards.

The MCU selector allows filtering on various criteria: series, lines, packages, peripherals
and additional MCU characteristics such as memory size or number of 1/Os (see Figure 21).

The Board selector allows filtering on STM32 board types, series and peripherals (see
Figure 22). Only the default board configuration is proposed. Alternative board
configurations obtained by reconfiguring jumpers or by using solder bridges are not
supported.

When a board is selected, the Pinout view is initialized with the relevant MCU part number
along with the pin assignments for the LCD, buttons, communication interfaces, LEDs,
etc...(see Figure 24). Optionally, the user can choose to initialize it with the default
peripheral modes (see Figure 25).

When a board configuration is selected, the signals change to 'pinned', i.e. they cannot be
moved automatically by STM32CubeMX constraint solver (user action on the peripheral
tree, such as the selection of a peripheral mode, will not move the signals). This ensures
that the user configuration remains compatible with the board.
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Figure 21. New Project window - MCU selector

MCU Selector | Board Selector
MCU Filters
Series Lines : Package :
sTM32F4 - [an +| [LoFp1o0 -
I0 =83 Flash >= 592 (KBytes) Ram == 214 {(KBytes)
128 &y 2048 o4 9 2586
Peripheral Selection MCUs List: & Items
Peripherals Nb  Max McU ‘ Lines Package Flash Ram Eeprom 10
F) |l & | [STM32F427VGETx STM32F4... LQFP100 1024 256 0 83 -
@|ADC 12-bit 0 | [sTM3ZFa27VITX STM32F4... [LQFP100 2048 256 0 a3
) STM32F429VGETx STM32F4... LQFP100 1024 256 0 83
@[can 0 STM32F429VITx STM32F4... |LQFP100 2043 258 ] 83
: o] STM32F437VGETx STM32F4... LQFP100 1024 256 0 83
) D STM32F437VIT= ... LQFP100 a
@ (DAC 120t 0 STM32F439VGTx STM32F4... [LQFP100 1024 255 0 83
@ DCMI : STM32F439VITx STM32F4... |LQFP100 2043 258 ] 83
@ [Ethernet ]
& FMC ]
2 el
D ]
) ] 3
[ 0
@[S 0
D ]
2 el
D ]
J —
@RTC 15
@|sAI W
@|sD10 [
@|5PT 0
D O
@TFTLCD (=]
> |4
@ Timer 16-bit 1]
@ Timer 32-bit [u]
) O
| @ |UART 0 ol ki

3

40/231 DoclD025776 Rev 15




UM1718

STM32CubeMX User Interface

Figure 22. New Project window - board selector

MCU Selector | Board Selector

Board Filter

endor

:5TMiCr0E|EdI0ﬂiCS

Peripheral Selection

-

Type of Board :

:Nudeo

[ Initialize all IP with their default Mode

MCL Series :

Al

Boards List: 12 Items

i Peripherals Mb  Max Type Reference MU
o | =] a | [Nudeo NUCLEO-F030R8 STM32F030RE8
o | [Nudeo NUCLEQ-FO070RE STM32F070RE
o (=] Nudeo NUCLEQ-FO072RE STM32F072RE
o (=] Nudeo NUCLEQ-F091RC STM32F091RC
@ |Button 1] Nudeo NUCLEO-F103RE STM32F 103REB
o Nudeo NUCLEO-F302R8 STM32F302R8
o (=] Nudeo NUCLEQ-F303RE STM32F303RE
o (=] Nudeo NUCLEO-F339R8 STM32F339R8
@ |Digital I/0 1] Nudeo NUCLEO-F401RE STM32F401RE
o (=] Nudeo NUCLEO-F411RE STM32F411RE
o (=] Nudeo NUCLEQ-L053R8 STM32L053R8
o Nudeo NUCLEQ-L152RE STM32L152RE
2 O 3
2 [
2 [
2 [
2 O
@|Led 0
2 ]
2 ]
o
2 ]
2 ]
o L
2 ]
o
2 ] -

Board Description

Keys Features :

& On-board ST-LINK/V2-1

# USB VBUS, ext. VIN, ext. 5V, ext +3.3V

# STMicroelectronics Morpho connector : (2 x 38)

@ STMicroelectronics Arduino connector - 10 + (2x 8) + 6
@ Push-buttons: User and Reset

# LEDs: COM, Power, User LEDs

Load User Manual Link to ST WebSite
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4.3

Main window

Once an STM32 part number or a board has been selected or a previously saved project
has been loaded, the main window displays all STM32CubeMX components and menus
(see Figure 23). Refer to Section 4.3 for a detailed description of the toolbar and menus.

Figure 23. STM32CubeMX Main window upon MCU selection

F

o STM32CubeMX Untitled: STM32F43avTx ©~ =~ = * L L "= =
File Project Pinout Window Help
B | By @ O []keep current Signals Placement @ o 0 = @ < F|nd| v|® Show user Label | 121 0 0

Pinout | Clack Configuration I Configuration I Power Consumption Calculat:r|

b_onfiguratinn

|| & Middlewares

- % FATFS
- % FREERTOS

ADC1
ADC2
ADC3

CAN1
CANZ
DAL
DCMI
DMA2ZD
ETH
FMC
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12C3
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1253
IWDG
LTDC
RCC
RNG
RTC
SAI1
SDID
SPI1

88 99 9 9 99 D9 DR DRI

-

STM32F439VITx
LQFP100
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Series Lines MU Package Required Peripherals
STMI2F4 STM22F429/429 STMIZF420VETx LQFP100 MNone -
STMI2F4 STMa2F429/429 STMIZF420WGETH LQFP100 MNone =
STMI2F4 STMa2F429/429 STMIZF420%ITx LQFP100 MNone -
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Selecting a board while keeping the peripheral default modes option unchecked,
automatically sets the pinout for this board. However, only the pins set as GPIOs are
marked as configured, i.e. highlighted in green, while no peripheral mode is set. The user
can then manually select from the peripheral tree the peripheral modes required for his
application (see Figure 24).

Figure 24. STM32CubeMX Main window upon board selection
(Peripheral default option unchecked)

r N
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Selecting a board with the peripheral default modes option checked, automatically sets both
the pinout and the default modes for the peripherals available on the board. This means that
STM32CubeMX will generate the C initialization code for all the peripherals available on the

board and not only for those relevant to the user application (see Figure 25).

Figure 25. STM32CubeMX Main window upon board selection
(Peripheral default option checked)

» STM32CubeMX Untitled: STM32F42971Tx -“- S

File Project Pinout Window Help

8 | & & O [V]Keep Corent Signals Placement 9 ¢ O — @ <4 Find|

w |, oy = [V] Show user Label

npi g

Pinout | Clock Configuration | Configuration | Power Consumption Cal[ulamrl

Configuration -
= Middlewares i
* FATFS

“ FREERTOS

4 ADC1
&\ ADC2
&\ ADC3
€3 CANL
) CAN2
% CRC
d\ DAC
€9 DCMI
% DMAZD
€9 ETH

& e
1201
© 1202

® 1203 L
1252

£ 1253

o IWDG

% LTDC

A\ RCC

% RNG

d\ RTC

Ay sAIL

4\ SDIO

A\ sP11

€9 sp12

+ SPI3

+ SPI4

@ SPIS

9 SPI6 -

1

z
H

STM32F429ZITx
LQFP144

203501 (ACRE S0
120350k [ACP/RF_S0A)

44/231

DoclD025776 Rev 15

3




UM1718

STM32CubeMX User Interface
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441

3

Toolbar and menus

The following menus are available from STM32CubeMX menu bar:

e File menu

e Project menu

e Pinout menu (displayed only when the Pinout view has been selected)
e  Window menu

e Help menu

STM32CubeMX menus and toolbars are described in the sections below.

File menu

Refer to Table 3 for a description of the File menu and icons.

Table 3. File menu functions

Icon Name Description
[:\ New Proiect Opens a new project window showing all supported MCUs and
# ) well as a set of STMicroelectronics boards to choose from

Loads an existing STM32CubeMX project configuration by
selecting an STM32CubeMX configuration .ioc file.

Load Project | caution: When upgrading to a new version of
STM32CubeMX, make sure to always backup your
projects before loading the new project (especially
when the project includes user code).

Opens a new window to select the configuration file to be imported
as well as the import settings.

Import Project The .impor.t is possiblg only if you stgrt from an empty MCU

K| configuration. Otherwise, the menu is disabled.

A status window displays the warnings or errors detected when
checking for import conflicts. The user can then decide to cancel
the import.

Saves current project configuration (pinout, clock tree, IP, PCC) as

L llj Sav:sPrOJect a new project. This action creates an .ioc file with user defined
name and located in the destination folder
LJ Save Project | Saves current project
No icon Close Project | Closes current project and switch back to the welcome page
. Recent . . ) .
No icon Projects > Displays the list of five most recently saved projects
No icon Exit Proposes to save the project if needed then close the application
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4.4.2 Project menu

Refer to Table 4 for a description of the Project menu and icons.

Table 4. Project menu

Icon Name Description

This menu generates C initialization C code for current
configuration (pinout, clocks, peripherals and middleware).
Opens a window for project settings if they have not been
defined previously.

(o] Generate Code | Note: It is recommended to backup the current projects when
upgrading to a new version of STM32CubeMX. The user
will be prompted to migrate to a new firmware library
version if any is available. Select "Continue" to keep the
previously used version.

T Generate This menu generates current project configuration as a pdf file
= Report( and a text file.

This menu opens the project settings window to configure
)': Settings project name, folder, select a toolchain and C code generation
options

1. If the project was previously saved, the reports are generated at the same location as the project
configuration .ioc file. Otherwise, the user can choose the destination folder, and whether to save the
project configuration as an .ioc file or not.

443 Pinout menu

The Pinout menu and sub-menus shortcuts are available only when the Pinout tab is
selected (see Figure 26). They are hidden otherwise (see Figure 27). Refer to Table 5 for a
description of the Pinout menu and icons.

Figure 26. Pinout menus (Pinout tab selected)
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Figure 27. Pinout menus (Pinout tab not selected)
STM32CubeMX Untitled: STM32F439VGTx
File Project Window Help
Bo Ul 65 +— 09§
| F‘inoutl Clock Conﬁgurationl Configuration | Power Consumption Calculator
|C_<mﬁguration ‘
-I-MiddleWares
Table 5. Pinout menu
Icon Name Description
") Undo Undoes last configuration steps (one by one)
- Redo Redoes steps that have been undone (one by one)
Opens a window showing the list of all the configured pins
together with the name of the signal on the pin and a Label field
allowing the user to specify a label name for each pin of the list.
For this menu to be active, at least one pin must have been
No i Pins/Signals | configured.
olicon Options Click the pin icon to pin/unpin signals individually.
Select multiple rows then right click to open contextual menu
and select action to pin or unpin all selected signals at once.
Click column header names to sort alphabetically by name or
according to placement on MCU.
Allows the user to search for a pin name, signal name or signal
Pinout search |label in the Pinout view. When it is found, the pin or set of pins
Find hul field that matches the search criteria blinks on the Chip view. Click
the Chip view to stop blinking.
- - Show user | Allows showing on the Chip view, the user-defined labels
¥ | Ehaw user Labal labels instead of the names of the signals assigned to the pins.

Clears user pinout configuration in the Pinout window. Note that

No icon Clear Pinouts | this action clears from the configuration window the IPs that
have an influence on the pinout.
No icon Clear Single | Clears signal assignments to pins for signals that have no
Mapped Signals | associated mode (highlighted in orange and not pinned).
Opens a window to specify the number of GPIOs to be
configure among the total number of GPIO pins that are not
used yet. Specify their mode: Input, Output or Analog
No icon Se(tBLFJ)rI\gsed (recommended configuration to optimize power consumption).
s
Caution: Before using this menu, make sure the debug pins
(available under SYS peripheral) are set to access
microcontroller debug facilities.
No icon Reset used | Opens a window to specify the number of GPIOs to be freed
GPIOs among the total number of GPIO pins that are configured.

Generate csv

text pinout file Generates pin configuration as a .csv text file

3
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Table 5. Pinout menu (continued)

Icon

Name

Description

Collapse All

Collapses the IP / Middleware tree view

Disable Modes

Resets to “Disabled” all peripherals and middleware modes that
have been enabled. The pins configured in these modes (green
color) are consequently reset to “Unused” (gray color). IPs and
middleware labels change from green to black (when unused)
or gray (when not available).

Expands the IP/Middleware tree view to display all functional

“p Expand All modes.

=2 Zooming in | Zooms in the chip pinout diagram

L Best Fit Adjusts the chip pinout diagram to the best fit size
=% Zooming out | Zooms out the chip pinout diagram

v| Xeep Current Signals Placement

Keep current
signals
Placement

Available from toolbar only.

Prevents moving pin assignments to match a new IP operating
mode. It is recommended to use the new pinning feature that
can block each pin assignment individually and leave this
checkbox unchecked.

44.4 Window menu
The Window menu allows to access the Outputs function (see Table 6).
Table 6. Window menu
Name Description
Opens the MCUs selection window at the bottom of STM32CubeMX Main
window.
Opens two tabs at the bottom of STM32CubeMX main window:
Outputs — MCUs selection tab that lists the MCUs that match the user criteria selected
via the MCU selector.
— Outputs tab that displays STM32CubeMX messages, warnings and errors
encountered upon users actions.
4.4.5 Help menu
Refer to Table 7 for a description of the Help menu and icons.
Table 7. Help menu
Icons Name Description
i § Help Content Opens the STM32CubeMX user manual
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Table 7. Help menu
A About... Shows version information
‘ Shows the software and firmware release updates available for
q Check for Updates
ey download.
Shows all STM32CubeMX and firmware releases available for
ﬁ:}: Install New Libraries | installation. Green check box indicates which ones are already
) installed on you PC and up-to-date.
Opens the updater settings window to configure manual
. versus automatic updates, proxy settings for internet
;)' Updater Settings... . P proxy 9
. connections, repository folder where the downloaded software
and firmware releases will be stored.
4.5 Output windows
451 MCUs selection pane
This window lists all the MCUs of a given family that match the user criteria (series,
peripherals, package..) when an MCU was selected last.
Note: Selecting a different MCU from the list resets the current project configuration and switches
to the new MCU. The user will be prompted to confirm this action before proceeding.
Figure 28. MCU selection menu
MCLs Selection |
Series Lines MU Package Required Peripherals
STM32F4 STM32F429,429 STM32F429YETx LQFP100 RTC,541,50I0 N
STM32F4 STIM32F429,439 STM32F429VGTx LQFP100 RTC,541,5010
STM32F4 STIM32F429,439 STM32F429IT LQFP100 RTC,541,5010
STM32F4 STM32F429,/439 STM32F429ZETx LQFP144 RTC,541,50I0
STM32F4 STM32F429/439 STM32F4292GTx LQFP144 RTC,541,5010 |
STM32F4 STM32F429/439 STM32F42921Tx LQFP144 RTC,541,5010 |
STM32F4 STM32F429/439 STM32F4207E % WLCSP143 RTC,541,5010 |
STM32F4 STM32F429/439 STM32F4202G WLCSP143 RTC,541,5010 |
STM32F4 STM32F429/439 STM32F42021Vx WLCSP143 RTC,541,5010 |
STM32F4 STM32F429/439 STM32F430BGTx LQFFZ08 RTC,541,5010 |
STM32F4 STM32F429/439 STM32F439BITx LQFFZ08 RTC,541,5010 |
STM32F4 STM32F429/439 STM32F4301GH: UFBGA1T6 RTC,541,5010
STMz2F4 STMa2F429/439 STME2F4301IHx UFBGALTE RTC,541,5010
STM32F4 STM32F429/429 STM32F4391G Tx LQFP176 RTC,541,50I0
STM32F4 STM32F429/429 STM32F4301IT% LQFP176 RTC,541,50I0 =
STM32F4 STIM32F429,429 STM32F429MGH: TFEGAZ216 RTC,541,50I0 |
STM32F4 STIM32F429,439 STM32F439NIHs: TFEGAZ16 RTC,541,5010 |
STM32F4 STIM32F429/439 STM32F439VGTx LQFP100 RTC,541,5010 |
|©IsTM3zF4 STM32F429/439 STM32F430ITx LQFP100 RTC,541,5010 |
STM32F4 STM32F429/439 STM32F4392GTx LQFP144 RTC,541,5010 |
STM32F4 STM32F429/439 STM32F43921Tx LQFP144 RTC,541,5010 |
STM32F4 STM32F429,439 STM32F4302G WLCSP143 RTC,541,5010 | |
SThAZ2EL CSThAZZEADD fA20 SThADEADDTT UL = = - =} IRTT SAT SOTT {
This window can be shown/hidden by selecting/unselecting Outputs from the Window
menu.
4.5.2 Output pane

3

This pane displays a non exhaustive list of the actions performed, errors and warnings

raised (see Figure 29).
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Figure 29. Output pane

MCUs Selection | Output |

Loading: 5TM32F411V (C-E)Tx G
Import Analysis: C:\5TM32CubeMX Projects\Test\test\test.ioc project

The Mcu (S5TM32F429ZITx) found in the Project being imported is not the same than the Mcu (S5TM32F411VETx) currently edited
& Import error: DMAZD peripheral does not exist

Import
Importing Pinout ...
Importing IP configurations ...

m

Importing project completed

4.6 Import Project window

The Import Project menu eases the porting of a previously-saved configuration to another
MCU.
By default the following settings are imported:

e  Pinout tab: MCU pins and corresponding peripheral modes.The import fails if the same
peripheral instances are not available in the target MCU.

e  Clock configuration tab: clock tree parameters.
e Configuration tab: peripherals and middleware libraries initialization parameters.
e  Project settings: choice of toolchain and code generation options.

To import a project, proceed as follows:

1. Select the Import project icon ' [3 that appears under the File menu after starting a
New Project and once an MCU has been selected.

The menu remains active as long as no user configuration settings are defined for the

new project, that is just after the MCU selection. It is disabled as soon as a user action

is performed on the project configuration.

2. Select File > Import Project for the dedicated Import project window to open. This

window allows to specify the following options:

—  The STM32CubeMX configuration file (.ioc) pathname of the project to import on
top of current empty project.

—  Whether to import the PCC configuration defined in the Power Consumption
Calculator tab or not.

—  Whether to import the project settings defined through the Project > Settings
menu: IDE selection, code generation options and advanced settings.

—  Whether to import the project settings defined through the Project > Settings
menu: IDE selection and code generation options.

—  Whether to attempt to import the whole configuration (Automatic import) or only a
subset (Manual Import).

a) Automatic project import (see Figure 30)

3
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Figure 30. Automatic project import

S
@ Import Project ﬁ

Imported Project
C:\5TM32CubeMy User Manual MY w4, 12\Import I0C\f4_demo.ioc

Impart MX Settings
[] Impoert PCC Settings
[ Import Project Settings
Import Pinout/Clock Configuration/Configuration Settings
i@ Automatic Import
(7 Manual Import

Import Pinning Status

Import Peripherals Configuration

Peripheral List

From STM32F4271GHx To STM32F401CBUx |
ETH Mone
CAN1 Mone
ADC1 ADC1
ADC2 import to ADCL =
ADC3 import to ADC1
RCC RCC
SPI1 SPI1 | 4
SPIS impart to | SPI2
SPIG import to | SP13 S

Try Import Showe View -Pinout =

Import Status

Loading: C:\BUCEETS\STHM32CubeM¥ User Manual\M¥ v4.12 user guide updates’\Import IO

Import Bnalysis: C:\BUCKETSYSTM32CubeM¥ User Manual‘\M¥ v4.12 user guide updates’\Ir
FU— o R . 5 § . ~
A

e Meou (STM32F427IGH=x) £ 4 in the Prodect being is not the szame tha

heral does not exist

& Import error: CAN1 peri

b Import error: ETH peripheral does not exist

4 mn

b) Manual project import

In this case, checkboxes allow to manually select the set of peripherals (see
Figure 31).

Select the Try Import option to attempt importing.
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Figure 31. Manual project import

Import Project ﬁ

Imported Project
C:\STM32CubeMyX User Manual MY v4. 12\Impart IOCYf4_demo.ioc E

Import M¥ Settings
[7] Import PCC Settings

[] Import Project Settings

Import Pinout/Clock Configuration/Configuration Settings
() Automatic Import

@ ]
Import Pinning Status
Import Peripherals Configuration
Peripheral List
From STM32F4271GHx To STM32F401CBUx it
ETH Mone
CAN1 Mone
ADC1 [¥] ADC1
ADC2 [ | import to ADC1 E
ADC3 [ | import to ADC1
RCC W] RCC
SPI1 ] sPI1
SPIS ] impart to [SPI2 -] -
SPI6 /] import to | SPI3 - +
Try Import Show View .Pinout - -
Import Status

Loading: C:\BUCEETS\S5TM32CubeMX User Manual‘MX w4.12 user guide updates’Imp
Import Analysis: C:\BUCKEETS\S5TM32CubeMX User Manual‘\M¥ w4.12 user guide upc

B The Men (STMIZ2FA27TOE e FrrimAd im the el e iTTma T
b The Mcu (STM3Z2F427IGH=x found in the Project being impor

& Import error: CAN1 peripheral does not exist
& Import error: ETH peripheral does not exist

] 1] | 3

The Peripheral List indicates:
—  The peripheral instances configured in the project to be imported

—  The peripheral instances, if any exists for the MCU currently selected, to which the
configuration has to be imported. If several peripheral instances are candidate for
the import, the user needs to choose one.

Conflicts might occur when importing a smaller package with less pins or a lower-end
MCU with less peripheral options. Click the Try Import button to check for such
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conflicts: the Import Status window and the Peripheral list get refreshed to indicate
errors, warnings and whether the import has been successful or not:

— Warning icons indicate that the user has selected a peripheral instance more than
once and that one of the import requests will not be performed. Figure 32 shows
an example where the ADC1 instance has been selected twice.

— A cross sign indicates that there is a pinout conflict and that the configuration can
not be imported as such. In Figure 32, the SPI16 instance configuration can not be
imported on SPI3 because it conflicts with the previously selected SPI1
configuration.

The manual import can be used to refine import choices and resolve the issues raised
by the import trial. Figure 33 shows how to complete the import successfully, that is, in
this case, by unselecting the request for ADC2 and SPI1 imports.

The Show View function allows switching between the different configuration tabs
(pinout, clock tree, peripheral configuration) for checking influence of the "Try Import"
action before actual deployment on current project (see Figure 33).

3
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Figure 32. Import Project menu - Try import with errors

@ Import Project &

Imported Project
C:\STM32CubeMy User ManualiMx v4. 12\Import I0CYf4_demo.ioc E

Impaort MX Settings
[] Import PCC Settings
[ Import Project Settings

Import Finout/Clock Configuration /Configuration Settings
() Automatic Import
(@ Manual Import
Import Pinning Status
Import Peripherals Configuration
Peripheral List
From STM32F4271GHx To STM32F401CEBUx

»

ETH Mone
CAN1 Mone
ADC1 [¥] 1 ADC1
ADC2 [¥] 1", import ta ADC1 E
ADC3 [ | impart to ADC1
RCC [Z]RCC
SPI1 [¥] 5P
SPIS [¥] import to | SPI2 ) —
SPI6 [¥] €3 import to [SP13 ) =
Show View |Pinout -
Import Status
& Import error: ETH peripheral does not exist -

Import Try
Importing Pinout

.
aar
a1 L IOr

&) SPI import failed

m

%W error: Mode Half-Duplex Master conflicts with: [SPI1 : Mode Full-Duplex Master]
Importing IP configurations
Import project completed

1| 1 2

3
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Figure 33. Import Project menu - Successful import after adjustments

-

@ Import Project

(o]

Imported Project
C:\STM32CubeMy User ManualMx v4, 12\Import IOCf4_demo.ioc

Import MY Settings
[] Import PCC Settings
[] Import Project Settings

Import Pinout/Clock Configuration/Configuration Settings
() Automatic Import

(@ Manual Import
Import Pinning Status
Import Peripherals Configuration

Peripheral List

L]

CAN1 MNone
ADC1 [V] ADC1

( apcz [ import to ADC1 )
ADC3 || import to ADC1
RCC [V] RCC

(sP11 RESH )
5PI5 [¥] import to [SPI2 =)

Show View | Pinout

Import Status
Importing IP configurations ...
Import project completed

Import Try :

Importing Pinout ...
Importing IP configurations ...
Import project completed

4 | 1

m

Choose OK to import with the current status or Cancel to go back to the empty project

without importing.

Upon import, the Import icon gets grayed since the MCU is now configured and it is no

more possible to import a non-empty configuration.
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4.7 Set unused / Reset used GPIOs windows

These windows allow configuring several pins at a time in the same GPIO mode.

To open them:
e  Select Pinout > Set unused GPIOs from the STM32CubeMX menu bar.

Note: The user selects the number of GPIOs and lets STM32CubeMX choose the actual pins to
be configured or reset, among the available ones.

Figure 34. Set unused pins window

ey =

MNumber of GP10s ;‘ d

L —— ]

GPIO Type Input -

I Ok || Cancel

. Select Pinout > Reset used GPIOs from the STM32CubeMX menu bar.

Depending whether the Keep Current Signals Placement option is checked or not on
the toolbar, STM32CubeMX conflict solver will be able to move or not the GPIO signals
to other unused GPIOs:

—  When Keep Current Signals Placement is off (unchecked), STM32CubeMX
conflict solver can move the GPIO signals to unused pins in order to fit in another
peripheral mode.

—  When Keep Current Signals Placement is on (checked), GPIO signals will not be
moved and the number of possible peripheral modes becomes limited.

Refer to Figure 36 and Figure 37 and check the limitation in available peripheral
modes.

Figure 35. Reset used pins window

3
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Figure 36. Set unused GPIO pins with Keep Current Signals Placement checked
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Figure 37. Set unused GPIO pins with Keep Current Signals Placement unchecke
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4.8

Project Settings window

This Project Settings windows includes 3 tabs:

A general project setting tab allowing to specify the project name, the location, the
toolchain, and the firmware version.

A code generation tab allowing to set code generation options such as the location of
peripheral initialization code, library copy/link options, and to select templates for
customized code.

An advanced settings tab dedicated to ordering STM32CubeMX initialization function
calls.

There are several ways to open the Project Settings window:

1.

58/231

By selecting Project > Settings from the STM32CubeMX menu bar (see Figure 38).
The code generation will then be generated in the project folder tree shown in
Figure 39.

By clicking Project > Generate code for the first time.

By selecting Save As for a project that includes C code generation (and not only pin
configuration).
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Figure 38. Project Settings window

-

-
LT

Project Settings

Project | Code Generator | Advanced Settings

Project Settings

Project Name

Projectl
Project Location

C:\STM32CubeMYX_Projects\ForumiTest)

Toolchain Folder Location
C:\STM32CubeMYX_Projects\ForumiTest\Project1)

Toolchain [ IDE
EWARM - Generate Under Root

Other Toolchains (GPDSC) 0

Mcu and Firmware Package

Mcu Reference
STM32F405VGETX

Firmware Package Mame and Version
STM32Cube FW_F4V1.11.0

Browse

Ok ] ’ Cancel
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Figure 39. Project folder

@u?l <« STM32Cube projects » Projectl » - | 4-¢| | Search Proj.. 2 |
Organize - Include in library - Share with - Bun » = ~ [ @
4 JehnDee it Mame }
4 S5TM32Cube projects .
Drivers
Projectl
EWARM
Inc
Src
|| .mxproject
Projectl.ioc
[ 1 T LS
& items
Project tab

The Project tab of the Project Settings window allows configuring the following options (see
Figure 38):

Project settings: project name, location, toolchain folder for toolchain specific
generated files, and toolchain to be used for project generation.

Selecting Other Toolchains (GPDSC) generates a gpdsc file. The gpdsc file provides a
generic description of the project, including the list and paths of drivers and other files
(such as startup files) that are required for building the project. This allows extending
STM32CubeMX project generation to any toolchain supporting gpdsc since the
toolchain will be able to load a STM32CubeMX generated C project by processing the
gpdsc file information. To standardize the description of embedded projects, the gpdsc
solution is based on CMSIS-PACK.

Additional project settings for SW4STM32 and Atollic TrueSTUDIO toolchains:

Select the optional Generate under root checkbox to generate the toolchain project
files in STM32CubeMX user project root folder or unselect it to generate them under a
dedicated toolchain folder.

STM32CubeMX project generation under the root folder allows to benefit from the
following Eclipse features when using Eclipse-based IDEs such as SW4STM32 and
TrueStudio:

—  Optional copy of the project into the Eclipse workspace when importing a project.
— Use of source control systems such as GIT or SVN from the Eclipse workspace.

However, it shall be noted that choosing to copy the project into workspace will prevent
any further synchronization between changes done in Eclipse and changes done in
STM32CubeMX as there will be 2 different copies of the project.

Linker settings: value of minimum heap and stack sizes to be allocated for the
application. The default values proposed are 0x200 and 0x400 for heap and stack
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3

sizes, respectively. These values may need to be increased when the application uses
middleware stacks.

e Firmware package selection when more than one version is available (this is the case
when successive versions implement the same API and support the same MCUs). By
default, the latest available version is used.

Code Generator tab

The Code Generator tab allows specifying the following code generation options (see
Figure 40):

e  STM32Cube Firmware Library Package option

e  Generated files options

e HAL settings options

e  Custom code template options

STM32Cube Firmware Library Package option

The following actions are possible:
e  Copy all used libraries into the project folder

STM32CubeMX will copy to the user project folder, the drivers libraries (HAL, CMSIS)
and the middleware libraries relevant to the user configuration (e.g. FatFs, USB, ..).

e  Copy only the necessary library files:

STM32CubeMX will copy to the user project folder only the library files relevant to the
user configuration (e.g., SDIO HAL driver from the HAL library,...).

e Add the required library as referenced in the toolchain project configuration file

By default, the required library files are copied to the user project. Select this option for
the configuration file to point to files in STM32CubeMX repository instead: the user
project folder will not hold a copy of the library files but only a reference to the files in
STM32CubeMX repository.

Generated files options

This area allows defining the following options:

e  Generate peripheral initialization as a pair of .c/.h files or keep all peripheral
initializations in the main.c file.

e  Backup previously generated files in a backup directory
The .bak extension is added to previously generated .c/.h files.
Keep user code when regenerating the C code.

This option applies only to user sections within STM32CubeMX generated files. It does
not apply to the user files that might have been added manually or generated via fil
templates.

e Delete previously generated files when these files are no longer needed by the current
configuration. For example, uart.c/.h file are deleted if the UART peripheral, that was
enabled in previous code generation, is now disabled in current configuration.
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HAL settings options

This area allows selection one HAL settings options among the following:
e Set all free pins as analog to optimize power consumption
e Enable/disable Use the Full Assert function: the Define statement in the

stm32xx_hal_conf.h configuration file will be commented or uncommented,
respectively.

Custom code template options

To generate custom code, click the Settings button under Template Settings, to open the
Template Settings window (see Figure 41).

The user will then be prompted to choose a source directory to select the code templates
from, and a destination directory where the corresponding code will be generated.

The default source directory points to the extra_template directory, within STM32CubeMX
installation folder, which is meant for storing all user defined templates. The default
destination folder is located in the user project folder.

STM32CubeMX will then use the selected templates to generate user custom code (see
Section 5.2: Custom code generation). Figure 42 shows the result of the template
configuration shown on Figure 41: a sample.h file is generated according to sample_h.ftl

3
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template definition.

Figure 40. Project Settings Code Generator
@ Project Settings ﬁ1

[ Project| Code Generator | Advanced Settings

STM32Cube Firmware Library Package

@ Copy all used libraries into the project folder:

() Copy only the necessary library files

() Add necessary library files as reference in the toolchain project configuration file

Generated files
[ "] Generate peripheral initialization as a pair of .c/.h' files per IP
[7] Backup previously generated files when re-generating
Keep User Code when re-generating

Delete previously generated files when not re-generated

HAL Settings
[7] set all free pins as analog (to optimize the power consumption)

[] Enable Full Assert

Template Settings

Select a template to generate customized code Settings...
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Figure 41. Template Settings window

r B
o) Tempat Seting Jrp—p— -

Template Settings
Source Folder

[7] Use defauilt location

Location: C:\Program Files\STMicroelectronics\STM32Cube\STM32CubeMx|\db\extra_tem;

Select your templates

Available Templates Selected Templates
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Destination Folder
Use default location
Location: C:\Users\JohnDoe\5TM32Cube projects\Projecti\Project1 Browse

oK ] [ Cancel
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Figure 42. Generated project template
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Advanced Settings tab

Figure 43 shows the case of several peripheral and/or middleware selections. By default the
peripheral/middleware initialization functions are called in the order in which they have been
enabled. The user can choose to re-order them by modifying the Rank number using the up
and down arrow buttons. A reset button allows switching back to alphabetical order. If the

Not to be generated checkbox is checked, STM32CubeMX does not generate the call to the

peripheral initialization function. It is up to the user code to do it.

Useful tooltips are also available by hovering the mouse over the different options.
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Figure 43. Advanced Settings window

= .
% Project Settings ﬁ

| Projectl Code Generatorl Advanced Settings |

- Generated Function Calls
Rank Function Mame IP Instance Mame Mot to be generated
1 My _GPIO_Init GPIO
2 MY_CRC_Init CRC ]
3 M¥_LTDC_Init LTDC ]
4 M¥_SAT1_Init SAT1 ]
5 M¥_TIMS_Init
& MYX_USART1_UART Init  |USART1 [

Update Manager windows

Three windows can be accessed through the Help menu available from STM32CubeMX
menu bar:

1.

Select Help > Check for updates to open the Check Update Manager window and
find out about the latest software versions available for download.

2. Select Help > Install new libraries to open the New Libraries Manager window and

find out about the software packages available for download. It also allows removing
previously installed software packages.

3. Select Help > Updater settings to open the Updater settings window and configure

update mechanism settings (proxy settings, manual versus automatic updates,
repository folder where STM32Cube software packages are stored).

3
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410 About window

This window displays STM32CubeMX version information.
To open it, select Help > About from the STM32CubeMX menu bar.

Figure 44. About window

( About &J‘

STM32CubeMX

Version 4.14.0
STM32Cube V1.0 1
http:iiwww.st.com/stm32cube

I, m—
" augmented

411 Pinout view

The Pinout view helps the user configuring the MCU pins based on a selection of
peripherals/middleware and of their operating modes.

Note: For some middleware (USB, FATS, LwiP), a peripheral mode must be enabled before
activating the middleware mode. Tooltips guide the user through the configuration.

For FatFs, a user-defined mode has been introduced. This allows STM32CubeMX to
generate FatFs code without a predefined peripheral mode. Then, it will be up to the user to
connect the middleware with a user-defined peripheral by updating the generated
user_diskio.c/.h driver files with the necessary code.

Since STM32 MCUs allow a same pin to be used by different peripherals and for several
functions (alternate functions), the tool searches for the pinout configuration that best fits the
set of peripherals selected by the user. STM32CubeMX highlights the conflicts that cannot
be solved automatically.

The Pinout view left panel shows the IP tree and the right pane, a graphical representation
of the pinout for the selected package (e.g. BGA, QFP...) where each pin is represented with
its name (e.g. PC4) and its current alternate function assignment if any.

3
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Note:

STM32CubeMX offers two ways to configure the microcontroller:

o From the IP tree by clicking the peripheral names and selecting the operating modes
(see Section 4.11.1: IP tree pane).

e For advanced users, by clicking a pin on the Chip view to manually map it to a
peripheral function (see Section 4.11.2: Chip view).

In addition, selecting Pinout > Set unused GPIOs allows configuring in one shot several
unused pins in a given GPIO mode.

The Pinout view is automatically refreshed to display the resulting pinout configuration.

Pinout relevant menus and shortcuts are available when the Pinout view is active (see the
menu dedicated sections for details on the Pinout menus).

Figure 45. STM32CubeMX Pinout view
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Note:

IP tree pane

In this pane, the user can select the peripherals, services (DMA, RCC,...), middleware in the
modes corresponding to the application.

The peripheral tree panel is also accessible from the Configuration view. However, only the
peripherals and middleware modes without influence on the pinout can be configured

through this menu.

Icons and color schemes

Table 8 shows the icons and color scheme used in the IP tree pane.

Table 8. IP tree pane - icons and color scheme

Display Peripheral status
The peripheral is not configured (no mode is set) and all
S modes are available.
ADC1 The peripheral is configured (at least one mode is set) and all
other modes are available
i\ ADC3 The peripheral is configured (one mode is set) and at least
g one of its other modes is unavailable.
4\ ADC2 The peripheral is not configured (no mode is set) and at least
: one of its modes is unavailable.
The peripheral is not configured (no mode is set) and no
‘&3 ETH mode is available. Move the mouse over the IP name to
display the tooltip describing the conflict.
CAN1 Available peripheral mode configurations are shown in plain
Mode iDisahIe black.

- &, DCMI
DCMI Disable
[ LY Disable

A\ ETH |Slave-8-bits-Embedded-Synchro
Fsmc|Slave-8-bits-External-Synchro

12C3

The warning yellow icon indicates that at least one mode
configuration is no longer available.

‘&) ETH

When no more configurations are left for a given peripheral
mode, this peripheral is highlighted in red.

@

us| LWIP: LightWeight TCP/IP Not available:
Active only with ETH IP configured

& mms T

Some modes depends on the configuration of other
peripherals or middleware modes. A tooltip explains the
dependencies when the conditions are not fulfilled.
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4.11.2

Chip view
The Chip view shows, for the selected part number:

e The MCU in a specific package (BGA, LQFP...)

e  The graphical representation of its pinout, each pin being represented with its name
(e.g. PC4: pin 4 of GPIO port C) and its current function assignment (e.g.
ETH_MII_RXDO) (see Figure 46 for an example).

The Chip view is automatically refreshed to match the user configuration performed via the
peripheral tree. It shows the pins current configuration state.

Assigning pins through the Chip view instead of the peripheral pane requires a good
knowledge of the MCU since each individual pin can be assigned to a specific function.

Tips and tricks

. Use the mouse wheel to zoom in and out.

e Click and drag the chip diagram to move it. Click best fit to reset it to best suited
position and size (see Table 5).

e Use Pinout > Generic CSV pinout text file to export the pinout configuration into text
format.

e  Some basic controls, such as insuring blocks of pins consistency, are built-in. See
Appendix A: STM32CubeMX pin assignment rules for details.

Figure 46. Chip view
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Icons and color schemes

Table 9 shows the icons and color scheme used in the Chip view.

Table 9. STM32CubeMX Chip view - Icons and color scheme

Display

Pin information

(26)-PF8:
& ADC3_ING (IN6G)

Tooltip indicates the selected pin current configuration: alternate function
name, Reset state or GPIO mode.

Move your mouse over the pin name to display it.

When a pin features alternate pins corresponding to the function currently
selected, a popup message prompts the user to perform a CTRL + click to
display them.

The alternate pins available are highlighted in blue.

—m

PILO
Reset_State
ETH_RX_ER
FMC_D31
GPIO_Analog
GPIO_Input
GPIO_Output
EVENT_OUT
aweans | GPIO_EXTILO

oea I

List of alternate functions that can be selected for a given pin. By default,
no alternate function is configured (pin in reset state).

Click the pin name to display the list.

Reset_State
ADCI_EXTI1
ADCZ_EXTI1
ADC3_EXTIT1

12C2_SDA
TIM2_CH4
USART3_RX
USB_OTG_HS_ULPL_D4
GPIO_Analeg
GFIO_Input
GPIO_Output
EVENT_OUT
GPIO_EXTI11

When a function has been mapped to the pin, it is highlighted in blue.

When it corresponds to a well configured peripheral mode, the list caption
is shown in green.

I

Boot and reset pins are highlighted in khaki. Their configuration cannot be

changed.

3
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Table 9. STM32CubeMX Chip view - Icons and color scheme (continued)

Display Pin information
VDD
W55 Power dedicated pins are highlighted in yellow. Their configuration cannot
RE.. be changed.
VDD
PF1 ) . .
Non-configured pins are shown in gray (default state).
PF2
When a signal assignment corresponds to a peripheral mode without
ADC3_ING ambiguity, the pin color switches to green.

When the signal assignment does not correspond to a valid peripheral
mode configuration, the pin is shown in orange. Additional pins need to be
configured to achieve a valid mode configuration.

RCC_OSC32_IN

When a signal assignment corresponds to a peripheral mode without
ambiguity, the pins are shown in green.

2z 5o S As an example, assigning the PF2 pin to the 12C2_SMBA signal matches
22 5o gl to 12C2 mode without ambiguity and STM32CubeMX configures
1207 sMah [Eo) automatically the other pins (PFO and PF1) to complete the pin mode
configuration.
Tooltips

Move the mouse over IPs and IP modes that are unavailable or partially available to display
the tooltips describing the source of the conflict that is which pins are being used by which
peripherals.

As an example (see Figure 47), the Ethernet (ETH) peripheral is no longer available
because there is no possible mode configuration left. A tooltip indicates to which signal are
assigned the pins required for this mode (ADC1-INO signal, USART3 synchronous signal,
etc...).

Figure 47. Red highlights and tooltip example: no mode configuration available

ETH -
B 0is2ble - :
MC -

12C1 Mode Conflict with
pc pe  |ADC3:INO or/and
12C2 Active only when TIM2 has enabled the Pulse Per Second Output or/and

B oisabie] ADCL : IN1 or/and

12013 ADC1 : INO or/and

1252 USART3 : Synchronous or/and
1253 ADC1 : IN2

In the next example (see Figure 48), the SDIO peripheral is partially available because at
least one of its modes is unavailable: the necessary pins are already assigned to the 12C
mode of the 12C3 peripheral.
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Figure 48. Orange highlight and tooltip example: some configurations unavailable

& 4 soio
- “Mode Disable v

SP11
[ o SPI2
SPI3

Mode Conflict with
12C3:12C12C

In this last example (see Figure 49) 12C2 peripheral is unavailable because there is no
mode function available. A tooltip shows for each function where all the remapped pins have
been allocated (USART3 synchronous mode).

Figure 49. Tooltip example: all configurations unavailable

- &3 12C2
‘---;Disab\e
B hv.# Disable
- 12C Conflict with
e USART3 : Mode Synchronous
B
-6 BROC h

4.11.3 Chip view advanced actions

Manually modifying pin assignments

To manually modify a pin assignment, follow the sequence below:

1. Click the pin in the Chip view to display the list of all other possible alternate functions
together with the current assignment highlighted in blue (see Figure 50).

2. Click to select the new function to assign to the pin.

Figure 50. Modifying pin assignments from the Chip view

LA

Reset_State

USART3_TX
USB_OTG_HS_ULP1_D3
GPI0_Analog
GPIO_Input

GPIO_Output
EVENT_OUT
F{GPI0_EXTIL0
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Caution:

Note:

74/231

Manually remapping a function to another pin

To manually remap a function to another pin, follow the sequence below:

1. Press the CTRL key and click the pin in the Chip view. Possible pins for relocation, if
any, are highlighted in blue.

2. Drag the function to the target pin.

A pin assignment performed from the Chip view overwrites any previous assignment.

Manual remapping with destination pin ambiguity

For MCUs with block of pins consistency (STM32F100x/ F101x/ F102x/ F103x and
STM32F105x/F107x), the destination pin can be ambiguous,e.g. there can be more than
one destination block including the destination pin. To display all the possible alternative
remapping blocks, move the mouse over the target pin.

A "block of pins" is a group of pins that must be assigned together to achieve a given
peripheral mode. As shown in Figure 51, two blocks of pins are available on a
STM32F107xx MCU to configure the Ethernet Peripheral in RMII synchronous mode: {PC1,
PA1, PA2, PA7, PC4, PC5, PB11, PB12, PB13, PB5} and {PC1, PA1, PA2, PD10, PD9,
PD8, PB11, PB12, PB13, PB5}.

Figure 51. Example of remapping in case of block of pins consistency

pco D14
ETH_RMI_MDC [J8 Foi3 |

STM32F107VBTX
LQFP100

ETH_rmi1_REF_Cuk [1F8 ETH_RMIT_TXD1
ETH_RMi_mpio [H 2| ETH_RMI_TxDO

STM32F107VBTx bo
LQFP100 ETH_RMII_RXD1

| ETH_RMIT_RxD0
ETH_RMIT_CRS DV

ETH_RMIT_REF_CLK |38 ETH_RMIT_TXD1
ETH_RMII_MpIO (18] B ETH_RMII_TXDO

[ERTwiTETEN 118d

Resolving pin conflicts

To resolve the pin conflicts that may occur when some peripheral modes use the same pins,
STM32CubeMX attempts to reassign the peripheral mode functions to other pins. The
peripherals for which pin conflicts could not be solved are highlighted in red or orange with a
tooltip describing the conflict.
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411.4

Note:

3

If the conflict cannot be solved by remapping the modes, the user can try the following:

e If the [¥|Keep Current Signals Placement box is checked, try to select the peripherals in a
different sequence.

e Uncheck the Keep Current Signals Placement box and let STM32CubeMX try all the
remap combinations to find a solution.

e Manually remap a mode of a peripheral when you cannot use it because there is no
pin available for one of the signals of that mode.

Keep Current Signals Placement

This checkbox is available from the toolbar when the Pinout view is selected (see Figure 26
and Table 5). It can be selected or unselected at any time during the configuration. It is
unselected by default.

It is recommended to keep the checkbox unchecked for an optimized placement of the
peripherals (maximum number of peripherals concurrently used).

The Keep Current Signals Placement checkbox should be selected when the objective is
to match a board design.

Keep Current Signals Placement is unchecked

This allows STM32CubeMX to remap previously mapped blocks to other pins in order to
serve a new request (selection of a new IP mode or a new IP mode function) which conflicts
with the current pinout configuration.

Keep Current Signals Placement is checked

This ensures that all the functions corresponding to a given peripheral mode remain
allocated (mapped) to a given pin. Once the allocation is done, STM32CubeMX cannot
move a peripheral mode function from one pin to another. New configuration requests are
served if it is feasible within current pin configuration.

This functionality is useful to:

e Lock all the pins corresponding to peripherals that have been configured using the
Peripherals panel.

e Maintain a function mapped to a pin while doing manual remapping from the Chip view.
Tip
If a mode becomes unavailable (highlighted in red), try to find another pin remapping

configuration for this mode by following the steps below:

1. From the Chip view, unselect the assigned functions one by one until the mode
becomes available again.

2. Then, select the mode again and continue the pinout configuration with the new
sequence (see Appendix A: STM32CubeMX pin assignment rules for a remapping
example). This operation being time consuming, it is recommended to unselect the
Keep Current Signals Placement checkbox.

Even if Keep Current Signals placement is unchecked, GPIO_ functions (excepted
GPIO_EXTI functions) are not moved by STM32CubeMX.
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4.11.5
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Pinning and labeling signals on pins

STM32CubeMX comes with a feature allowing the user to selectively lock (or pin) signals to
pins: This will prevent STM32CubeMX from automatically moving the pinned signals to
other pins when resolving conflicts. There is also the possibility to label the signals: User
labels are used for code generation (see Section 5.1 for details).

STM32CubeMX comes with a feature allowing the user to selectively lock (or pin) signals to
pins. This prevents STM32CubeMX from automatically moving pinned signals to other pins
when resolving conflicts. Labels, that are used for code generation, can also be assigned to
the signals (see Section 5.1 for details).

There are several ways to pin, unpin and label the signals:

1. From the Chip view, right-click a pin with a signal assignment. This opens a contextual
menu:
a) For unpinned signals, select Signal Pinning to pin the signal. A pin icon is then
displayed on the relevant pin. The signal can no longer be moved automatically
(for example when resolving pin assignment conflicts).

b) For pinned signals, select Signal Unpinning to unpin the signal. The pin icon is
removed. From now on, to resolve a conflict (such as peripheral mode conflict),
this signal can be moved to another pin, provided the Keep user placement option
is unchecked.

c) Select Enter User Label to specify a user defined label for this signal. The new
label will replacing the default signal name in the Chip view.

2. From the pinout menu, select Pins/Signals Options
The Pins/Signals Options window (see Figure 52) lists all configured pins.
a) Click the first column to individually pin/unpin signals.

b) Select multiple rows and right-click to open the contextual menu and select
Signal(s) Pinning or Unpinning.

3
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Figure 52. Pins/Signals Options window

»

Pin Marme Signal Name User Label
PA0ANKUP ETH_CRS
Pal ETH_RX¥_CLK
PAZ ETH_MDIO
P2 ETH_COL

DAC_OUT1

DaAC_OUT2
PA7 ETH_RX_D¥
PEO ETH_RXDZ2
FB1 ETH_RXD3
PBR10 ETH_RX_ER
FPB11 ETH_TX_EMN
FB12 ETH_TxDO
PE13 ETH_TXD1

| Pe14 1252_ext_SD
PE1S [252_SD
= 1252 WS
[ Apply ] l Ok l [ Cancel

c) Select the User Label field to edit the field and enter a user-defined label.

d) Order list alphabetically by Pin or Signal name by clicking the column header.
Click once more to go back to default i.e. to list ordered according to pin
placement on MCU.

Even if a signal is pinned, it is still possible however to manually change the pin signal
assignment from the Chip view: click the pin to display other possible signals for this pin and
select the relevant one.

Setting HAL timebase source

By default, the STM32Cube HAL is built around a unique timebase source which is the
ARM-Cortex system timer (SysTick).

However, HAL-timebase related functions are defined as weak so that they can be
overloaded to use another hardware timebase source. This is strongly recommended when
the application uses an RTOS, since this middleware has full control on the SysTick
configuration (tick and priority) and most RTOSs force the SysTick priority to be the lowest.

Using the SysTick remains acceptable if the application respects the HAL programming
model, that is, does not perform any call to HAL timebase services within an Interrupt
Service Request context (no dead lock issue).

To change the HAL timebase source, go to the SYS peripheral in the IP tree pane and
select a clock among the available clock sources: SysTick, TIM1, TIM2,... (see Figure 53).
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Figure 53. Selecting a HAL timebase source (STM32F407 example)

B % 5YS

é----DEbug :Disable "":

- [[1] System Wake-Up

» Timebase Source 51J"ST|C|'~’~|—*""|
Lo v
- & TIM2 E:;_ 1
o TIM3 S 1
-- = TIMA TIM< B
G- & TIMS [TIM5
- & TIMG TTMe
G- & TIM7 L -
f- & TIMB

When used as timebase source, a given peripheral is grayed and can no longer be selected
(see Figure 54).

Figure 54. TIM2 selected as HAL timebase source

é----DEbug :Disable
----- || System Wake-p
E--Tlmebase Source :'I'IME _)
- & TIM1
il TIM2 is no longer available as Timer periphe

=
o
kad
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As illustrated in the following examples, the selection of the HAL timebase source and the

use of FreeRTOS influence the generated code.

Example of configuration using SysTick without FreeRTOS

As illustrated in Figure 55, the Systick priority is set to 0 (High) when using the Systick
without FreeRTOS.

Figure 55. NVIC settings when using systick as HAL timebase, no FreeRTOS

- ™
& NVIC Cenfiguration ﬁ

fed NVIC | o/ Code generah’on|

Priority Group :4 bits for pre-emption prierity O bits for subpriarity - [] Sort by Premption Prierity and Sub Prority

Search Search (CrHl+F) E] @ [] Show only enabled interrupts

Interrupt Table Enabled Preemption Priority Sub Priority

*

|Mon maskable interrupt
Hard fault interrupt
Memory management fault
Pre-fetch fault, memory access fault
{lUndefined instruction or ilegal state
||Debug maonitor
||T|me base: System tick timer
|PVD interrupt through EXTI line 16
Flash global interrupt
RCC global interrupt

[ ) o e e e e e
[=R = =T = ] ) e =

Enabled Preemption Priority Sub Priority

[ Apply ][ Ok H Cancel

3

Interrupt priorities (in main.c) and handler code (in stm32f4xx_it.c) are generated

accordingly:

e main.c file

/* SysTick_IRQn interrupt configuration */
HAL_NVIC_SetPriority(SysTick_IRQn, 0, 0);

o stm32f4xx_it.c file

/**

* @brief This function handles System tick timer.
*/

void SysTick_Handler (void)

{
/* USER CODE BEGIN SysTick_IRQn 0 */
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/* USER CODE END SysTick IRQn 0 */

HAL_IncTick() ;

HAL_SYSTICK_IRQHandler () ;
/* USER CODE BEGIN SysTick_IRQOn 1 */

/* USER CODE END SysTick IRQn 1 */

}

Example of configuration using SysTick and FreeRTOS

As illustrated in Figure 56, the Systick priority is set to 15 (Low) when using the SysTick with

FreeRTOS.

Figure 56. NVIC settings when using FreeRTOS and SysTick as HAL timebase

-

@ " NVIC Configuration

===

q’7 MVIC | Qf? Code generaﬁon|

Search Search (Crtl+F)

Priority Group i4 bits for pre-emption priority O bits for subpriority -

[7] Sort by Premption Pricrity and Sub Prority

@ [7] Show only enabled interrupts

Interrupt Table
Mon maskable interrupt

Enabled

Preemption Priority

Sub Priority

Hard fault interrupt

Memory management fault

Pre-fetch fault, memory access fault

||Undeﬁned instruction or illegal state

|[pebug menitor

0
0
0
0

(=] =) = T

"TIITIE base: System tick timer

|[PvD interrupt through EXTI line 15

Flash global interrupt

15
5
5
5

=T =) =T

I RCC global interrupt

Enabled Preemption Priority

Sub Priority

[_Aemty |

Ok

] [ Cancel
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As shown in the code snippets given below, the SysTick interrupt handler is updated to use
CMSIS-os osSystickHandler function.

e main.cfile
/* SysTick_IRQn interrupt configuration */

HAL_NVIC_SetPriority (SysTick_IRQn, 15, 0);

e stm32f4xx_it.c file
/**
* @brief This function handles System tick timer.
*/
void SysTick_Handler (void)
{
/* USER CODE BEGIN SysTick_IRQn 0 */

/* USER CODE END SysTick_IRQn 0 */
HAL_IncTick();
osSystickHandler () ;

/* USER CODE BEGIN SysTick_IRQn 1 */

/* USER CODE END SysTick IRQn 1 */
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Example of configuration using TIM2 as HAL timebase source

When TIM2 is used as HAL timebase source, a new stm32f4xx_hal_timebase_TIM.c file is
generated to overload the HAL timebase related functions, including the HAL_InitTick
function that configures the TIM2 as the HAL time-base source.

The priority of TIM2 timebase interrupts is set to 0 (High). The SysTick priority is set to 15
(Low) if FreeRTOS is used, otherwise it is set to 0 (High).

Figure 57. NVIC settings when using freeRTOS and TIM2 as HAL timebase

- ™
@ NVIC Configuration ﬁ

fqd’ NVIC | o Code generaﬁon|
Priority Group :4 bits for pre-emption priority 0 bits for subpriority - [ Sort by Premption Priority and Sub Prority
Search Search (Cril+F) @ @ [] Show enly enabled interrupts
Interrupt Table Enabled Preemption Priority Sub Priority
||Mon maskable interrupt 0 0 -
Hard fault interrupt 0 0
Memaory management fault 0 0 I
Pre-fetch fault, memory access fault 0 0
||Undeﬁned instruction or ilegal state 0 0
Debug monitor 0 0
stem tick timer 15 H | 0
PVD interrupt through EXTI line 16 =] 5 0
i Flash global interrupt ] 5 ]
RCC global interrupt [l 5 ] I
I ime base: TIM2 global interrupt 0 j 0
Enabled Preemption Priority Sub Priority
Apply ] [ Ok ] [ Cancel

The stm32f4xx_it.c file is generated accordingly:

e  SysTick_Handler calls osSystickHandler when FreeRTOS is used, otherwise it calls
HAL_SYSTICK_IRQHandler.

o TIM2_IRQHandler is generated to handle TIM2 global interrupt.

3
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Configuration view

STM32CubeMX Configuration window (see Figure 58) gives an overview of all the
software configurable components: GPIOs, peripherals and middleware. Clickable buttons
allow selecting the configuration options of the component initialization parameters that will
be included in the generated code. The button icon color reflects the configuration status:

e  Green checkmark: correct configuration
e  Warning sign: incomplete but still functional configuration
e Red cross: for invalid configuration.

Note:

They are read-only in the Configuration view.

GPIO and Peripheral modes that influence the pinout can be set only from the Pinout view.

In this view, the MCU is shown on the left pane by its IP tree and on the right pane, by the list
of IPs organized in Middleware, Multimedia, Connectivity, Analog, System and Control
categories. Each peripheral instance has a dedicated button to edit its configuration: as an
example, TIM1 and TIM3 TIM instances are shown as dedicated buttons in Figure 58.

Figure 58. STM32CubeMX Configuration view

-
%' STM32CubeMX STM32CubeﬁSlmpIeLedToggle‘|9c": ST.M32F4JU?VGT)~ pa——

File Project Window Help
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Plnnutl Clock Configuration | Configuration | Power Consumption Calculamr‘

Configuration
Ehviddlewares
- ® FATFS

L #use

B % LwIp
-[¥] Enabled
) ® USB_HOST
*-Class for FS P [MSC_FS
|| =1ps
B4 ADC1
LM Se
E-® canL
| -Master Mode: Set
N E % CRC
[ Activated
- ® DAC
| "~ OUTL Configuration: Set
-4\ DCMI

- ® ETH

. Mode MII

-4 FSMC

. NAND Flash 1

; NCEZ chip select: Set
| e % IWDG

[T Activated
< | 1 ] »

| - DCMLSlave 8 bits Frmbed

s

m

Middlewares

I FATFS ofa, l I FREERTOS ":'rt,w l I LiIF E{ l I

USE_HOST === »

|

[ hamd £

I Do v, ] l CANL oy ] l A0C1 VL, ] l DA Q+ l l TIML §5g ]
Py

I ETH ey ] [ DAC i, ] I GPIO —%, I [ TIM3 €75, ]

An IP configuration button is associated to each peripheral in the Configuration window
(see Table 10).
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Table 10. IP configuration buttons

Format Peripheral Instance configuration status

Available but not fully configured yet. Click to open the

pma 1=1 ‘ : o
| = configuration window.

Well configured with default or user-defined settings
| that allows proceeding with the generation of
corresponding initialization C code. Click to open the
configuration window.

| ETH 1%“

Badly configured with some wrong parameter values.
Click to display the errors highlighted in red.

Other example (UART):
Baud Rate A& 1000000 Bits/s

% TIM4 Configuration ﬁ

Al Please select a Trigger Source in the Pinout view Dialog box that explains source of error. It shall be
fixed in another view.

GPIO, DMA and NVIC settings can be accessed either via a dedicated button like other IPs
or via a tab in the other configuration windows of the IPs which use them (see Figure 59).

Figure 59. Configuration window tabs for GPIO, DMA and NVIC settings (STM32F4 series)

- ™
@ 5SDIO Cenfiguration ﬁ

| Q:/) Parameter Settings | Q:/} User Constants | Q_’/} MVIC Settings | Q_’/) DMA 5ettings| Qﬂ GPIO Settings |

Search Signals

Search (CrtH+F) [] Show only Modified Fins
-

Fin Mame Signal on Fin  GPIOPin State  GPIOmode  GPIO Pull-up... Maximum ou... User Label Modified
|PCa SDIO_DO nfa Alternate Fun... [Mo pull-up an... |High ]
{Pca SDI0_D1 n/a Alternate Fun... [No pull-up an... |High &
{PC1o SDIO D2 n/a Alternate Fun... [No pull-up an... [High T

PC11 SDIO_D3 nfa Alternate Fun... |No pull-up an... |High ]
fPciz SDIO_CK n/a Alternate Fun... [Mo pull-up an... |High ]
i{Po2 SDIO_CMD n/a Alternate Fun... [No pull-up an... |High ]

|?| Select Pins from table to configure them. Multiple selection is Allowed.

[ Apply ] [ Ok ] [ Cancel

3
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IP and Middleware Configuration window

This window is open by clicking the IP instance or Middleware name from the
Configuration pane. It allows to configure the functional parameters that are required for
initializing the IP or the middleware in the selected operating mode. This configuration is
used to generate the corresponding initialization C code. Refer to Figure 60 for an IP
Configuration windows example.

The configuration window includes several tabs:

Parameter settings to configure library dedicated parameters for the selected
peripheral or middleware,

NVIC, GPIO and DMA settings to set the parameters for the selected peripheral (see
Section 4.12.5: NVIC Configuration window, Section 4.12.3: GPIO Configuration
window and Section 4.12.4: DMA Configuration windowfor configuration details).

User constants to create one or several user defined constants, common to the whole
project (see Section 4.12.2: User Constants configuration window for user constants
details).

Invalid settings are detected and are either:

Reset to minimum valid value if user choice was smaller than minimum threshold,
Reset to maximum valid value if user choice was greater than maximum threshold,

Reset to previous valid value if previous value was neither a maximum nor a minimum
threshold value,

Highlighted in red: # 1000000 Bits/s

Table 11 describes IP and middleware configuration buttons and messages.

Figure 60. IP Configuration window (STM32F4 series)

r ~
SDIO Configuration @

«f Parameter Settings | o/ User Constants | o/ NVIC Settings | o/ GPIO Settings | / DMA Setiings|

Configure the below parameters :

[=] SDIO parameters
510G ko o

Description Pane

SDIOCLK clock divide factor ~

ClockDiv must be between 0 and 255,

Parameter Description:

SDIO_CK = SDIOCLK [ [CLKDIV + 2]. The output dock frequency can vary between 187 KHz and 24 MHz, Itis advised to
keep the default ClockDiv value (0) to hawve a maximum SDIO_CK frequency of 24 MHz,

[ Apply ] [ Ok ] [ Cancel
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Table 11. IP Configuration window buttons and tooltips

Buttons and messages

Action

Apply Saves the changes without closing the window
OK Saves and closes the window
Cancel Closes and resets previously saved parameter settings

Shows and Hides the description pane

Tooltip

Guides the user through the settings of parameters with valid min-max
range.

To display it, moves the mouse over a parameter value from a list of
possible values. _ o

feiy MW ]
Stop Bits

sed Parameters

Data Direction
Over Samnlina

UART_PARITY_EVEN

16 Samnles

Hexadecimal vs decimal
values

Choose to display the field as an hexadecimal or a decimal value by
clicking the arrow on the right:

s
Timeout 0x00008061 Hexadecimal

Timeout Time (ns) I

TIMEOUT _time must be between 25 000 000 and 35 000 000.
0x17d7840 Decimal
Timeout 0x00008000 w o

3
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User Constants configuration window

A User Constants window is available to define user constants (see Figure 61). Constants
are automatically generated in the STM32CubeMX user project within the mxconstants.h file
(see Figure 62). Once defined, they can be used to configure peripheral and middleware
parameters (see Figure 63).

Figure 61. User Constants window

=
@ SDIO Configuration M
| o Parameter Settings | =/ User Constants | o/ NVIC Settings | o/ GPIO Settings | o/’ DMA Settings
Search Constants
Search (Cril+F) remowve
Constant Mame Constant Value
COMSTANT_1 10
CONSTANT_2 Duff
CONSTANT_3 CONSTANT_1
CONSTANT_4 (CONSTANT_3+CONSTANT_1)*100/CONSTANT_1
CONSTANT_5 (CONSTANT_2 - CONSTANT_1) I
[ Apply ] [ Ck ] [ Cancel
Figure 62. Extract of the generated mxconstants.h file
/* Includes ------————————-——"""""""""— *f
/* USER CODE BEGIN Includes */
/* USER CODE END Includes */
/* private define ---------------------------------------------.... ’ oo o - =/
#define CONSTANT 1 10
#define CONSTANT 2 OxIf
#define CONSTANT 3 CONSTANT 1
#define CONMSTANT 4 (CONSTANT 3+CONSTANT 1)+100/CONSTANT 1
#define CONSTANT 5 (CONSTANT 2 - CONSTANT 1)
/* USER CODE BEGIN Priwvate defines */
/* USER CODE END Priwvate defines */
DoclD025776 Rev 15 87/231




STM32CubeMX User Interface UM1718

88/231

Figure 63. Using constants for peripheral parameter settings

-

@ SDIO Cenfiguration [ﬁ

o/ Parameter Settings | o7 User Constants | </ NVIC Settings | </ GPIO Settings | </’ DMA Settings |

Configure the below parameters :

[=] SDIOQ parameters
SDIOCLE dodk divide factor CONSTANT_1|

[ Apply ] [ Ok ] [ Cancel

Creating/editing user constants

Click the Add button to open the User Constants window and create a new user-defined
constant (see Figure 64).

A constant consists of:
e A name that must comply with the following rules:

It must be unique.

It shall not be a C/C++ keyword.
It shall not contain a space.

It shall not start with digits.

e Avalue
The constant value can be: (see Figure 61 for examples):

a simple decimal or hexadecimal value
a previously defined constant

a formula using arithmetic operators (subtraction, addition, division, multiplication,
and remainder) and numeric value or user-defined numeric constants as
operands.

a character string: the string value must be between double quotes (example:
“constant_for_usart”).

3
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Once a constant is defined, its name and/or its value can still be changed: double click the
row that specifies the user constant to be modified. This opens the User Constants window
for edition. The change of constant name is applied wherever the constant is used. This
does not affect the peripheral or middleware configuration state. However changing the
constant value impacts the parameters that use it and might result in invalid settings (e.g.
exceeding a maximum threshold). Invalid parameter settings will be highlighted in red with a
red cross.

Figure 64. Specifying user constant value and name

r© -
User Constants lﬁj
constant Mame COMSTAMT_1
constant Value 10
| K | | Cancel
L

Deleting user constants

Click the Remove button to delete an existing user-defined constant.

The user constant is then automatically removed except in the following cases:

e When the constant is used for the definition of another constant. In this case, a popup
window displays an explanatory message (see Figure 65).

Figure 65. Deleting user constant not allowed when
constant already used for another constant definition

v |
Delete user constant warning: Li—hJ

! . Cannot delete, the selected user constant is used in the definition of another constant !

oK | | Cancel

e  When the constant is used for the configuration of a peripheral or middleware library
parameter. In this case, the user is requested to confirm the deletion since the constant
removal will result in a invalid peripheral or middleware configuration (see Figure 66).
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Figure 66. Deleting a user constant used for parameter configuration-
Confirmation request

- |
@ Delete user constant warning: M

h The selected user constant is used in the configuration of some ips! Are you sure you want to delete it 7

Clicking Yes leads to an invalid peripheral configuration (see Figure 67))

Figure 67. Deleting a user constant used for peripheral configuration -
Consequence on peripheral configuration

-

@ SDIO Cenfiguration [éj

| & Parameter Settings | /7 User Constants | o/’ NVIC Settings | </ GPIO Settings | </ DMA Settings

Configure the below parameters ;

= % SDIO parameters
SDIOCLEK dock divide factor & COMSTANT_2

[ Apply ] l Ok l [ Cancel
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Searching for user constants

The Search Constants field allows searching for a constant name or value in the complete

list of user constants (see Figure 68 and Figure 69).

Figure 68. Searching user constants list for name

r Y
@ SDIO Configuration ﬁ
o/ Parameter Settings | «/ User Constants | o/ NIC Settings | o/ GPIO Settings |/ DMA Settings |

Search Constants
CONSTANT_4 [ add | [ remove
Constant Name Constant Value
CONSTANT_4 |(COMSTANT_3+CONSTANT_1)*100/CONSTANT _1
[ Apply ] [ Ok ] [ Cancel
o
Figure 69. Searching user constants list for value

F B
@ SDIO Cenfiguration ﬂ
o Parameter Settings | © User Constants | o/ NVIC Settings | o/ GPIO Settings | o/’ DMA Settings |

Search Constants
10 ’ add ] [ remove
Constant Name Constant Valus
CONSTANT_1 10
’ Apply ] [ Ok ] ’ Cancel
b
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412.3 GPIO Configuration window

Click GPIO in the Configuration pane to open the GPIO configuration window that allows
configuring the GPIO pin settings (see Figure 70). The configuration is populated with
default values that might not be adequate for some peripheral configurations. In particular,
check if the GPIO speed is sufficient for the peripheral communication speed and select the
internal pull-up whenever needed.

Note: GPIO settings can also be accessed for a specific IP instance via the dedicated GPIO
window in the IP instance configuration window.

In addition, GPIOs can be configured in output mode (default output level). The generated
code will be updated accordingly.

Figure 70. GPIO Configuration window - GPIO selection

- B
@ Pin Configuration ﬂ

GPI0 | apct | apc2 | ETH | spio|

Search Signals

Search (Crt+F) [] Show only Modified Pins
-

Pin Name Signal on Pin GPIO Fin State GPIO mode GPIO Pull-up/... Maximum out... User Label Modified
FD10 nfa nfa Input mode Mo pull-up and ... |nfa [l
FD11 nfa Low Output Push Pull [MNo pull-up and ... |Low ]
PD12 nfa nfa Analog mode Mo pull-up and ... |n/fa &

Output Push Pull Mo pull-up and ...

PD13 Configuration :

GPIO Pin State High v

GPIO mode |Output Push Pul -

GPIO Pull-up/Pull-down :No pull-up and no pull-down -

Maximum output speed :Low -

User Label

] Group By IP [ Apply ] [ Ok ] ’ Cancel
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Click a row or select a set of rows to display the corresponding GPIO parameters (see
Figure 71):

) GPIO PIN state

It changes the default value of the GPIO Output level. It is set to low by default and can
be changed to high.

e  GPIO mode (analog, input, output, alternate function)

Selecting an IP mode in the Pinout view automatically configures the pins with the
relevant alternate function and GP1O mode.

e  GPIO pull-up/pull-down
It is set to a default value and can be configured when other choices are possible.
e  GPIO maximum output speed (for communication IPs only)

Itis set to Low by default for power consumption optimization and can be changed to a
higher frequency to fit application requirements.

° User Label

It changes the default name (e.g. GPIO_input) into a user defined name. The Chip
view is updated accordingly. The GPIO can be found under this new name via the Find
menu.

Figure 71. GPIO Configuration window - displaying GPIO settings
f % Pin Configuration L&J1

| 610 | ADci | apcz| 12€1 1202 | 1263

Search Signals

Search (Crtl+F) [] Show only Maodified Pins
-
Pin Name Signal on Pin GPIO Fin State GPIO mode GPIO Pull-up/... Maximum out... User Label Modified
BS Cl 3 Alternate Pull-up g
FET 12C1 SDA nfa Alternate Func... |Pull-up High [&]

PB& Configuration :

GPIO mode :Alhernate Function Open Drain - I
GPIO Pull-up/Pul-down :Pull-up - I
Maximum output speed :High -
User Label

|| Group By 1P [ Apply ] [ ok ] ’ Cancel ]

A

A Group by IP checkbox allows to group all instances of a peripheral under a same window
(see Figure 72).
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Figure 72. GPIO configuration grouped by IP

GPIO | ADC | 12C

Search Signals

Search (Crtl+F) Show only Modified Pins

Fin Name Signalﬁon Fin GPIO Fin State GPIO mode GPIO Pull-up/... Maximum out... User Label Modified

I PBG [2C1_SCL nfa Alternate Func... [Pull-up High (&

I FET I2C1 SDA nia Alternate Func... |Pull-up High (&
PE10 12C2_SCL nfa Alternate Func... |Pull-up High (&
FBE11 12C2_SDA nfa Alternate Func... [Pull-up High (&
FPAG 12C3 SCL nia Alternate Func... |Pull-up High (&
PC9 [2C3_SDA nfa Alternate Func... |Pull-up High (&

12| Select Pins from table to configure them. Multiple selection is Allowed.

f

ooty ] [ ok ][ concd ]

As shown in Figure 73, row multi-selection can be performed to change a set of pins to a
given configuration at the same time.

Figure 73. Multiple Pins Configuration

GFIO | ADC | I2C

Search Signals

Search (Crtl+F) Show only Modified Pins

-
Pin Name Signal on Pin | GPIO Pin State GPIO mode  GPIC Pull-up... Maximum ou... User Label Modified
I Ftb 1201 _SCL n/a Alternate Fun... [Full-up High [ i
PB7 12C1 SDA n/fa Alternate Fun... [Pull-up High [&
PE10 12C2_SCL n/ja Alternate Fun... [Pull-up High [&] H
v
7 -
PB11#PAS Configuration :
GPIO mode [ |
GPIO Pull-up/Pull-down [Pull—up - ]
Maximum output speed [Fast - ]
GPIO Speed
User Label [ |
Group By IP Apply ] ’ ok ] ’ Cancel ]
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412.4 DMA Configuration window
Click DMA in the Configuration pane to open the DMA configuration window.
This window allows to configure the generic DMA controllers available on the MCU. The
DMA interfaces allow to perform data transfers between memories and peripherals while the
CPU is running, and memory to memory transfers (if supported).
Note: Some IPs such as USB or Ethernet, have their own DMA controller, which is enabled by

3

default or via the IP configuration window.

Clicking Add in the DMA configuration window adds a new line at the end of the DMA
configuration window with a combo box proposing to choose between possible DMA
requests to be mapped to peripherals signals (see Figure 74).

Figure 74. Adding a new DMA request

DMA Configuration Iﬁ

| DMA1| DMAZ | MemToMem|

DMA Request Stream Direction Priority

|Select

MEMTOMEM
SPIS_RX
SPIS_TX

add | [ Delete |
DMA Request Settings
Peripheral Memaory
Mode Mormal Increment Address
Use Fifo Threshold | One Quarter Full Data Width Byte Byte
Burst Size Single Single
[ Apply H Ok ” Cancel ]

b

Selecting a DMA request automatically assigns a stream among all the streams available, a
direction and a priority. When the DMA channel is configured, it is up to the application code
to fully describe the DMA transfer run-time parameters such as the start address, etc....

The DMA request (called channel for STM32F4 MCUSs) is used to reserve a stream to
transfer data between peripherals and memories (see Figure 75). The stream priority will be
used to decide which stream to select for the next DMA transfer.

DMA controllers support a dual priority system using the software priority first, and in case of
equal software priorities, a hardware priority that is given by the stream number.
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Figure 75. DMA Configuration

-

:

DMAL | pmMA2 | MemToMem|

DMA Request Stream Direction Priority
12C1_RX DMA1 Stream 0 Peripheral To Memo Lows

DMAL Stream 6 Memory To Peripheral  Low

[ Add ] [ Delete ]
DMA Request Settings
Peripheral Memory

Mode  |Normal v Increment Add... ] ]
Use Fifo []  Thres... |Half Full ~|  Data width Byte  w| | |Byte -

Burst Size Single - Single -

L
’ Apply ” Ok ][ Cancel ] IJ

Additional DMA configuration settings can be done through the DMA configuration
window:

Mode: regular mode, circular mode, or peripheral flow controller mode (only available
for the SDIO IP).

Increment Add: the type of peripheral address and memory address increment (fixed
or post-incremented in which case the address is incremented after each transfer).
Click the checkbox to enable the post-incremented mode.

Peripheral data width: 8, 16 or 32 bits

Switching from the default direct mode to the FIFO mode with programmable threshold:
a) Click the Use FIFO checkbox.

b) Then, configure the peripheral and memory data width (8, 16 or 32 bits).

c) Select between single transfer and burst transfer. If you select burst transfer,
choose a burst size (1, 4, 8 or 16).

In case of memory-to-memory transfer (MemtoMem), the DMA configuration applies to a
source memory and a destination memory.

3
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Figure 76. DMA MemToMem configuration

[ |
DMA Configuration @
DMA1 | DMAZ2 | MemToMem |
DMA Reguest Stream Direction Priority
MEMTOMEM DMAZ2 Stream 0 Memory To Memory Low

| Add | [ Delete |
DMA Request Settings
Src Memory Dst Memory
Mode Normal - Increment Address [ [
|Use Fifo Threshold |Half Full - Data Width Byte - Byte -
Burst Size Single - Single -
[ Apply ] [ Ok ] [ Cancel

412.5 NVIC Configuration window

Click NVIC in the Configuration pane to open the Nested Vector interrupt controller

configuration window (see Figure 77).

Interrupt unmasking and interrupt handlers are managed within 2 tabs:

e  The NVIC tab allows enabling peripheral interrupts in the NVIC controller and setting
their priorities.

e The Code generation tab allows selecting options for interrupt related code
generation.

Enabling interruptions using the NVIC tab view

The NVIC view (see Figure 77) does not show all possible interrupts but only the ones
available for the IPs selected in the Pinout and Configuration panes. System interrupts
are displayed but can never be disabled.

Check/Uncheck the Show only enabled interrupts box to filter or not enabled interrupts.

Use the search field to filter out the interrupt vector table according to a string value. As an
example, after enabling UART IPs from the Pinout pane, type UART in the NVIC search
field and click the green arrow close to it: all UART interrupts are then displayed.

Enabling a peripheral interrupt will generate of NVIC function calls
HAL_NVIC_SetPriority and HAL_NVIC_EnablelRQ for this peripheral.

3
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Figure 77. NVIC Configuration tab - FreeRTOS disabled

F h
% NVIC Configuration ﬁ
‘e NVIC}| o7 Code generaﬁonl
Prigrity Group j4 bits for pre-emption priority O bits for subpriority - [ Sort by Premption Priority and Sub Prority
Search E] @ |:| Show only enabled interrupts

Interrupt Table Enabled Preemption Priority Sub Priority
MNon maskable interrupt (o] 0 -
Hard fault interrupt (o] 0
Memory management fault (o] 0
Pre-fetch fault, memory access fault (o] 0
Undefined instruction or ilegal state (u] 0
System service call via SWT instruction (o] 0
Debug monitor (o] 0
Pendable request for system service (u] 0
Time base: System tick timer (o] 0
PVD interrupt through EXTI line 16 ] (o] 0
Flash global interrupt ] 0 0
RCC global interrupt ] i} 0
12C1 event interrupt ] 0 0
12C1 error interrupt ] 0 ]

SPI1 global interrupt ] i} 0
SPI2 global interrupt ] i} 0
USB On The Go F5 global interrupt ] 0 0
FPU global interrupt ] i} 0
Enabled Preemption Priority Sub Priority
[ Apply ] [ Ok ] [ Cancel ]
L

When FreeRTOS is enabled, an additional column is shown (see Figure 78). In this case, all
the interrupt service routines (ISRs) that are calling the interrupt safe FreeRTOS APIs,
should have a priority lower than the priority defined in the
LIBRARY_MAX_SYSCALL_INTERRUPT_PRIORITY parameter (the highest the value, the
lowest the priority). The check in the corresponding checkbox guarantees that the restriction
is applied.

If an ISR does not use such functions, the checkbox can be unchecked and any priority level
can be set.

It is possible to check/uncheck multiple rows at a time (see rows highlighted in blue in
Figure 78).
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Figure 78. NVIC Configuration tab - FreeRTOS enabled
@ NVIC Configuration u

eﬁ’ NVIC | Qﬁ’ Code generaﬁonl

Priority Group [4 bits for pre-emption priority 0 bits for subpriority - ] [] Sert by Premption Priority and Sub Prority
Search | Search (Crtl+F) | E] @ [] Show only enabled interrupts
Interrupt Table Enabled = Preemption Priority Sub Priority  Uses FreeRTOS functions
MNon maskable interrupt (o] 0 -
Hard fault interrupt o] 0
Memory management fault ] 0 ]
Pre-fetch fault, memary access fault (o] 0 ]
Undefined instruction or ilegal state 0 0 ]
| ||System service call via SWI instruction 0 0 ]
Debug monitor 0 0 ]
" ||Pendable request for system service 15 0
Time base: System tick timer 15 0
PVD interrupt through EXTI line 15 5 0
Flash global interrupt 5 0
R.CC global interrupt 5 0

I12C1 event interrupt

I2C1 error interrupt

SPI1 global interrupt

SPI2 global interrupt

USE On The Go FS global interrupt
FPU global interrupt |

HEEEEEE

EEEElERIEEE
==

[T]Enabled Preemption Priority Sub Priority [ Uses FreeRTOS functions

Eaply || ok | [ cancel |

IP dedicated interrupts can also be accessed through the NVIC window in the IP
configuration window (see Figure 79).

Figure 79. 12C NVIC Configuration window

-
& [2C1 Configuration u

| o/ Parameter Settings | «// User Constants |:/’ NVIC Settings || /7 GPIO Settings | /7 DMA Settings

Interrupt Table Enabled Preemption Priority Sub Priority
12C1 eventinterrupt Vv 0 0

12C1 error interrupt 0 0

oo ] [0 ) G

3
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STM32CubeMX NVIC configuration consists in selecting a priority group, enabling/disabling
interrupts and configuring interrupts priority levels (preemption and sub-priority levels):

1.

Select a priority group

Several bits allow to define NVIC priority levels. These bits are divided in two priority

groups corresponding to two priority types: preemption priority and sub-priority. For

example, in the case of STM32F4 MCUs, the NVIC priority group 0 corresponds to 0-

bit preemption and 4-bit sub-priority.

In the interrupt table, click one or more rows to select one or more interrupt vectors.

Use the widgets below the interrupt table to configure the vectors one by one or several

at a time:

— Enable checkbox: check/uncheck to enable/disable the interrupt.

—  Preemption priority: select a priority level. The preemption priority defines the
ability of one interrupt to interrupt another.

—  Sub-priority: select a priority level. The sub-priority defines the interrupt priority
level.

—  Click Apply to save changes, and OK to close the window.

Code generation options for interrupt handling

The Code Generation view allows customizing the code generated for interrupt initialization
and interrupt handlers:

Selection/Unselection of all interrupts for sequence ordering and IRQ handler
code generation

Use the checkboxes in front of the column names to configure all interrupts at a time
(see Figure 80). Note that system interrupts are not eligible for init sequence reordering
as the software solution does not control it.

3
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Figure 80. NVIC Code generation — All interrupts enabled

-
@ NVIC Configuration

et

lm‘ Q/? Code generation ’

Enabled interrupt table
Mon maskable interrupt

Select for init sequence ardering

Generate IRQ handler

|Hard fault interrupt

|Memary management fault

||Pre-fetch fault, memory access fault

||Undefined instruction or illegal state

| Debug monitor

ime base: System tick timer
Flash global interrupt

RCC global interrupt

ADC1, ADC2 and ADC3 global interrupts

CAN1TX interrupts

12C1 eventinterrupt

<< ===

EEEEEEEEEEEE

Interrupt unmasking ordering table (interrupt init code is moved after all the peripheral init code)

Rank Interrupt name
1 Flash global interrupt
2 RCC global interrupt
3 ADC1, ADC2 and ADC3 global interrupts
4 CAN1TX interrupts
5 12C1 eventinterrupt

[_#emty ] |

H Cancel l

Default initialization sequence of interrupts

By default, the interrupts are enabled as part of the peripheral MSP initialization
function, after the configuration of the GPIOs and the enabling of the peripheral clock.

This is shown in the CAN example below, where HAL_NVIC_SetPriority and
HAL_NVIC_EnablelRQ functions are called within stm32xxx_hal_msp.c file inside the

peripheral msp_init function.

Interrupt enabling code is shown in green.
void HAL_CAN_MspInit (CAN_HandleTypeDef* hcan)

{

GPIO_InitTypeDef GPIO_InitStruct;

if (hcan->Instance==CAN1)
{

/* Peripheral clock enable */

__ CAN1_CLK_ENABLE() ;

/**CAN1 GPIO Configuration
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1=3510 J > CAN1_RX
130 A ——— > CAN1_TX
*/

GPIO_InitStruct.Pin = GPIO_PIN_O0|GPIO_PIN_1;
GPIO_InitStruct.Mode = GPIO_MODE_AF_PP;
GPIO_InitStruct.Pull = GPIO_NOPULL;
GPIO_InitStruct.Speed = GPIO_SPEED_FREQ_VERY_HIGH;
GPIO_InitStruct.Alternate = GPIO_AF9_ CANI1;
HAL_GPIO_Init (GPIOD, &GPIO_InitStruct);

/* Peripheral interrupt init */

HAL_NVIC_SetPriority (CAN1_TX_IRQn, 2, 2);

HAL_NVIC_EnableIRQ (CAN1_TX_TIRQn) ;

}
}

For EXTI GPIOs only, interrupts are enabled within the MX_GPIO_Init function:
/*Configure GPIO pin : MEMS_INT2_Pin */

GPIO_InitStruct.Pin = MEMS_INT2_Pin;

GPIO_InitStruct.Mode = GPTO_MODE_EVT_RISING;

GPIO_InitStruct.Pull = GPIO_NOPULL;

HAL_GPIO_Init (MEMS_INT2_GPIO_Port, &GPIO_InitStruct);

/* EXTI interrupt init*/
HAL_NVIC_SetPriority (EXTI15_10_IRQn, 0, 0);
HAL_NVIC_EnableIRQ (EXTI15_10_IRQn) ;

For some peripherals, the application still needs to call another function to actually
activate the interruptions. Taking the timer peripheral as an example, the function
HAL_TIM_IC_Start_IT needs to be called to start the Timer input capture (IC)
measurement in interrupt mode.
Configuration of interrupts initialization sequence
Checking Select for Init sequence ordering for a set of peripherals moves the
HAL_NVIC function calls for each peripheral to a same dedicated function, named
MX_NVIC_lInit, defined in the main.c. Moreover, the HAL_NVIC functions for each
peripheral are called in the order specified in the Code generation view bottom part
(see Figure 81).
As an example, the configuration shown in Figure 81 generates the following code:

/** NVIC Configuration

*/

void MX_NVIC_Init (void)

{
/* CAN1_TX_IRQn interrupt configuration */
HAL_NVIC_SetPriority (CAN1_TX IRQn, 2, 2);
HAL_NVIC_EnableIRQ(CAN1_TX_TIRQn) ;
/* PVD_IRQn interrupt configuration */
HAL_NVIC_SetPriority (PVD_IRQn, 0, 0);

3
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HAL_NVIC_EnableIRQ (PVD_IRQn) ;

/* FLASH_TIRQn interrupt configuration */
HAL_NVIC_SetPriority(FLASH_IRQn, 0, 0);
HAL_NVIC_EnableIRQ (CAN1_IRQn) ;

/* RCC_IRQn interrupt configuration */
HAL_NVIC_SetPriority (RCC_IRQn, 0, 0);
HAL_NVIC_EnableIRQ (CAN1_IRQn) ;

/* ADC_IRQn interrupt configuration */
HAIL_NVIC_SetPriority (ADC_IRQn, 0, 0);
HAL_NVIC_EnableIRQ (ADC_IRQn) ;

Figure 81. NVIC Code generation — Interrupt initialization sequence configuration

& NVIC Configuration

I dmﬂc JCodegenerab‘onl

Enabled interrupt table
| maskable interrupt

[ Select for init sequence ordering

[7] Generate IRQ handler

|Hard fault interrupt

|[Mernory management fault

|F’re~feﬁda fault, memory access fault

|undefined instruction or illegal state
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By default, STM32CubeMX generates interrupt handlers within the stm32xxx_it.c file.
As an example:
void NMI_Handler (void)
{
HAL_RCC_NMI_TIRQHandler () ;
}
void CAN1_TX IRQHandler (void)
{
HAL_CAN IRQHandler (&hcanl);
}
The column Generate IRQ Handler allows controlling whether the interrupt handler
function call shall be generated or not. Unselecting CAN1_TX and NMI interrupts from

the Generate IRQ Handler column as shown in Figure 81 removes the code
mentioned earlier from the stm32xxx_it.c file.

Figure 82. NVIC Code generation — IRQ Handler generation
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[Flash global interrupt

IRCC global interrupt ]
ADC1, ADC2 and ADC3 global interrupts ]

LN EEREEREEEE

Interrupt unmasking ordering table (interrupt init code is moved after all the peripheral init code)
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4.12.6 FreeRTOS middleware configuration view

Through STM32CubeMX FreeRTOS configuration window, the user can configure all the
resources required for a real-time OS application and reserve the corresponding heap.
FreeRTOS elements are defined and created in the generated code using CMSIS-RTOS
API functions. Follow the sequence below:

1. In the Configuration tab, enable FreeRTOS from the tree view.

2. Click FreeRTOS in the Configuration pane to open the FreeRTOS configuration
window (see Figure 83).

All tabs but the User Constants tab allow configuring FreeRTOS native configuration
parameters and objects, such as tasks, timers, queues, and semaphores.

The Config parameters values allow configuring Kernel and Software settings.

The Include parameters tab allows selecting only the API functions required by the
application and thus optimizing the code size.

Both Config and Include parameters will be part of the FreeRTOSConfig.h file.

Figure 83. FreeRTOS configuration view

. -
o FREERTOS Configuration S
[ ofuserconstants | o/ Tasks and Queues | /7 Timers and Semaphares | / FreeRTOS Heap Usage
Q@ Config parameters | Q/’ Indude parameters

Configure the following parameters:

Search : | Search (Crtl+F) ¥ &
=] Versions -

CMSIS-RTOS version 1.02 I

FreeRTOS version 3.2.3 E I
= Kernel settings
e = I

CPU_CLOCK_HZ SystemCoreClock

TICK_RATE_HZ 1000

MAX_PRIORITIES 7

MIMIMAL_STACK_SIZE 128 Words

MAX_TASK_NAME_LEN 16

USE_16_BIT_TICKS Disabled

IDLE_SHOULD_YIELD Enabled

USE_MUTEXES Enabled ~

USE_PREEMPTION

configUSE_PREEMPTION

Parameter Description:

Set to 1 to use the preemptive RTOS scheduler, or 0 to use the cooperative RTOS scheduler.

[ Apply ] [ Ck ] [ Cancel

3
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Tasks and Queues Tab

As any RTOS, FreeRTOS allows structuring a real-time application into a set of independent
tasks, with only one task being executed at a given time. Queues are meant for inter-task
communications: they allow to exchange messages between tasks or between interrupts
and tasks.

In STM32CubeMX, the FreeRTOS Tasks and Queues tab allows creating and configuring

such

tasks and queues (see Figure 84). The corresponding initialization code will be

generated within main.c or freeRTOS.c if the project option to generate per IP is selected

(see

Figure 40: Project Settings Code Generator).

Figure 84. FreeRTOS: configuring tasks and queues

-
FREERTOS Configuration ==
| Q/‘ Config parameters | Q/‘ Incude parameters | Q" User Constants |Q‘ Tasks and Queues | Qﬁ“'ﬁmers and Semaphores|
r Tasks
Mame Priority Stack Size (Words) Entry Function Code Generation Option
defaultTask osPriorityMormal 128 StartDefaultTask Default
ol | Task_a osPriorityHigh 128 StartTask_A Default f
Task_B osPriorityLow 256 StartTask_B Default
|| GQueues I
| MName Queue Size Item Size
myQueue_1 | 15 |4 |
myQueus_2 |32 |z |
[ Apply ] [ Ok ] [ Cancel ]

106/231

Tasks

Under the Tasks section, click the Add button to open the New Task window where
task name, priority, stack size and entry function can be configured (see Figure 85).
These settings can be updated at any time: double-clicking a task row opens again the
new task window for editing.

The entry function can be generated as weak or external:

When the task is generated as weak, the user can propose another definition than
the one generated by default.

When the task is extern, it is up to the user to provide its function definition.

By default, the function definition is generated including user sections to allow
customization.

Queues

Under the Queues section, click the Add button to open the New Queue window
where the queue name, size and item size can be configured (see Figure 85). The
queue size corresponds to the maximum number of items that the queue can hold at a

3
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time, while the item size is the size of each data item stored in the queue. The item size
can be expressed either in number of bytes or as a data type:

1 byte for uint8_t, int8_t, char and portCHAR types

2 bytes for uint16_t, int16_t, short and portSHORT types
4 bytes for uint32_t, int32_t, int, long and float

8 bytes for uint64_t, int64_t and double

A default value of 4 bytes will be used when the item size can not be automatically
derived from user input.

These settings can be updated at any time: double-clicking a queue row opens again
the new queue window for editing.

Figure 85. FreeRTOS: creating a new task

FREERTOS Configuration =
Q@ Config parameters | Q/’ Indude parameters
Q@ User Constants | Q./'} Tasks and Queues | Q{’ Timers and Semaphores | Qﬂ FreeRTOS Heap Usage
r Tasks
Name Priority Stack Size (Words) Entry Function Code Generation Option
defaultTask osPriorityMormal | 128 |StartDefaultTask |Defau|t
5
MNew Task &
MName myTasko2|
Priarity .oSPriorityIdIe =
Stack Size (Words) 128 Delete
-Queues Entry Function StartTask02
Name Code Generation Option | Default - | fize
\ /
[ Apply ] [ Ok ] [ Cancel
\, 4

The following code snippet shows the generated code corresponding to Figure 84:
FreeRTOS: configuring tasks and queues.

Create the thread(s) */

/* definition and creation of defaultTask */
osThreadDef (defaultTask, StartDefaultTask, osPriorityNormal, 0, 128);
defaultTaskHandle = osThreadCreate (osThread(defaultTask), NULL) ;

/* definition and creation of Task_A */
osThreadDef (Task_A, StartTask_A, osPriorityHigh, 0, 128);
Task_AHandle = osThreadCreate(osThread(Task_A), NULL) ;

/* definition and creation of Task_B */

osThreadDef (Task_B, StartTask_B, osPriorityLow, 0, 256);
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Task_BHandle = osThreadCreate(osThread(Task_B), NULL) ;

/* Create the queue(s) */
/* definition and creation of myQueue_1 */
osMessageQDef (myQueue_1, 16, 4);

myQueue_lHandle = osMessageCreate (osMessageQ (myQueue_1),

/* definition and creation of myQueue_2 */
osMessageQDef (myQueue_2, 32, 2);

myQueue_2Handle = osMessageCreate (osMessageQ (myQueue_2),

Timers, Mutexes and Semaphores

NULL) ;

NULL) ;

FreeRTOS timers, mutexes and semaphores can be configured via the FreeRTOS Timers
and Semaphores tab (see Figure 86).

Under each object dedicated section, clicking the Add button to open the corresponding
New <object> window where the object specific parameters can be specified. Object
settings can be modified at any time: double clicking the relevant row opens again the New
<object> window for edition.

Note: Expand the window if the newly created objects are not visible.

Figure 86. FreeRTOS - Configuring timers, mutexes and semaphores

r Bl
& FREERTOS Configuration ﬁ
[ Q/]Conﬁg pa'aneters] Q/’ Indude parameters [ Q/) User Constants [ Q/?Tad:smdQuam Qﬂ 5 g\/’ FreeRTOSHeq)Usage.
r Timers
Mame Callback Type Code Generation Option
myTimer01 callbacko1 losTimerPeriodic |Defauit -
myTimer02 \Callbackoz losTimerOnce IDefault X
Add | [ Delete |
Name
myMutex01 ‘
add | [ Delete |
rRecursive
Name
myRecursiveMutex01 ‘
add | [ Delete |
r Binary hores
Name
myBinarySem01 ‘
Add | [ Delete |
(R o
MName Count
myCountingSem01 |7 ‘
add | [ Delete |
[y ) [ ok ] [ concel ]
L
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Timers

Prior to creating timers, their usage (USE_TIMERS definition) must be enabled in the
software timer definitions section of the Configuration parameters tab. In the
same section, timer task priority, queue length and stack depth can be also configured.

The timer can be created to be one-shot (run once) or auto-reload (periodic). The timer
name and the corresponding callback function name must be specified. It is up to the
user to fill the callback function code and to specify the timer period (time between the
timer being started and its callback function being executed) when calling the CMSIS-
RTOS osTimerStart function.

Mutexes/Semaphores

Prior to creating mutexes, recursive mutexes and counting semaphores, their usage
(USE_ MUTEXES, USE_RECURSIVE_MUTEXES,
USE_COUNTING_SEMAPHORES definitions) must be enabled within the Kernel
settings section of the Configuration parameters tab.

The following code snippet shows the generated code corresponding to Figure 86:
FreeRTOS - Configuring timers, mutexes and semaphores).

/* Create the semaphores(s) */
/* definition and creation of myBinarySem0l */
osSemaphoreDef (myBinarySem01) ;

myBinarySemOlHandle = osSemaphoreCreate (osSemaphore (myBinarySem01l), 1);

/* definition and creation of myCountingSem01l */
osSemaphoreDef (myCountingSem01) ;

myCountingSemOlHandle = osSemaphoreCreate (osSemaphore (myCountingSem01) ,

7);

/* Create the timer(s) */
/* definition and creation of myTimer01l */
osTimerDef (myTimer01l, CallbackO1l);

myTimerOlHandle = osTimerCreate (osTimer (myTimer0l), osTimerPeriodic,

NULL) ;

/* definition and creation of myTimer02 */
osTimerDef (myTimer02, Callback02);

myTimer02Handle = osTimerCreate (osTimer (myTimer02), osTimerOnce, NULL) ;

/* Create the mutex(es) */

/* definition and creation of myMutex0l */
osMutexDef (myMutex01) ;

myMutex0lHandle = osMutexCreate (osMutex (myMutex01)) ;

/* Create the recursive mutex(es) */

/* definition and creation of myRecursiveMutex0l */

osMutexDef (myRecursiveMutex01) ;
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myRecursiveMutex0lHandle =
osRecursiveMutexCreate (osMutex (myRecursiveMutex01)) ;

FreeRTOS heap usage

The FreeRTOS Heap usage tab displays the heap currently used and compares it to the
TOTAL_HEAP_SIZE parameter set in the Config Parameters tab. When the total heap
used crosses the TOTAL_HEAP_SIZE maximum threshold, it is shown in red and a red
cross appears on the tab (see Figure 87).

Figure 87. FreeRTOS Heap usage

F B
# FREERTOS Configuration S5
| q’q Config parameters | q’q Indude parameters | Q:”} User Constants | Q::)Tasks and Queuss | Q?Tlmers and Semaphoresl & FreeRTOS Heap Usage

= Summary
Total amount for tasks 17496 Bytes
Total amount for queues 212 Bytes
Total amount for timers 240 Bytes
Total amount for mutexes and semaphores 352 Bytes
= FreeRTOS tasks
Idle task (FreeRTOS internal) 632 Bytes =
Timer service task (FreeRTOS internal) 1144 Bytes
defauliTask 5240 Bytes
myTask02 5240 Bytes
myTask03 5240 Bytes
=l FreeRTOS gueues
Timer command queue (FreeRTOS internal) 212 Bytes
=] FreeRTOS timers b

[ myTimerd1 48 Bytes

| myTimer0d2 48 Bytes

| myTimerd3 43 Bytes

| myTimer04 45 Bytes -

l TOTAL HEAP USED
Total amount of the heap used by known objects {user objects, internal freertos objects) N

»

WARNING

Current computed value is greater than the configTOTAL_HEAP_SIZE value set in Config parameters tab

To avoid runtime issues, you should increase config_TOTAL_HEAP_SIZE, removefadjust some defined objects (tasks, queues, timers, mutexes, semaphores)
or change the Memory Management scheme to heap_3

More about FreeRTOS Heap:

FreeRTOS uses a region of memory called Heap (into the RAM) to allocate memory for tasks, gueues, timers, semaphores, mutexes and when dynamically
creating variables,

(FreerRTOS heap is different than the system heap defined at the compiler fevel)

m

The total amount of that available heap space is set by configTOTAL_HEAP_SIZE which is defined in FreeRTOSConfig.h.

FreeRTOS offers several heap management schemes that range in complexity and features.It indudes five sample memory allocation implementations, each
of which are decribed in the following link: http:/fwww. freertos.orgfad0111.himl

As the selected heap management scheme is not heap 3:

[ Apply ] [ ok ] [ Cancel

3
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413 Clock tree configuration view

STM32CubeMX Clock configuration window (see Figure 88) provides a schematic
overview of the clock paths, clock sources, dividers, and multipliers. Drop-down menus and
buttons allow modifying the actual clock tree configuration to meet user application
requirements.

Actual clock speeds are displayed and active. The clock signals that are used are
highlighted in blue.

Out-of-range configured values are highlighted in red to flag potential issues. A solver
feature is proposed to automatically resolve such configuration issues (see Figure 89).

Reverse path is supported: just enter the required clock speed in the blue filed and
STM32CubeMX will attempt to reconfigure multipliers and dividers to provide the requested
value. The resulting clock value can then be locked by right clicking the field to prevent
modifications.

STM32CubeMX generates the corresponding initialization code:

e  main.c with relevant HAL_RCC structure initializations and function calls

e stm32xxxx_hal_conf.h for oscillator frequencies and Vpp values.

4.13.1 Clock tree configuration functions

External clock sources

When external clock sources are used, the user must previously enable them from the
Pinout view available under the RCC peripheral.

Peripheral clock configuration options

Some other paths, corresponding to clock peripherals, are grayed out. To become active,
the peripheral must be properly configured in the Pinout view (e.g. USB). This view allows
to:

e Enter a frequency value for the CPU Clock (HCLK), buses or peripheral clocks

STM32CubeMX tries to propose a clock tree configuration that reaches the desired
frequency while adjusting prescalers and dividers and taking into account other
peripheral constraints (such as USB clock minimum value). If no solution can be found,

3
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STM32CubeMX proposes to switch to a different clock source or can even conclude
that no solution matches the desired frequency.

e Lock the frequency fields for which the current value should be preserved

Right click a frequency field and select Lock to preserve the value currently assigned
when STM32CubeMX will search for a new clock configuration solution.

The user can unlock the locked frequency fields when the preservation is no longer
necessary.

o Select the clock source that will drive the system clock (SYSCLK)
—  External oscillator clock (HSE) for a user defined frequency.
— Internal oscillator clock (HSI) for the defined fixed frequency.
—  Main PLL clock
e Select secondary sources (as available for the product)
—  Low-speed internal (LSI) or external (LSE) clock
— 12S input clock
e  Select prescalers, dividers and multipliers values.
e Enable the Clock Security system (CSS) on HSE when it is supported by the MCU

This feature is available only when the HSE clock is used as the system clock source
directly or indirectly through the PLL. It allows detecting HSE failure and inform the
software about it, thus allowing the MCU to perform rescue operations.

e Enable the CSS on LSE when it is supported by the MCU

This feature is available only when the LSE and LSI are enabled and after the RTC or
LCD clock sources have been selected to be either LSE or LSI.

¢ Reset the Clock tree default settings by using the toolbar Reset button ( @ ):
This feature reloads STM32CubeMX default clock tree configuration.

e Undo/Redo user configuration steps by using the toolbar
Undo/Redo buttons ( ., . )

e Detect and resolve configuration issues

Erroneous clock tree configurations are detected prior to code generation. Errors are
highlighted in red and the Clock Configuration view is marked with a red cross (see
Figure 89).

Issues can be resolved manually or automatically by clicking the Resolve Clock Issue
button ( € ) which is enabled only if issues have been detected.

The underlying resolution process follows a specific sequence:
a) Setting HSE frequency to its maximum value (optional).

b) Setting HCLK frequency then peripheral frequencies to a maximum or minimum
value (optional).

c) Changing multiplexers inputs (optional).

d) Finally, iterating through multiplier/dividers values to fix the issue. The clock tree is

cleared from red highlights if a solution is found. Otherwise an error message is
displayed.

Note: To be available from the clock tree, external clocks, 12S input clock, and master clocks shall
be enabled in RCC configuration in the Pinout view. This information is also available as
tooltips.
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The tool will automatically perform the following operations:

e Adjust bus frequencies, timers, peripherals and master output clocks according to user
selection of clock sources, clock frequencies and prescalers/multipliers/dividers values.

e  Check the validity of user settings.

e Highlight invalid settings in red and provide tooltips to guide the user to achieve a valid
configuration.

The Clock tree view is adjusted according to the RCC settings (configured in RCC IP pinout

and configuration views) and vice versa:

e Ifin RCC Pinout view, the external and output clocks are enabled, they become
configurable in the clock tree view.

e Ifin RCC Configuration view, the Timer prescaler is enabled, the choice of Timer clocks
multipliers will be adjusted.

Conversely, the clock tree configuration may affect some RCC parameters in the

configuration view:

e  Flash latency: number of wait states automatically derived from Vpp voltage, HCLK
frequency, and power over-drive state.

e  Power regulator voltage scale: automatically derived from HCLK frequency.

e  Power over-drive is enabled automatically according to HCLK frequency. When the
power drive is enabled, the maximum possible frequency values for AHB and APB
domains are increased. They are displayed in the Clock tree view.

The default optimal system settings that is used at startup are defined in the
system_stm32f4xx.c file. This file is copied by STM32CubeMX from the STM32CubeF4
firmware package. The switch to user defined clock settings is done afterwards in the main
function.

Figure 88 gives an example of Clock tree configuration view for an STM32F429x MCU and
Table 12 describes the widgets that can be used to configure each clock.
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Figure 88. STM32F429xx Clock Tree configuration view
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Figure 89. Clock Tree configuration view with errors
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Table 12. Clock tree view widget

Format

Configuration status of the Peripheral

Instance
HSIRC
- Active clock sources
Unavailable settings are blurred or grayed out
(clock sources, dividers,...)
+ -
AHE Prescaler Gray drop down lists for prescalers, dividers,
2, multipliers selection.
» X1 - Multiplier selection
H5E O&C
- User defined frequency values
HCLK {MHz)

48

Automatically derived frequency values

User-modifiable frequency field

Right click blue border rectangles, to lock/unlock
a frequency field. Lock to preserve the frequency
value during clock tree configuration updates.
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4.13.2 Recommendations

The Clock tree view is not the only entry for clock configuration.

1. Go first through the RCC IP pinout configuration in the Pinout view to enable the
clocks as needed: external clocks, master output clocks and Audio 12S input clock
when available (see Figure 90).

Figure 90. Clock tree configuration: enabling RTC, RCC Clock source
and outputs from Pinout view

r Y
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=4 ReC
~High Speed Clock (HSE) |BYPASS Clock Source - "
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2. Then go to the RCC IP configuration in the Configuration view. The settings defined
there for advanced configurations will be reflected in the clock tree view. The settings
defined in the clock tree view may change the settings in the RCC configuration (see

Figure 91).

Figure 91. Clock tree configuration: RCC Peripheral Advanced parameters

RCC Conﬁgurati_on‘ -

Ec\\:ﬁ‘ Parameter Settings | Q/‘ NVIC Settings
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El System Parameters
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Instruction Cache
Prefetch Buffer
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=l RCC Parameters
HSI Calibration Value
TIM Prescaler Selection
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Power Regulatror Voltage Scale

Power Ower Drive

3.3V

Enabled

Enabled

Enabled

0'WS (1 CPU cyde)

]
Disabled

Power Regulator Voltage Scale 3
Disabled

ey | [ o

] [ Cancel
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STM32F43x/42x power-over drive feature

STM32F42x/43x MCUs implement a power over-drive feature allowing to work at the
maximum AHB/APB bus frequencies (e.g., 180 MHz for HCLK) when a sufficient Vpp
supply voltage is applied (e.g Vpp > 2.1 V).

Table 13 lists the different parameters linked to the power over-drive feature and their
availability in STM32CubeMX user interface.
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Table 13. Voltage scaling versus power over-drive and HCLK frequency

Parameter

STM32CubeMX panel

Value

Vpp voltage

Configuration (RCC)

User-defined within a predefined range. Impacts
power over-drive.

Power Regulator
Voltage scaling

Configuration (RCC)

Automatically derived from HCLK frequency and
power over-drive (see Table 14).

Power Over Drive

Configuration (RCC)

This value is conditioned by HCLK and Vpp value
(see Table 14). It can be enabled only if
Vpp222V

When Vpp 22.2V, it is either automatically
derived from HCLK or it can be configured by the
user if multiple choices are possible (e.g., HCLK
=130 MHz)

HCLK/AHB clock
maximum frequency
value

Clock Configuration

Displayed in blue to indicate the maximum
possible value. For example: maximum value is
168 MHz for HCLK when power over-drive
cannot be activated (when Vpp £2.1V),
otherwise it is 180 MHz.

APB1/APB2 clock
maximum frequency
value

Clock Configuration

Displayed in blue to indicate maximum possible
value

Table 14 gives the relations between power-over drive mode and HCLK frequency.

Table 14. Relations between power over-drive and HCLK frequency

HCLK frequency range: . .
- Corresponding voltage scaling and power
Vpp > 2.1 V required to enable power over- over-drive (POD)
drive (POD)

Scale 3

<

=120 MHz POD is disabled
Scale 2

120 to 14 MHz

POD can be either disabled or enabled

144 to 168 MHz

Scale 1 when POD is disabled
Scale 2 when POD is enabled

168 to 180 MHz

POD must be enabled

Scale 1 (otherwise frequency range not
supported)
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Clock tree glossary

Table 15. Glossary

Acronym Definition
HSI High Speed Internal oscillator: enabled after reset, lower accuracy than
HSE.
HSE High Speed External oscillator: requires an external clock circuit.
PLL Phase Locked Loop: used to multiply above clock sources.
LS| L.ow Speed Internal clock: low power clocks usually used for watchdog
timers.
LSE Low Speed External clock: powered by an external clock.
SYSCLK System clock
HCLK Internal AHB clock frequency
FCLK Cortex free running clock
AHB Advanced High Performance Bus
APB1 Low speed Advanced Peripheral Bus
APB2 High speed Advanced Peripheral Bus

Power Consumption Calculator (PCC) view

For an ever-growing number of embedded systems applications, power consumption is a
major concern. To help minimizing it, STM32CubeMX offers the Power Consumption
Calculator (PCC) tab (see Figure 92), which, given a microcontroller, a battery model and a
user-defined power sequence, provides the following results:

Average current consumption

Power consumption values can either be taken from the datasheet or interpolated from
a user specified bus or core frequency.

Battery life
Average DMIPs

DMIPs values are directly taken from the MCU datasheet and are neither interpolated
nor extrapolated.

Maximum ambient temperature (Tapmax)
According to the chip internal power consumption, the package type and a maximum

junction temperature of 105 °C, the tool computes the maximum ambient temperature
to ensure good operating conditions.

Current Tapax implementation does not account for I/O consumption. For an accurate
Tamax estimate, 1/0 consumption must be specified using the Additional Consumption
field. The formula for I/O dynamic current consumption is specified in the
microcontroller datasheet.
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The PCC view allows developers to visualize an estimate of the embedded application
consumption and lower it further at each PCC power sequence step:

e Make use of low power modes when any available

e Adjust clock sources and frequencies based on the step requirements.

e Enable the peripherals necessary for each phase.

For each step, the user can choose VBUS as possible power source instead of the battery.
This will impact the battery life estimation. If power consumption measurements are

available at different voltage levels, STM32CubeMX will also propose a choice of voltage
values (see Figure 96).

An additional option, the transition checker, is available for STM32L0, STM32L1 and
STM32L4 series. When it is enabled, the transition checker detects invalid transitions within
the currently configured sequence. It ensures that only possible transitions are proposed to
the user when a new step is added.

4141 Building a power consumption sequence

The default starting view is shown in Figure 92.

Figure 92. Power Consumption Calculator default view

STM32CubeMX Untitled: STM32L475VGTx = | S e

File Project Power Window Help
i1 HE @G T:9 e ippig

| Pinaut | Clock Configuration | Configuration | Power Consumption Calculator | DB Editor |

) 4 | 5tep Sequence Transitions Checker
Microcontroller Selected (2] 4 = { } ) M ’V b4 | ] I 2] ’V on Log “
Series STM32L4 rSequence Table
Line STM32L4x5 .
ey STM32L475VGTx Step Mode  vdd Ran... Mem... CPU... Cloc... Src... Peri... Add.... Step... Dur... DMIPS Volt... TaMax Cat..
Datasheet 027692_Revl
Parameter Selection ! Q )
Ambient Temp... :25 -
dd Power Su... :—Choose— -

Display
’V Plot: All Steps ?

»)

Battery Selection

Battery Mot set
In Series 1=
In Parallel 1=
Capacity 0.0 mah

Self Discharge 0.0 %&/month
Mominal Voltage 0.0V

Max Cont Curr...0.0 mA

Max Pulse Cur... 0.0 mA

Information Notes ¥

@

Help

3
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Selecting a Vpp value

From this view and when multiple choices are available, the user must select a Vpp value.

Selecting a battery model (optional)

Optionally, the user can select a battery model. This can also be done once the power
consumption sequence is configured.

The user can select a predefined battery or choose to specify a new battery that best
matches his application (see Figure 93).

Figure 93. Battery selection

File Project Power Window Help

1 UR  &0: 9« I S

Finout I Clock Configuration I Config

Available batteries:

Mi troller Salacted
feracantrafier selacts Battery Database Management Add Battery

Serie: 5TM
Line: 5TM.
MCU: STM,
Datasheet: 0253

Available Batteries List
MName Capacity (mAh) Self Discharge (%... Mominal Voltage (V) Max Cont Current... Max Pulse Curren... Datsbase

Parameter Selection Alkaline(AAA LROZ) ] X . T ¥ Default

. Alkaline(C LR.14) x 2 . X Default
Ambient Temperature (°C): |2 Alkaline (D LR.20) L

| ; Default
vdd Power Supply (V): 3 Alkaline(9v) . Add battery: X Default

Li-MnO2| . ' Default
1 Mame Battery_29 T

Li-MnO2| Default
Battery Selection Li-MnO2| . Capacity (mah) 0.0 1 Default
Li-MnO2(CR2430) 1 ! Default
Select Battery Li-MnO2(CR2477) . Gelf Discharge (Ye/month) 0.0 . Default
Li-SOCL2(AAATDO) 1 ! Default

. Mominal Voltage (V) 0.0
Battery: Li-50CL2(A3400) . ) Default

Capacity: Li-50CL2(Co000) . Max Cont Current (mA) . X Default
Self Discharge: .1 | Li-socL2(p1g000) X : Default
Nominal Voltage: || Lisoci2(ppas000) [tadESaisnral Default
Ni-Cd{AA1100) - ! Default
Ni-Cd(A1700) - ! Default
Ni-Cd(C3000) - ! Default
Ni-Cd{D4400) - - . ! Default
In Series: Mi-Cd{F7000) x x . X Default
Ni-MH{AAASDD) ! - . ! Default
In Parallel: Ni-MH(AA 1500) . . . ) Default
Ni-MH{A2500) 2500.0 . ! Default

Help

Max Cont Current:

Max Pulse Current:

3
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Power sequence default view

The user can now proceed and build a power sequence (see Figure 94).

Figure 94. Building a power consumption sequence

Ambient Tem. .. 25
vdd Power 5... 3.0

Battery Selection \ é )

Battery Alkaline{AA L...
In Series 1=

In Parallel 1=

Capacity 2850.0 mAh

Self Discharge 0.3 Ya/month
Nominal Valt... 1.5V

Max Cont Cu...1000.0 mA
Max Pulse C... 0.0 mA

Information Notes ‘%'

L Haln (34

STM32CubeMX PCC_stm321053_projectioc®: STM32L053C8Tx =NRcN X
File Project Power Window Help

BebUR &8 20 29 &
| Plnoutl Clock Configuration | Conﬁgurahon| Power Consumption Calculator

Microcontroller Selec... (&) »| 4 |f5tep Sequence Transitions Checker

s oo ||
- ] 4 \ | X | ] I 12 [@] on Log

Series STM32L0 :] :] =

Line STM32L0x3 rSequence Table

MCU STM32L053C... .

Datasheet 025844 Revd Step  Mode Vdd Ran... Mem... CPU... Clc.. Src... Peri... Add.... Step... Dura... DMIPS Volt... TaMax Cat...

Parameter Selection  (2)

Display
’V Plot: All Steps 2

m

Managing sequence steps

Steps can be reorganized within a sequence (Add new, Delete a step, Duplicate a step,
move Up or Down in the sequence) using the set of Step buttons (see Figure 95).

The user can undo or redo the last configuration actions by clicking the Undo button in the
PCC view or the Undo icon from the main toolbar

Figure 95. Step management functions

Step

=

g

it JLd (9]

Adding a step

There are two ways to add a new step:
e Click Add in the Power Consumption panel. The New Step window opens with empty

step

settings.

e Or, select a step from the sequence table and click Duplicate. A New Step window
opens duplicating the step settings. (see Figure 96).
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Figure 96. Power consumption sequence: new step default view
- )
@ New Step ﬁ
-Power Memary |Peripherals -
Power Mode RUN - [ | i [l AapC
———————— ||| COMP1
Power Range —Choose-- - O
: " ||| =---- comp2
Memory Fetch Type ] Fast
vdd - [ Slow
Voltage Source :Elattery || i [Tl cre
..... D CRS
..... DAE
-Clocks O
----- [ DBGMCU
CPUFrequency | = |1} D DMA -
Interpolation Ranges | = | |[] - |:| FIREWALL
User Choice(Hz | |l | FLASH
----- [ cPIOA
Clock Configuration
----- [ cP1OB
Clock Source Freguency | = | ]| i ] GPIOC
----- [ cPIOH
-Optional Settngs —M || i [ 1201
Step Duration 1 :ms - """ D 1ac2
- - D WDG
Additional Consumption ] mi - &
: o [ [[] LCD
----- [ LPTIM1
-Results
s————I| i. | LPUART1
5tep Consumption  (0pA ] i [7] PVD/BOR
Without Peripherals (opa | "1 PwWR
..... D RNG
Peripherals Part O pA (A: OpA-D: O pa)
----- [[] rTC
Ta Max (°C) ws ] ke [[] sP11
— -
Warnings
b
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Once a step is configured, resulting current consumption and Tapax values are provided in

the window.

Editing a step

To edit a step, double-click it in the sequence table. The Edit Step window opens (see

Figure 97).
Figure 97. Edit Step window
r B
& Edit Step ﬁ
F ]
e AR ]
~Power Memary Peripherals =
Power Mode: RUN =\ P [7] anc
r N | N COHP]_
Power Range: Range1-High - 0
: ||| =---- comp2
Memory Fetch Type: FLASH - . [[] Fast
Vd: 3.0 - - [[] Slow
) N I:l CRC
Voltage Source: Battery =l [ crs
..... I:l DAC
rClodg—m — | | I:l DBGMCU
CPU Frequency: 32,0 MHz = Il [ pMA
----- FIREWALL E
Interpolation ranges D
..... I:l FLASH
User choice (H2): [ [} i [] GPTIOA
il Clodk Configuration: HSEBYP PLL = (] ["] eP10B
: 18- [] GPIOC
Clock Source Freguency: 16.0 MHz = Il | GPIOH
1| [ | [ 12C1
rOptional Settngs ———————————————————————————— (| . [(]12C2
|| Step Duration: 1 [ | [ IwDG
I 1 ] i LCD
Additional Consumption: 0 mA 0
- 18- [ LpTIM1
----- [] LPUARTL
Results
..... I:l WD,"BOR
Step Consumption: | 6.65mA ] Ll [ PR
Without Peripherals: (6.3ma |7 [C] Rue
S /[l I:l RTC
Peripherals Part: 352pA (A:OpA-D:352pA) ||| ] sP11
Ta Max ("C): B 1 1 [7] spP12
----- [ SYSCFG i
-Warnings
H
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Moving a step

By default, a new step is added at the end of a sequence.

Click the step in the sequence table to select it and use the Up and Down buttons to move it
elsewhere in the sequence.

Deleting a step

Select the step to be deleted and click the Delete button.

Using the transition checker

Not all transitions between power modes are possible. PCC proposes a transition checker
to detect invalid transitions or restrict the sequence configuration to only valid transitions.

Enabling the transition checker option prior to sequence configuration ensures the user will
be able to select only valid transition steps.

Enabling the transition checker option on an already configured sequence will highlight the
sequence in green (green frame) if all transitions are valid (see Figure 98), or in red if at
least one transition is invalid (red frame with description of invalid step highlighted in red)
(see Figure 99).

In this case, the user can click the Show log button to find out how to solve the transition
issue (see Figure 100).

Figure 98. Enabling the transition checker option on an already configured sequence -

all transitions valid

-Step Sequence Transitions Checker
L[ = (W)t (3 [0 )00 ]| (i i) (] (o8] [ 2 [o}
- Sequence Table

Step Mode  Vdd Ran... Mem... CPU... Cloc... Src... Peri... Add... Step... Dur... DMIPS Volt... Ta... Cat..

1 RLMN 3.0 Rang... |[FLASH |1004Q... |MS5I 1.0 MHz 0 mA 166.9... |1 ms 0.95 Battery (104.97 |[Inter... | =
2 RLMN 3.0 Rang... |FLASH |8.0 MHz HSEBYP |8.0 MHz 0 mA 1.3mA |1ms 7.6 Battery |104.73 [Datas...|
3 RLMN 3.0 Rang... |[FLASH |8.0 MHz [HSEBYP |8.0 MHz |ADC ... |OmA 3.51mA|1ms 7.6 Battery |104.42 |Datas...

4 SLEEP |3.0 Rang... |FLASH |8.0 MHz HSEBYP |8.0 MHz 0 mA 3830 pA |1ms 7.6 Battery |104.94 [Datas...| =
5 RLMN 3.0 Rang... |[FLASH |[4.2 MHz [M5I 4.2 MHz |ADC ... |OmA 1.64mA |1 ms 3.99 Battery |104.73 |Datas...

5] RLMN 3.0 Rang... [FLASH |1200... [HSEBYP |12.0... 0 mA 2.33mA|1ms 11.4 Battery |104.62 |Inter... | —
7 STOP  |3.0 MNoRa... nfa 0 Hz ALL C... |OHz 0 mA 0.41 pA [1ms 0.0 Battery |105 Datas...| ™

Figure 99. Enabling the transition checker option on an already configured sequence -
at least one transition invalid

rStep Sequence Transitions Checker -
ENES i uEnEs sl HUH&H!HEE]L?\[OH
r Sequence Table
Step Mode  Vdd Ran. Mem... CPU... Cloc... &rc... Peri... Add.... Step... Dura... DMIPS VWolt... TaMax Cat..
1 RLM 3.0 Rang... [FLASH |10000...|MS5L 1.0 MHz 0 mA 166.9... |1 ms 0.95 Battery |104.97 |Inter...
2 RLM 3.0 Rang... [FLASH |3.0 MHz HSEBYP (8.0 MHz 0 mA 1.3mA |1ms 7.6 Battery |104.79 |Datas...
3 RLM 3.0 Rang... |FLASH |3.0 MHz HSEBYP [8.0 MHz [ADC ... [OmA 3.51mA |1 ms 7.6 Battery |104.42 |Datas...
4 SLEEP |3.0 Rang... [FLASH |3.0 MHz HSEBYP (8.0 MHz 0 mA 380 pA |1ms 7.6 Battery |104.94 |Datas...
5 RLM 3.0 Rang FLASH |4.2 MHz |MSI 4.2MHz |ADC ... |0 mA 1.64mA |1 ms 3.99 Battery |104.73 |Datas...
5] RLM 3.0 Rang FLASH |12000...|HSEBYP |12.0... 0 mA 2.33mA |1 ms 11.4 Battery |104.62 |Inter...
7 0.41pA 1ms . Battery -
8 SLEERP  |3.0 Rang FLASH |30000...|HSEEYP |3.0 MHz 0 mA 380 pA |1ms 7.6 Battery |104.94 |Inter...
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Figure 100. Transition checker option -show log
[ Log for current sequence o S )

Check transition between step 4 (SLEEP, Range2-Medium) and step 5 (RUN, Range1-High)
Possible next step(s) RUN [Range1-High, Range2-Medium, Range3-Low]
—==—=—=—=—==—=—==—========= [ransition allowed |

Check transition between step 5 (RUN, Range1-High) and step 6 (STOP, NoRange)
Possible next step(s) RUN [Range1-High, Range2-Medium, Range3-Low]
Possible next step(s) LOWPOWER_RUN [NoRange]

Possible next step(s): SLEEP [Range1-High, Range2-Medium, Range3-Low]
Possible next step(s) LOWPOWER_SLEEP [NoRange]

Possible next step(s) STOP [NoRange]

—==—=—=—=—==—=—==—========= [ransition allowed |

Check transition between step 6 (STOP, NoRange) and step 7 (SLEEP, Range1-High)
Possible next step(s) WU_FROM_STOP [NoRange]

____________________ Transition not possible !

~

m

1

l Close ] L Save in 3 file

= o —————
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4.14.2

3

Configuring a step in the power sequence

The step configuration is performed from the Edit Step and New Step windows. The
graphical interface guides the user by forcing a predefined order for setting parameters.

Their naming may differ according to the selected MCU series. For details on each
parameter, refer to Section 4.14.4: Power sequence step parameters glossary glossary and
to Appendix D: STM32 microcontrollers power consumption parameters or to the electrical
characteristics section of the MCU datasheet.

The parameters are set automatically by the tool when there is only one possible value (in
this case, the parameter cannot be modified and is grayed out). The tool proposes only the
configuration choices relevant to the selected MCU.

Proceed as follow to configure a new step:

1. Click Add or Duplicate to open the New step window or double-click a step from the
sequence table to open the Edit step window.

2. Within the open step window, select in the following order:
—  The Power Mode
Changing the Power Mode resets the whole step configuration.
—  The Peripherals

Peripherals can be selected/unselected at any time after the Power Mode is
configured.

— The Power scale

The power scale corresponds to the power consumption range (STM32L1) or the
power scale (STM32F4).

Changing the Power Mode or the Power Consumption Range discards all
subsequent configurations.

—  The Memory Fetch Type
—  The Vpp value if multiple choices available
—  The voltage source (battery or VBUS)
— A Clock Configuration
Changing the Clock Configuration resets the frequency choices further down.

—  When multiple choices are available, the CPU Frequency (STM32F4) and the
AHB Bus Frequency/CPU Frequency(STM32L1) or, for active modes, a user
specified frequency. In this case, the consumption value will be interpolated (see
Section : Using interpolation).

3. Optionally set
— A step duration (1 ms is the default value)

— An additional consumption value (expressed in mA) to reflect, for example,
external components used by the application (external regulator, external pull-up,
LEDs or other displays). This value added to the microcontroller power
consumption will impact the step overall power consumption.

4. Once the configuration is complete, the Add button becomes active. Click it to create
the step and add it to the sequence table.
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Using interpolation

For steps configured for active modes (Run, Sleep), frequency interpolation is supported by
selecting CPU frequency as User Defined and entering a frequency in Hz (see Figure 101).

Figure 101. Interpolated Power Consumption
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<O
rPower Memory Peripherals -
Power Mode: 'RUN
Power Range: -Range 1-High
Memaory Fetch Type: 'FLASH
Veld: 3.0
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rClocks
CPU Frequency: {jeer-defined i
Interpolation ranges -S.EI MHz —-16.0MHz - | |[] |:| FIREWAILL
User choice (Hz): goooooo ||| [ ALasH
—— || [] GPTOA
Clock Configuration: HSEEBYP ] GPI0B
Clock Source Frequency: BomHz || [[] GPIOC
..... D GPIOH
rOptional Settings —————————————————[| i~ (1201 ;
Step Duration: 1 me ||| (p e
— ||| - [] IWDG i
Additional Consumption: a mA Lo
----- [ LPTIM1
R ke [7] LPUART1
Step Consumption:  (1.55mA [ |]] - [C] rvD/BOR
Without Peripherals: [1.55m& || 7 [Cpwr
..... D RNG
Peripherals Part: O pA (A: O pA-D: 0pA) FRTC
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..... [T sPT? | |
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Importing pinout

Figure 102 illustrates the example of the ADC configuration in the Pinout view: clicking

Import Pinout in the PCC view selects the ADC IP and GPIO A (Figure 103).

The Import pinout button 2 allows to automatically select the IPs that have been
configured in the Pinout view.

Figure 102. ADC selected in Pinout view
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Selecting/deselecting all peripherals

Clicking the Select All button it allows selecting all peripherals at once.

Clicking Deselect All E removes them as contributors to the step consumption.

Figure 103. PCC Step configuration window: ADC enabled using import pinout

-

S5

@ New Step
9 d‘) }

Power Memary -
Power Mode: :RUN - | I
Power Scale: :Smlelﬂigh -

Memaory Fetch Type: :FLASH -
vdd: 3.3 -
Voltage Source: :Batten-I - E
rClocks
CPU Frequency: 1680 MHz - |
Interpolation ranges
User choice (Hz): N
Clock Configuration: :HS-E PLL \
Clock Source Frequency: -+ 0 MHz -

r Optional Settings
Step Duration: 1 :ms -

Additional Consumption: a :mA -

rResults
Step Consumption: | 52.41 mA
Without Peripherals: | 50 mA
Peripherals Part: 2.41mA (A: L.emA -D: 812,28 pA)

Ta Max ("C): 97.56
Warnings

[ Add ] [ Cancel
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4.14.3 Managing user-define

The configuration of a powe
Figure 104):

d power sequence and reviewing results

r sequence leads to an update of the PCC view (see

The sequence table shows all steps and step parameters values. A category column

indicates whether the consumption values are taken from the datasheet or are

[ ]

interpolated.
[ )

display type (e.g. plot a
[ ]

Il steps, plot low power versus run modes, ..)

The sequence chart area shows different views of the power sequence according to a

The results summary provides the total sequence time, the maximum ambient

temperature (Tapyax), Plus an estimate of the average power consumption, DMIPS, and
battery lifetime provided a valid battery configuration has been selected.

Figure 104. Power Consumption Calculator view after sequence building

-
STM32CubeMX STM32L053CETx_sequence.ioc: STM32L053CETx =RACE X |
File Project Power Window Help
BEeBUR &G 9 @pi
| Pinout | Clock Configuration I Configuration | Power Consumption Calculator
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Micracontroller Selec... (2] [ {E . i 1 N N ‘ h ][ W H X ” [} ][ By ] 2 [ #/on w
Series 5TM32L0 rSequence Table | |
Line STM32L0x3 .| Please select the step to move up first! |
Mcu STM32L053C... Step Mode  vdd Rabr—rem———rorr —wo—are=———er...  Add... Step... Dur... DMIPS Volt.. Ta... Cat..
Datasheet 025844 Rev4 1 RUN |30 |Rang... [FLASH [1000... [MSI  [L.OMHz oma  [166.9..[1me  [0.95  |Battery [104.97 [Inter... | .
2 RN 3.0 Rang... |FLASH |8.0 MHz |HSEEYP |8.0 MHz 0 mA 1L3mA |1ms 7.6 Battery 104.79 Datas...| |
— 3 RUM 3.0 Rang... [FLASH (8.0 MHz [HSEBYP (8.0 MHz |ADC ... |0 mA 3.51mA|1ms 7.6 Battery [104.42 Datas...
Parameter Selection (&) 4 SLEEF |3.0 Rang... FLASH (8.0 MHz |HSEBYP (8.0 MHz 0 mA 330 pA [1ms 7.6 Battery [104.94 Datas...|=
i i 5 RN 3.0 Rang... FLASH |4.2 MHz |M5I 4.2 MHz [ADC ... [DmA 1.64mA |1 ms 3.99 Battery (104.73 |Datas...
AmbientTem..._ES - | ] RUM 3.0 Rang... [FLASH [1200... [HSEBYP (12.0... 0 mA 2.33mA|1ms 11.4 Battery (104.62 [Inter... [
vdd Power 5... | 3.0 o | 7 STOP 3.0 MoRa... |nfa 0 Hz ALL C... |0 Hz OmA  [0.41pA[ims (0.0 Battery [105 Datas...| =
) ) Display
. = S - iy
Battery Selection @& | =
—— Plot: Run / Low Pomer [ Consumption Profile by Step
Area % Run / Low Power SRUN
Battery Alkaline(AAL... Pie: All Modes = T ’
a Pie: Run  Low Power 3:RUN S:RUN
In Series 2= . .
1P Consumption: All 2:RUN l
In Parallel 3 1P Consumption: Analog |
Capadty $550.0 mAh IP Consumption: Digiltanl i 5 FHIN]
@ 1.0 . l 7:5TOP
i =
Self Discharge 0.3 %%/month 505 l
Nominal Volt... 3.0V 0.0
Max Cont Cu...3000.0 mé 00 05 1.0 15 20 25 30 235 40 45 50 55 60 65 7.0
Max Pulse C... 0.0mA Time (ms)
| == Idd by Step == Average Current |
T =i T )] Sequence Time /Ta Max 7 ms /10442 °C Average Consumption 1.33 mA
- Baltery Life Estimation 8 months, 20 days, 9 hours Average DMIPS 6.52 DMIPS
h
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Managing the whole sequence (load, save and compare)

The current sequence can be saved or deleted by clicking [ X ] and [ A ]
respectively.

In addition, a previously saved sequence can be either loaded in the current view or opened
for comparison by clicking | B (see Figure 105).

Figure 105. Sequence table management functions

Seguence

Lo Jlu J[® ] [ &

2
=y

To load a previously saved sequence:
1.  Click the load button | |.
2. Browse to select the sequence to load.

To open a previously saved sequence for comparison:

1. Click the Compare button .

2. Browse and select the .pcs sequence file to be compared with the current sequence. A
new window opens showing the selected sequence details.
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Managing the results charts and display options

In the Display area, select the type of chart to display (sequence steps, pie charts,
consumption per IPs, ...). You can also click External Display to open the charts in
dedicated windows (see Figure 106).

Right-click on the chart to access the contextual menus: Properties, Copy, Save as png
picture file, Print, Zoom menus, and Auto Range to reset to the original view before zoom
operations. Zooming can also be achieved by mouse selecting from left to right a zone in
the chart and Zoom reset by clicking the chart and dragging the mouse to the left.

Figure 106. Power Consumption: Peripherals Consumption Chart

-
Current Sequence l =HACT é,l

rMCU Settings / Results Summary

MCU: STM32L053C8Tx Sequence Time [ Ta Max: 7ms [ 104.42 °C

Vdd: 3.0V Average Consumption: 1.33 mA

Datasheet: 025844 Rev4 Average DMIPS: 6.52 DMIPS

Batteries (3 in parallel): Alkaline(as LRE) Battery Life Estimation: 8 months , 20 days &9 hours
- Sequence Table

Step Mode \idd Rang... Memory CPUf... Clock... SrcF... Perip... Add.... Step... Dura... DMIPS \Volta... TaMax Cate...

1 RUN 3.0 Range... FLASH  |10000.., [MSL 1.0 MHz 0 mA 166.9 pA (1 ms 0,95 Battery |104.97 |Interp...
2 RN 3.0 Range... FLASH |8.0 MHz [HSEBYP (3.0 MHz 0 mA L3mA |1ms 7.6 Battery |104.7% |Datas...
3 RUM 3.0 Range... FLASH |8.0 MHz |[HSEBYP (3.0 MHz |ADC C... |0 m& 3.51mA |1ms 7.6 Battery |104.42 |Datas...
4 SLEEP  [3.0 Range... FLASH |8.0 MHz |[HSEBYP (3.0 MHz 0 mA 3BOpA  |1ms 7.6 Battery |104.94 |Datas...
5 RN 3.0 Range... FLASH |4.2MHz [MSL 4.2MHz |ADCC... |0 mA L&4mA [1ms 3.99 Battery |104.73 |Datas...
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Overview of the Results summary area

This area provides the following information (see Figure 107):

Total sequence time as the sum of the sequence steps durations.

Average consumption as the sum of each step consumption weighed by the step
duration.

The average DMIPS (Dhrystone Million Instructions per Second) based on Dhrystone
benchmark, highlighting the CPU performance for the defined sequence.

Battery life estimation for the selected battery model, based on the average power
consumption and the battery self-discharge.

Tamax: highest maximum ambient temperature value encountered during the
sequence.

Figure 107. Description of the Results area

Results Summary

Sequence Time/ TaMax 7 ms/104.42°C Average Consumption 1.33mA
Battery Life Estimation 8 months, 20 days & 9 hours Average DMIPS 6.52 DMIPS

4144 Power sequence step parameters glossary

The parameters that characterize power sequence steps are the following (refer to
Appendix D: STM32 microcontrollers power consumption parameters for more details):

134/231

Power modes

To save energy, it is recommended to switch the microcontroller operating mode from
running mode, where a maximum power is required, to a low-power mode requiring
limited resources.

Vcore range (STM32L1) or Power scale (STM32F4)

These parameters are set by software to control the power supply range for digital
peripherals.

Memory Fetch Type

This field proposes the possible memory locations for application C code execution. It
can be either RAM, FLASH or FLASH with ART ON or OFF (only for families that
feature a proprietary Adaptive real-time (ART) memory accelerator which increases the
program execution speed when executing from Flash memory).

3
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The performance achieved thanks to the ART accelerator is equivalent to 0 wait state

program execution from Flash memory. In terms of power consumption, it is equivalent
to program execution from RAM. In addition, STM32CubeMX uses the same selection
choice to cover both settings, RAM and Flash with ART ON.

Clock Configuration

This operation sets the AHB bus frequency or the CPU frequency that will be used for
computing the microcontroller power consumption. When there is only one possible
choice, the frequencies are automatically configured.

The clock configuration drop-down list allows to configure the application clocks:
—  The internal or external oscillator sources: MSI, HSI, LS|, HSE or LSE),
—  The oscillator frequency,

—  Other determining parameters: PLL ON, LSE Bypass, AHB prescaler value, LCD
with duty...

Peripherals

The peripheral list shows the peripherals available for the selected power mode. The
power consumption is given assuming that peripherals are only clocked (e.g. not in use
by a running program). Each peripheral can be enabled or disabled. Peripherals
individual power consumptions are displayed in a tooltip. An overall consumption due
to peripheral analog and digital parts is provided in the step Results area (see

Figure 108).

The user can select the peripherals relevant for the application:

— None (Disable All),

—  Some (using IP individual checkbox),

— Al (Activate All),

—  Or all from the previously defined pinout configuration (Import Pinout).

Only the selected and enabled peripherals are taken into account when computing the
power consumption.
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Figure 108. Peripheral power consumption tooltip

MNew Step &J
)
8 JO
- Power Memory Peripherals -
Power Mode :RUN - """ ADC
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Memary Fetch Type :FLASH -
vdd 30 -
Voltage Source :Ba‘d:eryuI =l C
----- CRS
{ [¥] pAC
rClocks
| ) . . DRI —
“ CPU Frequency 32,0 MHz - @ D!_?;f«C 468 pA (Analog: 340 pA, Digital: 128 pA) | |
InterpolatonRanges | = [ ||| i~ FIREWALL
User Choice(H2) | [} FLASH
: : - [7/] GPIOA
M| Clodk Configuration HSEBYF PLL -
: GPIOB
Clodk Source Frequency | 16.0 MHz =) ] i GPIOC
----- GPIOH
rOptional Settings —M || .. 12C1
Step Duration 1 :ms - """ T2c2
: : - [7] TWDG
Additional Consumption 0 mA - £ "
. - - [J] LCD
----- LPTIM1
Resus ———— || | LPUARTL
Wl| Step Consumption 1248mA [} - PVD/BOR b
Without Peripherals 6.3ma [} PWR
----- RNG
[Peripherals Part 6.18 mA (A: 547.09 pA - D: 5.63 mA) J £
----- RTC
Ta Max ("C) o294 ] i SPI1
— -
-Warnings
| |
l Add l [ Cancel I

e  Step duration

The user can change the default step duration value. When building a sequence, the
user can either create steps according to the application actual power sequence or
define them as a percentage spent in each mode. For example, if an application
spends 30% in Run mode, 20% in Sleep and 50% in Stop, the user must configure a 3-
step sequence consisting in 30 ms in Run, 20 ms in Sleep and 50 ms in Stop.

e  Additional Consumption

This field allows entering an additional consumption resulting from specific user
configuration (e.g. MCU providing power supply to other connected devices).
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Battery glossary

Capacity (mAh)
Amount of energy that can be delivered in a single battery discharge.
Self-discharge (%/month)

This percentage, over a specified period, represents the loss of battery capacity when
the battery is not used (open-circuit conditions), as a result of internal leakage.

Nominal voltage (V)
Voltage supplied by a fully charged battery.
Max. Continuous Current (mA)

This current corresponds to the maximum current that can be delivered during the
battery lifetime period without damaging the battery.

Max. Pulse Current (mA)

This is the maximum pulse current that can be delivered exceptionally, for instance
when the application is switched on during the starting phase.
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5.1
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STM32CubeMX C Code generation overview

Refer to Section 4.4.2: Project menu for code generation and C project settings related

topics.

Standard STM32Cube code generation

During the C code generation process, STM32CubeMX performs the following actions:

1. Ifitis missing, it downloads the relevant STM32Cube firmware package from the user
repository. STM32CubeMX repository folder is specified in the Help > Updater
settings menu.

2. It copies from the firmware package, the relevant files in Drivers/CMSIS and
Drivers/STM32F4_HAL _Driver folders and in the Middleware folder if a middleware
was selected.

3. It generates the initialization C code ( .c/.h files) corresponding to the user MCU
configuration and stores it in the /nc and Src folders. By default, the following files are
included:

stm32fdxx_hal_conf.h file: this file defines the enabled HAL modules and sets
some parameters (e.g. External High Speed oscillator frequency) to predefined
default values or according to user configuration (clock tree).

stm32fdxx_hal_msp.c (MSP = MCU Support package): this file defines all
initialization functions to configure the IP instances according to the user
configuration (pin allocation, enabling of clock, use of DMA and Interrupts).

main.c is in charge of:

Resetting the MCU to a known state by calling the HAL_init() function that resets
all peripherals, initializes the Flash memory interface and the SysTick.
Configuring and initializing the system clock.

Configuring and initializing the GPIOs that are not used by IPs.

Defining and calling, for each configured IP, an IP initialization function that
defines a handle structure that will be passed to the corresponding IP HAL init
function which in turn will call the IP HAL MSP initialization function. Note that
when LwlIP (respectively USB) middleware is used, the initialization C code for the
underlying Ethernet (respectively USB IP) is moved from main.c to LwIP
(respectively USB) initialization C code itself.

mxconstants.h file:

This file contains the define statements corresponding to the pin labels set from
the Pinout tab, as well as the user project constants added from the
Configuration tab (refer to Figure 109 and Figure 110 for examples):

#define MyTimeOut 10

#define LD4_Pin GPIO_PIN 12
#define LD4_GPIO_Port GPIOD
#define LD3_Pin GPIO_PIN_13
#define LD3_GPIO_Port GPIOD
#define LD5_Pin GPIO_PIN_14
#define LD5_GPIO_Port GPIOD
#define LD6_Pin GPIO_PIN_15

3
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#define LD6_GPIO_Port GPIOD

Figure 109. Labels for pins generating define statements

Figure 110. User constant generating define statements

o Parameter Settings | &/ User Constants | ¢/ NVIC Settings | o/ GPIO Settings|

Search Constants

Gaarch (CrHLE

remove

Constant Name Constant Value
MyTimeOut 10

In case of duplicate labels, a unique suffix, consisting of the pin port letter and the
pin index number, is added and used for the generation of the associated define
statements.

In the example of a duplicate 12C1 labels shown in Figure 111, the code
generation produces the following code, keeping the 12C1 label on the original port
B pin 6 define statements and adding B7 suffix on pin 7 define statements:

#define I2C1l_Pin GPIO_PIN_6
#define I2C1_GPIO_Port GPIOB
#define I2C1B7_Pin GPIO_PIN_7

#define I2C1B7_GPIO_Port GPIOB

Figure 111. Duplicate labels

—
O
o
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In order for the generated project to compile, define statements shall follow strict

naming conventions. They shall start with a letter or an underscore as well as the
corresponding label. In addition, they shall not include any special character such
as minus sign, parenthesis or brackets. Any special character within the label will
be automatically replaced by an underscore in the define name.

If the label contains character strings between “[]” or “()”, only the first string listed
is used for the define name. As an example, the label “LD6 [Blue Led]”
corresponds the following define statements:

#define LD6_Pin GPIO_PIN_15
#define LD6_GPIO_Port GPIOD

The define statements are used to configure the GPIOs in the generated
initialization code. In the following example, the initialization of the pins labeled
Audio_RST_Pin and LD4_Pin is done using the corresponding define statements:

/*Configure GPIO pins : LD4_Pin Audio_RST Pin */
GPIO_InitStruct.Pin = LD4_Pin | Audio_RST Pin;
GPIO_InitStruct.Mode = GPIO_MODE_OUTPUT_PP;
GPIO_InitStruct.Pull = GPIO_NOPULL;
GPIO_InitStruct.Speed = GPIO_SPEED_LOW;
HAL_GPIO_Init (GPIOD, &GPIO_InitStruct);

Finally it generates a Projects folder that contains the toolchain specific files that match
the user project settings. Double-clicking the IDE specific project file launches the IDE
and loads the project ready to be edited, built and debugged.
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5.2.1

5.2.2

5.2.3

3

Custom code generation

STM32CubeMX supports custom code generation by means of a FreeMarker template
engine (see http://www.freemarker.org).

STM32CubeMX data model for FreeMarker user templates

STM32CubeMX can generate a custom code based on a FreeMarker template file (.fil
extension) for any of the following MCU configuration information:

e List of MCU peripherals used by the user configuration
e List of parameters values for those peripherals
e List of resources used by these peripherals: GPIO, DMA requests and interrupts.
The user template file must be compatible with STM32CubeMX data model. This means
that the template must start with the following lines:

[#ftl]

#1list configs as dt]

#assign data = dt]

[

[

[#assign peripheralParams =dt.peripheralParams]
[#assign peripheralGPIOParams =dt.peripheralGPIOParams]
[

#assign usedIPs =dt.usedIPs]
and end with
[/#1list]

A sample template file is provided for guidance (see Figure 112: extra_templates folder —
default content).

STM32CubeMX will also generate user-specific code if any is available within the template.

As shown in the below example, when the sample template is used, the ftl commands are
provided as comments next to the data they have generated:

FreeMarker command in template:
${peripheralParams.get ("RCC") .get ("LSI_VALUE") }

Resulting generated code:
LSI_VALUE : 32000 [peripheralParams.get ("RCC") .get ("LSI_VALUE") ]

Saving and selecting user templates

The user can either place the FreeMarker template files under STM32CubeMX installation
path within the db/extra_templates folder or in any other folder.

Then for a given project, the user will select the template files relevant for his project via the
Template Settings window accessible from the Project Settings menu (see Section 4.8:
Project Settings window)

Custom code generation

To generate custom code, the user must place the FreeMarker template file under
STM32CubeMX installation path within the db/extra_templates folder (see Figure 113:
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extra_templates folder with user templates).

The template filename must follow the naming convention <user filename>_<file
extension>.ftl in order to generate the corresponding custom file as <user filename>.<file
extension>.

By default, the custom file is generated in the user project root folder, next to the .ioc file
(see Figure 114: Project root folder with corresponding custom generated files).

To generate the custom code in a different folder, the user shall match the destination folder
tree structure in the extra_template folder (see Figure 115: User custom folder for
templates).

Figure 112. extra_templates folder — default content

mﬂﬂ « db » extra_templates - |+1,,| | Search extr.. 1

| B |

COrganize = Include in library = Share with - Bum » #= -« [T f@l

F

o 5TM32CubeMX_4_6

-~

STMicroelectronics Mame

STM32Cube ;
|| RTE_Device_h_ftl

|| sample_h_ftl
o Gl

extra_templates

* i mCu

5 Aliemine

Figure 113. extra_templates folder with user templates
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) : :

Organize = = Open Include in library = Share with = » 1= » [i ._Q‘.
STM32CubeMXx 4 6 2 Mame :
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(L myFilehi )
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e RTE Device h ftl
| plugins |
| | sample_h.ftl
ternplates ( — x )
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| help
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Figure 114. Project root folder with corresponding custom generated files

@Uv| . % Custom Code project » CustomCodeGen » - | +3 H Search Cus... P'
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Figure 115. User custom folder for templates
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Figure 116. Custom folder with corresponding custom generated files
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6

Tutorial 1: From pinout to project C code generation
using an STM32F4 MCU

This section describes the configuration and C code generation process. It takes as an
example a simple LED toggling application running on the STM32F4DISCOVERY board.

6.1 Creating a new STM32CubeMX Project

1. Select File > New project from the main menu bar or New project from the Welcome
page.

2. Select the MCU Selector tab and filter down the STM32 portfolio by selecting STM32F4
as 'Series', STM32F407 as 'Lines', and LQFP100 as 'Package’ (see Figure 117).

3. Select the STM32F407VGTx from the MCU list and click OK.

Figure 117. MCU selection
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% MNew Project ﬁ‘
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STM32CubeMX views are then populated with the selected MCU database (see
Figure 118).

Figure 118. Pinout view with MCUs selection
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Optionally, remove the MCUs Selection bottom window by unselecting Window> Outputs
sub-menu (see Figure 119).

Figure 119. Pinout view without MCUs selection window
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6.2

148/231

Configuring the MCU pinout

For a detailed description of menus, advanced actions and conflict resolutions, refer to
Section 4: STM32CubeMX User Interface and Appendix A: STM32CubeMX pin assignment
rules.

1.
2.

By default, STM32CubeMX shows the Pinout view.

By default, ["|keep Current Signals Flacement is unchecked allowing STM32CubeMX to
move the peripheral functions around and to find the optimal pin allocation, that is the
one that accommodates the maximum number of peripheral modes.

Since the MCU pin configurations must match the STM32F4DISCOVERY board,
enable ' [V]keep current signals Placement for STM32CubeMX to maintain the peripheral function
allocation (mapping) to a given pin.

This setting is saved as a user preference in order to be restored when reopening the
tool or when loading another project.

Select the required peripherals and peripheral modes:

a) Configure the GPIO to output the signal on the STM32F4DISCOVERY green LED
by right-clicking PD12 from the Chip view, then select GPIO_output:

Figure 120. GPIO pin configuration

GPIC_Cutput

b) Enable a timer to be used as timebase for toggling the LED. This is done by
selecting Internal Clock as TIM3 Clock source from the peripheral tree (see
Figure 121).

Figure 121. Timer configuration

El TIM3
----- Slave Mode :Disahle v:
----- Trigger Source :Disahle v:
----- Clock Source :Internal Clock v:
----- Channell :Disahle v:
----- Channel2 :Disahle v:
----- Channel3 :Disahle v:
----- Channel4 :Disahle v:
----- Combined Channels :Disahle v:
----- Use-ETR-as-Clearing-Source
----- XOR activation
----- [] one Pulse Mode
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c) You can also configure the RCC in order to use an external oscillator as potential
clock source (see Figure 122).

This completes the pinout configuration for this example.

Figure 122. Simple pinout configuration

¢ STM32CubeMX STM32Cube _simpleledToggle.joc STM32F4OTVGTX
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I

STM32ZF407VGTX
L@FP100

Note:

loading ST Discovery board configuration from the Board selector tab.

6.3

1.

Saving the project

click H to save the project.
When saving for the first time, select a destination folder and filename for the project.

The .ioc extension is added automatically to indicate this is an STM32CubeMX

configuration file.

Figure 123. Save Project As window

Starting with STM32CubeMX 4.2, the user can skKip the pinout configuration by directly

r

% Save Project As...
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2.

3

Click ¥ to save the project under a different name or location.
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6.4

6.5

150/231

Generating the report

Reports can be generated at any time during the configuration:
1. Click - to generate .pdf and .txt reports.

If a project file has not been created yet, a warning prompts the user to save the project
first and requests a project name and a destination folder (see Figure 124). An .ioc file
is then generated for the project along with a .pdf and .txt reports with the same name.

Answering “No” will require to provide a name and location for the report only.

A confirmation message is displayed when the operation has been successful (see
Figure 125).

Figure 124. Generate Project Report - New project creation

Generate Project Report d Y &J

The project name is generally used as report name, but no project is currently saved.
If the project is not created now, you will be asked for a report file name

Would you like to create a project first ?

Yes || No H Cancel I |

y—

Figure 125. Generate Project Report - Project successfully created

'0' Reports (Pdf and Text) are successfully generated under C:/STM32Cube_simpleLedToggle

| Open Folder | l Close ‘

2. Open the .pdf report using Adobe Reader or the .txt report using your favorite text
editor. The reports summarize all the settings and MCU configuration performed for the
project.

Configuring the MCU Clock tree

The following sequence describes how to configure the clocks required by the application
based on an STM32F4 MCU.

STM32CubeMX automatically generates the system, CPU and AHB/APB bus frequencies
from the clock sources and prescalers selected by the user. Wrong settings are detected
and highlighted in red through a dynamic validation of minimum and maximum conditions.
Useful tooltips provide a detailed description of the actions to undertake when the settings
are unavailable or wrong. User frequency selection can influence some peripheral
parameters (e.g. UART baudrate limitation).

STM32CubeMX uses the clock settings defined in the Clock tree view to generate the
initialization C code for each peripheral clock. Clock settings are performed in the generated
C code as part of RCC initialization within the project main.c and in stm32f4xx_hal_conf.h
(HSE, HSI and External clock values expressed in Hertz).
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Follow the sequence below to configure the MCU clock tree:
1. Click the Clock Configuration tab to display the clock tree (see Figure 126).

The internal (HSI, LSI), system (SYSCLK) and peripheral clock frequency fields cannot
be edited. The system and peripheral clocks can be adjusted by selecting a clock
source, and optionally by using the PLL, prescalers and multipliers.

Figure 126. Clock tree view
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FCLK Cortex dock (MHz)

Main PLL

48 |48MHz clocks (MHz)

125 source Mux

puzsak [

MCO2 source Mux

SYSOLK

| gLLLZSCIK

o)
J—» 96 |125 clocks (MHz)
Brdock |
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First select the clock source (HSE, HSI or PLLCLK) that will drive the system clock of
the microcontroller.

In the example taken for the tutorial, select HSI to use the internal 16 MHz clock (see
Figure 127).

Figure 127. HSI clock enabled

System Clock Mux

SYSCLK (MHz)
HSE il

el 16

PLLCLK
L

§ -+"

-

To use an external clock source (HSE or LSE), the RCC peripheral shall be configured
in the Pinout view since pins will be used to connect the external clock crystals (see
Figure 128).

Figure 128. HSE clock source disabled

| ‘..
}
1 o
£ J

— Ll
i "HSE O5C" is not available
d Tao enzble go back to IPRCC in Pinout Tab’

Other clock configuration options for the STM32F4DISCOVERY board would have
been:

—  To select the external HSE source and enter 8 in the HSE input frequency box
since an 8 MHz crystal is connected on the discovery board:

Figure 129. HSE clock source enabled

Input frequency

—  To select the external PLL clock source and the HSI or HSE as the PLL input clock
source.

Figure 130. External PLL clock source enabled

PLL Source Mux
HSI o
L L]

HSE
- I M

3
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Note:

6.6

6.6.1

Note:

3

3. Keep the core and peripheral clocks to 16 MHz using HSI, no PLL and no prescaling.
Optionally, further adjust the system and peripheral clocks using PLL, prescalers and
multipliers:

Other clock sources independent from the system clock can be configured as follows:

— USB OTG FS, Random Number Generator and SDIO clocks are driven by an
independent output of the PLL.

—  12S peripherals come with their own internal clock (PLLI2S), alternatively derived
by an independent external clock source.

— USB OTG HS and Ethernet Clocks are derived from an external source.

4. Optionally, configure the prescaler for the Microcontroller Clock Output (MCO) pins that
allow to output two clocks to the external circuit.

5. Click i to save the project.
6. Go to the Configuration tab to proceed with the project configuration.

Configuring the MCU initialization parameters

Reminder

The C code generated by STM32CubeMX covers the initialization of the MCU
peripherals and middlewares using the STM32Cube firmware libraries.

Initial conditions

Select the Configuration tab to display the configuration view (see Figure 131).

Peripherals and middleware modes without influence on the pinout can be disabled or
enabled in the IP Tree pane. The modes that impact the pin assignments can only be
selected through the Pinout tab.

In the main panel, tooltips and warning messages are displayed when peripherals are not
properly configured (see Section 4: STM32CubeMX User Interface for details).

The RCC peripheral initialization will use the parameter configuration done in this view as
well as the configuration done in the Clock tree view (clock source, frequencies, prescaler
values, etc...).
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Figure 131. Configuration view

N
& STM32CubeMX Untitled®: STM32FA07VGTx [ESREEE

File Project Window Help
FEeesw 85 +-mp ¢
[ Pinout | clock Configuration | Configuration | Power Consumption Calculator | OB Editor
IConfiguration
=-MiddleWares
- & FATFS
B [[] User-defined
- & FREERTOS
' [[] Enabled

E-Peripherals Middlewares
5 & CRC

i [] Activated
£ & IWDG

‘e [F] Activated

(| &8 RCC

‘- High Speed Clock (HSE):BYPASS Clock Source
=}~ % RNG

7] Activated DMA Q+
B & TIM3

i Clock Source :Internal Clock. T —°\"o
O & TIME

[[] Activated

P
l TIM3 -“{9@

|

[ (o= -

One Pulse Mode

)
B ® TIM7 1Y)
&[] Activated

: One Pulse Mode
- & WWDG
L [[] Activated

6.6.2 Configuring the peripherals

Each peripheral instance corresponds to a dedicated button in the main panel.

Some peripheral modes have no configurable parameters as illustrated below:

Figure 132. Case of IP without configuration parameters

Q RNG Configuration u

_& Warning: This IP has no supported configuration parameters.
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Follow the steps below to proceed with peripheral configuration:
1.  Click the peripheral button to open the corresponding configuration window.

In our example,

a) Click TIM3 to open the timer configuration window.

Figure 133. Timer 3 configuration window

-
@ TIM3 Configuration

==

o' Parameter Settings | o/7 User Constants | o/’ NVIC Settings | </’ DMA Settings

Configure the below parameters :

Search : L

Counter Mode

Internal Clock Division (CKD)
= Trigger Output (TRGC) Parameters

Master /Slave Mode

Trigger Event Selection

[l Counter Settings

Counter Period (AutoReload Register - 16 bits value ) 0

Up

Mo Division

Disable (no sync between this TIM (Master) and its Slaves
Reset (UG bit from TIMx_EGR)

Prescaler (PSC - 16 bits value)

Prescaler must be between 0 and 65 535.

[ Apply ] [ Ok ] [ Cancel

3
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b) With a 16 MHz APB clock (Clock tree view), set the prescaler to 16000 and the

counter period to 1000 to make the LED blink every millisecond.

Figure 134. Timer 3 configuration

[ |
TIM3 Configuration @
o Parameter Settings | o/7 User Constants | &/ NVIC Settings | </ DMA Settings|
Configure the below parameters :
Search : L
[l Counter Settings
Prescaler (P5C - 16 bits value) 16000
Counter Mode Up
I Counter Period (AutoReload Register - 16 bits value ) 0
Internal Clock Division (CKD) Mo Division
= Trigger Output (TRGO) Parameters
Master /Slave Mode Disable (no sync between this TIM (Master) and its Slaves
Trigger Event Selection Reset (UG bit from TIMx_EGR)
Prescaler (PSC - 16 bits value)
Prescaler must be between 0 and 65 535.
[ Apply ] [ Ok ] [ Cancel

Optionally and when available, select:

—  The NVIC Settings tab to display the NVIC configuration and enable interruptions

for this peripheral.

—  The DMA Settings tab to display the DMA configuration and to configure DMA

transfers for this peripheral.

In the tutorial example, the DMA is not used and the GPIO settings remain

unchanged. The interrupt is enabled as shown in Figure 135.

— The GPIO Settings tab to display the GPIO configuration and to configure the

GPIOs for this peripheral.
— Insertan item:

— The User Constants tab to specify constants to be used in the project.

Modify and click Apply or OK to save your modifications.
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6.6.3

3

Figure 135. Enabling Timer 3 interrupt

TIM3 Configuration &J

/7 Parameter Settings | o/ User Constants | o NVIC Settings | </ DMA Setﬁngs|

Interrupt Table Enabled Preemption Priority Sub Priority
ITIM3 global interrupt | |I |I
Configuring the GPIOs

The user can adjust all pin configurations from this window. A small icon along with a tooltip
indicates the configuration status.

Figure 136. GPIO configuration color scheme and tooltip

GPIO =
o

—————
GPIO: General Purpose Input Qutput
ThisIP is correctly configured. You can generate code using current valu

Follow the sequence below to configure the GPIOS:

1.

Click the GPIO button in the Configuration view to open the Pin Configuration
window below.

The first tab shows the pins that have been assigned a GPIO mode but not for a
dedicated IP. Select a Pin Name to open the configuration for that pin.

In the tutorial example, select PD12 and configure it in output push-pull mode to drive
the STM32F4DISCOVERY LED (see Figure 137).
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Figure 137. GPIO mode configuration

[ @ Pin Configuration ﬁ-‘
GPIO
Search Signals
search (Crth+F) [] Show enly Modified Fins
Pin Name 5ignalfon Pin GPIO mode GPIO Pull-up/Pu... Maximum outpu... User Label Modified
D Cuty 0 and no 0 04 d ¥l
PD 14 Configuration :
GPIO mode Cutput Push Pul -
| GPIO Pull-up /Pull-down :No pull-up and no pull-down - I
I Maximum output speed :Low v: I
User Label LD4 [Green Led]
Group By IP l Apply ] [ ok ] [ Cancel
3. Click Apply then Ok to close the window.
6.6.4 Configuring the DMAs
This is not required for the example taken for the tutorial.
It is recommended to use DMA transfers to offload the CPU. The DMA Configuration
window provides a fast and easy way to configure the DMAs (see Figure 138).
1.  Add a new DMA request and select among a list of possible configurations.
2. Select among the available streams.
3. Select the Direction: Memory to Peripheral or Peripheral to Memory.
4. Select a Priority.
Note: Configuring the DMA for a given IP can also be performed using the IP configuration
window.
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UM1718 Tutorial 1: From pinout to project C code generation using an STM32F4 MCU
Figure 138. DMA Parameters configuration window
r |
# DMA Configuration ﬂ
DMAL | DMA2 | MemToMem|
DMA Request Stream Direction Priarity
I2C1_RX DMA1 Stream 0 Peripheral To Memaor Low
\Select 3
i 2C1_TX
TIM3_CH4/UP
Add ] [ Delete
DMA Request Settings
Peripheral Memory
Mode Normal - Increment Add...
Use Fifo Thres... |Half Full - Data Width Byte - Byte -
Burst Size Single - Single -
’ Apply ] [ Ok ] [ Cancel
6.6.5 Configuring the middleware

3

This is not required for the example taken for the tutorial.

If a peripheral is required for a middleware mode, the peripheral must be configured in the
Pinout view for the middleware mode to become available. A tooltip can guide the user as

illustrated in the FatFs example below:

Figure 139. FatFs disabled

tpnﬁguratinn
-MiddleWares B
- & FATFS

e External SRAM

»

-.. [] 5D Card
i-—- [] USB Disk

LY USE Disk Dissbled:
Active only with USB Host (class MSC) middleware

A

-

-

o WO OO e PO o

-
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1. Configure the USB IP from the Pinout view.

Figure 140. USB Host configuration

- & USB_OTG_FS
: :-Mode[Host_DnIy -
[ Activate_soF

------ [ Activate_vBUS

2. Select MSC_FS class from USB Host middleware.
3. Select the checkbox to enable FatFs USB mode in the tree panel.

Figure 141. FatFs over USB mode enabled

f;]---l“ljdllle“'arﬁ
5 & FATFS
- ----- External SDRAM
----- External SRAM
- ----- SD Card
----- USE Disk
- [7] user-defined
[+~ % FREERTOS
(-
(-
- W USB_HOST
E----Class for HS IP |Disable
E----Class for FS IP [Mass Storage Host Class -

4. Select the Configuration view. FatFs and USB buttons are then displayed.

Figure 142. Configuration view with FatFs and USB enabled

o

: = )
CwE ) | Cma]

l FATFS 1= H USB_HOST <= l

3
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5. FatFs and USB using default settings are already marked as configured * . Click
FatFs and USB buttons to display default configuration settings. You can also change
them by following the guidelines provided at the bottom of the window.

Figure 143. FatFs IP instances
@ FATFS Configuration ﬂ‘

i</ TPs instances! o/’ Set Defines

Configure the below parameters :

=] USBH
USEH instance USB Host MSC FS

Apply | [ ok | [ cancel |

Figure 144. FatFs define statements

N
% FATFS Configuration ﬁ
«/ IPs instances| =/ Set Deﬁn95|

Configure the below parameters :

-

[=| Function Parameters

FS_TINY Disabled
FS_READOMLY (Read-only mode) Disabled
S Mz (Mnmaton ey [
USE_STRFUNC (Use String Functions) Enabled with LF -> CRLF conversion
USE_MKFS Enabled
USE_FORWARD Disabled
USE_LABEL Disabled
USE_FASTSEEK Enabled

Locale and Namespace Parameters
Physical Drive Parameters
System Parameters

FS_MINIMIZE (Minimization level)

_F5_MINIMIZE

Parameter Description:

The FS_MINIMIZE option defines minimization level to remove some functions.

0: Full function.

1: f_stat, f_getfree, f_unlink, f_mkdir, f_chmod, f_truncate, f_utime and f_rename are removed.
2: f_opendir and f_readdir are removed in addition to 1.

3: f_Iseek is removed in addition to 2.

Apply ] [ Ok ] [ Cancel

3
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6.7 Generating a complete C project

6.7.1 Setting project options

Default project settings can be adjusted prior to C code generation as described in
Figure 145.
1. Select Settings from the Project menu to open the Project settings window.

2. Select the Project Tab and choose a Project name, location and a toolchain to
generate the project (see Figure 145).

Figure 145. Project Settings and toolchain choice

@ Project Settings ﬁ

Project | Code Generator I Advanced Settings|

Project Settings

Project Mame
STM32Cube_SimpleLedToggle

Project Location

C:\Wsers\JohnDog\5TM32Cube projects),

Taoolchain Folder Location

C:\sers\JohnDog\STM32Cube projects\STM32Cube_SimpleLedTogale,

Toolchain / IDE

Cther Toolchains (GPDSC)

Mcu and Firmware Package

Mcu Reference
STM32F427ZGTx

Firmware Package Mame and Version

STM32Cube FW_F4V1.11.0RC2 Use latest available version

[ ok | | concl

3
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3. Select the Code Generator tab to choose various C code generation options:

The library files copied to Projects folder.
C code regeneration (e.g. what is kept or backed up during C code regeneration).

HAL specific action (e.g. set all free pins as analog 1/Os to reduce MCU power
consumption).

In the tutorial example, select the settings as displayed in the figure below and click

OK.

Note: A dialog window appears when the firmware package is missing. Go to next section for
explanation on how to download the firmware package.

Figure 146. Project Settings menu - Code Generator tab

Project Settings

S

Code Generator | Advanced Settings

STM32Cube Firmware Library Package
(") Copy all used libraries into the project folder

(") Copy only the necessary library files

(@ Add necessary library files as reference in the toolchain project configuration file

Generated files

HAL Settings

[] Generate peripheral initialization as a pair of '.cf.h' files per IP
[] Backup previously generated files when re-generating
Keep User Code when re-generating

Delete previously generated files when not re-generated

Set all free pins as analog (to optimize the power consumption)

[] Enable Full Assert

Template Settings

Select a template to generate customized code Settings...

Ok ] [ Cancel

3
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6.7.2 Downloading firmware package and generating the C code

1. Click “= to generate the C code.

During C code generation, STM32CubeMX copies files from the relevant STM32Cube
firmware package into the project folder so that the project can be compiled. When
generating a project for the first time, the firmware package is not available on the user
PC and a warning message is displayed:

Figure 147. Missing firmware package warning message
Project Manager Settings [ﬁ,l

The Firmware Package (STM32Cube FW_F ¥V1.11.0 )  or one of its dependencies required by the Project is not available in your STM32CubeMX Repository.
Do you want to download this now 7

N

2.  STM32CubeMX offers to download the relevant firmware package or to go on. Click
Download to obtain a complete project, that is a project ready to be used in the
selected IDE.

By clicking Continue, only /nc and Src folders will be created, holding STM32CubeMX
generated initialization files. The necessary firmware and middleware libraries will have
to be copied manually to obtain a complete project.

If the download fails, the below error message is displayed:

Figure 148. Error during download

Problem during Download and/or Unzip ﬁ

.: v ) Error during Access to HTTP Server.
Please check Proxy settings under 'Help = Updater Settings = Connection Parameters'.

To solve this issue, execute the next two steps. Skip them otherwise.

3
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3. Select Help > Updater settings menu and adjust the connection parameters to match
your network configuration.

Figure 149. Updater settings for download

Updater Settings ﬁ

| Updater Settings| Connection Parameters

Proxy Server Type
1) No Proxy

() Use System Proxy Parameters

I (@) Manual Configuration of Proxy Server I

Manual Configuration of Proxy Server

Froxy HTTP  do.it.mycompany.com Port | 8080

I Authentification I
Require Authentification

User Loggin JohnDoe

Password |essssssssssss

[ A& Check Connection ]

’ oK ] [ Cancel ]

4. Click Check connection. The check mark turns green once the connection is
established.

3
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Figure 150. Updater settings with connection

Updater Settings ﬁ
Updater Settings| Connection Parameters|

Proxy Server Type
1) No Proxy

7

Use System Proxy Parameters

I (@) Manual Configuration of Proxy Server I

Manual Configuration of Proxy Server

Proxy HTTP | do.it. mycompany.com Port (8080

I Authentification I
Require Authentification

User Loggin | JohnDoe

Password | eesssssssssese

[ /" Check Connection ]

’ OK ] i cancel

5.  Once the connection is functional, click to generate the C code. The C code
generation process starts and progress is displayed as illustrated in the next figures.

Figure 151. Downloading the firmware package

Download selected Firmware & Software lihj

Download File stm32cube_fw_f4_v080.zip
. 2.9 MBytes / 54.8 MBytes

Download and Unzip selected Files

3
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Figure 152. Unzipping the firmware package

Download selected Firmware & Software ﬁ

Unzip File : stm32cube_fw_f4 v082.zip
[

Download and Unzip selected Files OK
|

6. Finally, a confirmation message is displayed to indicate that the C code generation has
been successful.

Figure 153. C code generation completion message

- B
# Code Generation ﬁ

The Code is successfully generated under C:/STM32CubeMX_Projects/STM32Cube_simpleLedToggle

COpen Folder ] | Open Projectél ’ Close

3
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7.

Click Open Folder to display the generated project contents or click Open Project to
open the project directly in your IDE. Then proceed with Section 6.8.

Figure 154. C code generation output folder

"I: ‘ @
@uﬂ « STM3.. » STM32Cube Si.. » v |4 [l SearchsT  Simpleled.. P
File Edit View Tools Help
Organize ~ -/ Open Include in library v » = - I e
4 | STM32Cube_SimpleLedToggle  “*  Name N B
Drivers )
Drivers
Inc
| Inc
Middlewares i =
i | Middlewares F
Projects =
| . Projects
Src
Src I
= STM32Cube_SimpleLedToggleioc  ~
Ll | il }
Projects Date modified: 2/3/2014 10:05 AM

§ rile 1older |J

The generated project contains:

The STM32CubeMX .ioc project file located in the root folder. It contains the project
user configuration and settings generated through STM32CubeMX user interface.

The Drivers and Middlewares folders hold copies of the firmware package files relevant
for the user configuration.

The Projects folder contains IDE specific folders with all the files required for the project
development and debug within the IDE.

The Inc and Src folders contain STM32CubeMX generated files for middleware,
peripheral and GPIO initialization, including the main.c file. The STM32CubeMX
generated files contain user-dedicated sections allowing to insert user-defined C code.

C code written within the user sections is preserved at next C code generation, while C code
written outside these sections is overwritten.

User C code will be lost if user sections are moved or if user sections delimiters are
renamed.

3
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6.8

3

Building and updating the C code project

This example explains how to use the generated initialization C code and complete the
project, within IAR EWARM toolchain, to have the LED blink according to the TIM3

frequency.

A folder is available for the toolchains selected for C code generation: the project can be
generated for more than one toolchain by choosing a different toolchain from the Project
Settings menu and clicking Generate code once again.

1.  Open the project directly in the IDE toolchain by clicking Open Project from the dialog
window or by double-clicking the relevant IDE file available in the toolchain folder under

STM32CubeMX generated project directory (see Figure 153).

Figure 155. C code generation output: Projects folder

[ P ———— oo
; L2 « ¥y STM32Cube_simpleLedToggle » - |+ Search STM.. PI
L p g9 pd

File Edit View Tools Help
Organize = Include in library = Share with = Burn Mew folder g | ..@.
- 5TM32Cube_simpleLedToggle % Mame .
Drivers :
Drivers
EWARM
EWARM
Inc
, Inc
MDK-ARM L
MDK-ARM
J Src ||
Src
SWASTM32
SW4STM32
TrueSTUDIO
TrueSTUDIO
|| .mxproject "
® 5TM32Cube_simpleLledToggleioc
3 | 5TM32Cube_simpleLedToggle.td |
" 5TM32Cube_simpleLedToggle_Configuration.pdf
- |4 il p
11 items
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2.

As an example, select .eww file to load the project in the IAR EWARM IDE.

Figure 156. C code generation for EWARM

= [

G-

b 5TM32Cube_simpleLedToggle » EWARM »

+ [42 |[ Searchew.. o

:/6 IAR IDE Workspace

File Edit View Tools Help
Organize v g@' Open « Burn MNew folder = « [ @.
9 S
5TM32Cube_simpleledToggle = Name Date modified
Drivers . "
) settings 7/28/2015 2:44
. EWARM . ,
: 5TM32Cube_simpleLedToggle Configura... 2015 2:44
. Inc ——— e
| 4] Project.ewan 2015 2:39
MDE-ARM ; - -
5 | STM32Cube_simpleLedToggle.ewd 1/28/2015 2:39
y Src
|| STM32Cube_simpleLedToggle.ewp 7/28/2015 2:39
SWASTM32 ; L
| strn32f4070e_flash.icf 7/16/2015 5:52
. TrueSTUDIO :
| stm32f407:0_sram.icf 7/16/2015 5:52
+ | . | 3
i Project.eww Date modified: 7/28/2015 2:39 PM Date created: 7/28/2015 2:39 PM

Size: 169 bytes
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3. Select the main.c file to open in editor.

Figure 157. STM32CubeMX generated project open in IAR IDE

& Project - IAR Embedded Waorkbench IDE =NAEE X

File Edit View Project Tools Window Help

==y ==y | o o | - "mEe &P |BEDEGE 2|2

Workspace x L fl «x
S5TM32Cube_simpleledT ogale Configuration A /% Includes f
Eileg ) #include "stm32f4xx _hal.h"

/* USER CODE BEGIN Includes */

B STM32Cube_simpleLedToggle... v /* USER CODE END Includes #/

8 03 Application

| CIEWARM /* Private wvariables

| Letuser TIM HandleTypeDef htim3;

| main.c /+# USER CODE BEGIN BV +/

| st 32fde_hal_msp.c /* Private variables

| stmaefdor_itc /* USER CODE END FV #/

[ Drivers

3 Dutput /* Private function prototypes

wvoid SystemClock_Config(wvoid):
static void ME_GPIO Init (woid);
static void ME_TIM3_Init(void); |
/* USER CODE BEGIN FFF +*/ I
/* USER CODE END PFF */

m

/* USER CODE BEGIN 0 */ b
/* USER CODE END 0 */
int main(void)
B {
/* USER CODE BEGIN 1 #/
/* USER CODE END 1 *=/
/* MCU Configuration
/* Reset of all peripherals, Initiaslizes the Flash interface and the 5y
HAL Init();
/* Configure the system clock *#/
SystemClock_Config():
/* Initialize all configured peripherals *#/
MX_GPIO Init();
MX_TIM3 Init();:
/% USER CODE BEGIN 2 */
/* USER CODE END 2 */
/* Infinite loop */
/* USER CODE BEGIN WHILE +*/
while (1)
B
/* USER CODE END WHILE +#/
/* USER CODE BEGIN 3 #/
rol
/* USER CODE END 3 #/

I | S5TM32Cube_simpleledToggle

[Ready Ln51, Coll System NL

The htim3 structure handler, system clock, GPIO and TIM3 initialization functions are
defined. The initialization functions are called in the main.c. For now the user C code
sections are empty.

3
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4. Inthe IAR IDE, right-click the project name and select Options.

Figure 158. IAR options

’STMSECUbe_SimpIeLedTDggIe Caonfiguration vl

& [ Application
= [ Drivers
& C1Example
L@ (3 Output

Files ii £ DB

=fa|STM32Cube_SimpleLedToggle..| v | |

x

x

x

5. Click the ST-LINK category and make sure SWD is selected to communicate with the

STM32F4DISCOVERY board. Click OK.

Figure 159. SWD connection

r

Options for node "STM32Cube_SimpleLedToggle™

=5

Category:

General Options >
CfC++ Compiler

Assembler ST-LINK

Factony Settings

Output Converter

Custom Build Rese

Build Actions INormaI

Linker
Debugger Interface Clock setup
Simulator
Angel
CMSIS DAP
GDB Server
IAR ROM-manitor
Tjet/TTAGjet
JHink/-Trace
T1 Stellaris

Macraigor

‘._:_.'JTAG CPU clock

111

SWO clock

PE micra
RDIL

720 MHz

[ Auto

2000 kHz

STLINK

Third-Party Driver
T1 XD5100/200 N

ok ||

Cancel
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6. Select Project > Rebuild all. Check if the project building has succeeded.

Figure 160. Project building log

Messages

st 32fdxe_hal_tim.c

st 32fdx_hal_tim_ex.c
st 32fdw_itc

st 32fdxe_|_sdmmc.c
system_stm32{dc
Linking

Taotal number of errars: 0
Total number of warnings: 0

7. Add user C code in the dedicated user sections only.
Note: The main while(1) loop is placed in a user section.
For example:
a) Edit the main.c file.
b) To start timer 3, update User Section 2 with the following C code:

Figure 161. User Section 2

HAL Init{):

/* Configure the system clock */
SystemClock Config():

J#% Initialize all configured peripherals #/
MX GPIO Init{):

MX TIM3 Init{):

/* USER CODE BEGIN 2 */
HAL TIM Base Start IT (shtim3)}:
/* USER CODE END 2 */

/% Infinite loop */

/* USER CODE BESIN WHILE #/
while (1}

{

c) Then, add the following C code in User Section 4:

Figure 162. User Section 4

AF USER CODE BEGIN 4 +/7

wvoid HAL_TIM PeriodElapsedCallback (TIM HandleTypeDef *htim)
{

if | htim->Instance == htim3.Instance )

{

HAL GPIO _TogglePin(GPIOD, GPIO_FPIN 1Z):

}
¥
A% USER CODE END 4 =7

3
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10.

This C code implements the weak callback function defined in the HAL timer driver
(stm32f4xx_hal_tim.h) to toggle the GPIO pin driving the green LED when the
timer counter period has elapsed.

Rebuild and program your board using |2 .. Make sure the SWD ST-LINK option is
checked as a Project options otherwise board programming will fail.

-

Launch the program using =<~ | The green LED on the STM32F4DISCOVERY board
will blink every second.

To change the MCU configuration, go back to STM32CubeMX user interface,
implement the changes and regenerate the C code. The project will be updated,
preserving the C code in the user sections if || Keep Current Signals Placement option in
Project Settings is enabled.

6.9 Switching to another MCU

STM32CubeMX allows loading a project configuration on an MCU of the same series.

Proceed as follows:

1.
2.

174/231

Select File > New Project.

Select an MCU belonging to the same series. As an example, you can select the
STM32F429ZITx that is the core MCU of the 32F429IDISCOVERY board.

Select File > Import project. In the Import project window, browse to the .ioc file to
load. A message warns you that the currently selected MCU (STM32F429ZITx) differs
from the one specified in the .ioc file (STM32F407VGTx). Several import options are
proposed (see Figure 163).

Click the Try Import button and check the import status to verify if the import
succeeded (see Figure 164).

Click OK to really import the project. An output tab is then displayed to report the import
results.

The green LED on 32F429IDISCOVERY board is connected to PG13: CTRL+ right
click PD12 and drag and drop it on PG13.

Select Project > Settings to configure the new project name and folder location. Click
Generate icon to save the project and generate the code.

Select Open the project from the dialog window, update the user sections with the

user code, making sure to update the GPIO settings for PG13. Build the project and
flash the board. Launch the program and check that LED blinks once per second.

3
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Figure 163. Import Project menu

S

Import Project

Imported Project
2 \STM32CubeMy_Projects\4_10_UMYSTM32Cube_simpleLedToggle\STM32Cube_simpleLedToggle.ioc [I]

Import MY Settings

Import PCC settings

Import Finout/Clock Configuration/Configuration Settings

(@ Automatic Import
() Manual Import
Import Pinning Status
Import Peripherals Configuration

Peripheral List

NVIC
RCC
TIM3
GPIO
Try Import Show View -Pinout - ]
Import Status

Import Analysis: C:\5TM32CubeMX Projectsi4 10 UM\STM32Cube simpl¢

W

I T 3
Figure 164. Project Import status
Try Import Show View :Pinout v:
Im\pnrt Status
Inport Try :

m

Inporting Pinout
Inporting IP configurations
Inport project completed
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7 Tutorial 2 - Example of FatFs on an SD card using
STM324291-EVAL evaluation board

The tutorial consists in creating and writing to a file on the STM32429I-EVAL1 SD card using
the FatFs file system middleware.

To generate a project and run tutorial 2, follow the sequence below:
1.  Launch STM32CubeMX.

2. Select File > New Project. The Project window opens.

3. Click the Board Selector Tab to display the list of ST boards.

4. Select EvalBoard as type of Board and STM32F4 as series to filter down the list.

5. Leave the option Initialize all IPs with their default mode unchecked so that the code

is generated only for the IPs used by the application.

6. Select the STM32429I-EVAL board and click OK. The Pinout view is loaded, matching
the MCU pinout configuration on the evaluation board (see Figure 165).

Figure 165. Board selection

r ~
% MNew Project @
MCU Selector | Board Selectar
Board Filter
Vendor : Type of Board : MCU Series :
:STMicroeIechonics - :EvaIBoard - :5TM32F4 -
[] mnitialize all IP with their default Mode
Peripheral Selection Boards List: 5 Items
Peripherals Mo Max Type Reference MCU
@ |Accelerometer |} EvalBoard |5TM324DG-EVAL STM32F4071G
J EvalBoard STM3241G-EVAL STM32F4171G
@ |Audio Line In [&] alBoard 429]-EVA SN
@ |Audio Line Out |:| EvalBoard STM324391-EVAL2 STM32F439NT I
@ [Button 1) EvalBoard STM32946E-EVAL STM32F4496ZE
@|CAN 0 N
@|Camera ]
) Ol
@ |Digital /0 0 i
@ [Eeprom [}
@ Ethernet ] |
Flash Memary 1}
@ |Graphic Lcd Display [l
o I
@rDa ]
@ |Joystick [0
) (]
@ |Led 1]
) 0
Memory Card ]
@ Micro 0
@ |Potentiometer ]
P ]
@Rs-232 0
| @ 0
@ |SRAM/SDRAM 1]
@ |Speaker [l
2 I
D (&
@[use 0
| - - T — — — - -
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7. From the Peripheral tree on the left, expand the SDIO IP and select the SD 4 bits wide
bus (see Figure 166).

Figure 166. SDIO IP configuration

-

=&\ SDIO
~-Mode 5D 4 bits Wide bus -

8. Under the Middlewares category, check “SD Card” as FatFs mode (see Figure 167).

Figure 167. FatFs mode configuration

Configuration
I-MiddleWares
. B+ ® FATFS

External SDRAM
: External SRAM
- [] 5D Card
‘ IJSE Disk
[ User-defined

9. Configure the clocks as follows:
a) Select the RCC peripheral from the Pinout view (see Figure 168).

Figure 168. RCC peripheral configuration

24\ RCC
| g----High Speed Clock (HSE) 'CrystaIfCEramic Resonator -
g----Low Speed Clock (LSE) |Disable v

L || Master Clock Output 1
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b) Configure the clock tree from the clock tab (see Figure 169).
Figure 169. Clock tree view
e System Clock Mux
-|SI.
= HSE SYSCLK (MHz) AHB Prescaler HCLK (MHz)
’ - -~ 168 =1 168 =
PLL Sourm Mux P‘._\_Eﬁ - o
HSI . A
1 & —= Enable CSS
Input frequency - s25 X336 « f2 o
~~-vﬂ«.’:1} HSE %55 - | F N [ /P
Main PLL Q

10. In the Project Settings menu, specify the project name and destination folder. Then,
select the EWARM IDE toolchain.

Figure 170. Project Settings menu - Code Generator tab

e

@ Project Settings

===

Project | Code Generator

Project Settings
Project Name
fatfs_sd_test

Project Location

Toolchain Folder Location

Toolchain [ IDE
EWARM

Mcu and Firmware Package

Mcu Reference
STM32F429MNIHx

STM32Cube FW_F4V1.8.0

C:\sT™ 32CubEM3{_P‘rojects‘|ETM 32F429NI-5TM32F429I-EVAL L

C:\STM32CubeMy,_Projects\STM32F429NI-5TM32F4251-EVAL 1\fatfs_sd_test)

Firmware Package Mame and Version

Browse

Use latest available version

ok ]

Cancel
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11. Click Ok. Then, in the toolbar menu, click ,-I}

to generate the project.

12. Upon code generation completion, click Open Project in the Code Generation dialog
window (see Figure 171). This opens the project directly in the IDE.

Figure 171. C code generation completion message

=
% Code Generation

==

Open Folder ] EOpen Projectél [ Close

The Code is successfully generated under C:/STM32CubelMX_Projects/STM32F429NI-5TM32F4291-EVALL /fatfs_sd_test

13. In the IDE, check that heap and stack sizes are sufficient: right click the project name
and select Options, then select Linker. Check Override default to use the icf file from

STM32CubeMX generated project folder. Adjust the heap and stack sizes (see

Figure 172).

Figure 172. IDE workspace

Options for node "fatfs_sd_test”

B

Categony:

General Options
Static Analysis
Runtime Checking
C/C++ Compiler
Assembler
Qutput Conwverter
Custom Build
Build Actions
Debugger
Simulator
Angel
CMSIS DAP
GDE Server
IAR. ROM-monitor
I§et/ITAGjet
Jink/1-Trace
TI Stellaris
Macraigor
PE micro
RDI
ST-LINK
Third-Party Driver
TLXDS

Factary Settings

Config |Lib|T:|r'_.' I Input |Optirnization5 IM\ranced I Cutput I List I o 12

Linker corfiguration file
Overmide defautt
SPROJ_DIRS \stm32f425%0:_flash icf

Corfiguration file symbol definttions: fone per line)

]

Linker configuration file editor

CSTACK 0300

HEAP 0x400

Vector Table | Memary Regions | Stack/Heap Sizes

Save ] [ Cancel

3

DoclD025776 Rev 15

179/231




Tutorial 2 - Example of FatFs on an SD card using STM32429I-EVAL evaluation board

UM1718

Note: When using the MDK-ARM toolchain, go to the Application/MDK-ARM folder and double

click the startup_xx.s file to edit and adjust the heap and stack sizes there.
14. Go to the Application/User folder. Double click the main.c file and edit it.

15. The tutorial consists in creating and writing to a file on the evaluation board SD card

using the FatFs file system middleware:
a) At startup all LEDs are OFF.

b) The red LED is turned ON to indicate that an error occurred (FatFs initialization,

file read/write access errors..).

c) Theorange LED is turned ON to indicate that the FatFs link has been successfully

mounted on the SD driver.

d) The blue LED is turned ON to indicate that the file has been successfully written to

the SD Card.

e) The green LED is turned ON to indicate that the file has been successfully read

from file the SD Card.
16. For use case implementation, update main.c with the following code:

a) Insert main.c private variables in a dedicated user code section:
/* USER CODE BEGIN PV */

/* Private variables -----------------m */
FATFS SDFatFs; /* File system object for SD card logical drive */

FIL MyFile; /* File object */
const char wtext[] = "Hello World!";
const uint8_t imagel bmp[] = ({

0x42,0x4d, 0x36,0x84,0x03,0x00,0x00,0x00,0x00,0x00,0x36,0x00,0x00,0x00,
0x28,0x00,0x00,0x00,0x40,0x01,0x00,0x00,0x£f0,0x00,0x00,0x00,0x01,0x00,
0x18,0x00,0x00,0x00, 0x00,0x00,0x00,0x84,0x03,0x00,0x00,0x00,0x00,0x00,
0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x29, 0x74,
0x51, 0x0e, 0x63,0x30, 0x04, 0x4c, 0x1d, 0x0f, 0x56, 0x25,0x11, 0x79,0x41,0x1£,
0x85,0x6f, 0x25,0x79, 0x7e,0x27,0x72,0x72, 0x0b, 0x50, 0x43,0x00, 0x44, 0x15,
0x00, 0x4b, 0x0f, 0x00, Ox4a, 0x15,0x07,0x50,0x16,0x03,0x54,0x22,0x23,0x70,
0x65,0x30,0x82, 0x6d, 0x0f, O0x6c, 0x3e, 0x22,0x80, 0x5d, 0x23, 0x8b, 0x5b, 0x261} ;

/* USER CODE END PV */
b) Insert main functional local variables:

int main(void)

{

/* USER CODE BEGIN 1 */

FRESULT res; /* FatFs function common result code */

uint32_t byteswritten, bytesread; /* File write/read counts */
char rtext[256]; /* File read buffer */
/* USER CODE END 1 */

/* MCU Configuration-------------—--———————————————————————— */

/* Reset of all peripherals, Initializes the Flash interface and the

Systick. */
HAL_Init();
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c) Insert user code in the main function, after initialization calls and before the while
loop, to perform actual read/write from/to the SD card:

int main(void)

{

MX_FATFS_Init();

/* USER CODE BEGIN 2 */
/*##-0- Turn all LEDs off(red, green, orange and blue) */
HAL_GPIO_WritePin(GPIOG, (GPIO_PIN_10 | GPIO_PIN_6 | GPIO_PIN_7 |
GPIO_PIN_12), GPIO_PIN_SET) ;
/*##-1- FatFS: Link the SD disk I/O0 driver ########H##*/
if (retSD == 0) {
/* success: set the orange LED on */

HAL_GPIO_WritePin (GPIOG, GPIO_PIN_7, GPIO_PIN_RESET);
/*##-2- Register the file system object to the FatFs module ###*/
if (f_mount (&SDFatFs, (TCHAR const*)SD_Path, 0) != FR_OK){

/* FatFs Initialization Error : set the red LED on */
HAL_GPIO_WritePin (GPIOG, GPIO_PIN_10, GPIO_PIN_RESET) ;
while (1) ;

} else {
/*##-3- Create a FAT file system (format) on the logical drive#*/
/* WARNING: Formatting the uSD card will delete all content on the
device */
if (f_mkfs ( (TCHAR const*)SD_Path, 0, 0) !'= FR_OK){
/* FatFs Format Error : set the red LED on */
HAL_GPIO_WritePin (GPIOG, GPIO_PIN_10, GPIO_PIN_RESET) ;
while (1) ;

} else {
/*##-4- Create & Open a new text file object with write access#*/

if (f_open(&MyFile, "Hello.txt", FA_CREATE_ALWAYS | FA_WRITE) !=
FR_OK) {

/* 'Hello.txt' file Open for write Error : set the red LED on */

HAL_GPIO_WritePin (GPIOG, GPIO_PIN_10, GPIO_PIN_RESET) ;

while(1l);
} else {
/*##-5- Write data to the text file ########H#HHH#FHEFHRE/
res = f_write(&MyFile, wtext, sizeof (wtext), (void

*) &byteswritten) ;
if ((byteswritten == 0) || (res != FR_OK)){
/* 'Hello.txt' file Write or EOF Error : set the red LED on */
HAL_GPIO_WritePin (GPIOG, GPIO_PIN_10, GPIO_PIN_RESET) ;

while(1);
} else {

/*##-6- Successful open/write : set the blue LED on */
HAL_GPIO_WritePin (GPIOG, GPIO_PIN_12, GPIO_PIN_RESET);
f_close(&MyFile) ;

/*##-7- Open the text file object with read access #*/
if (f_open (&MyFile, "Hello.txt", FA_READ) != FR_OK) {

/* 'Hello.txt' file Open for read Error : set the red LED on */

3
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HAL_GPIO_WritePin (GPIOG, GPIO_PIN_10, GPIO_PIN_RESET) ;

while (1) ;
} else {
/*##-8- Read data from the text file #####H###H#>/
res = f_read(&MyFile, rtext, sizeof (wtext), &bytesread);
if ((strcmp (rtext,wtext) !=0) || (res != FR_OK)){

/* 'Hello.txt' file Read or EOF Error : set the red LED on */
HAL_GPIO_WritePin (GPIOG, GPIO_PIN_10, GPIO_PIN_RESET) ;
while(1);

} else {

/* Successful read : set the green LED On */

HAL_GPIO_WritePin (GPIOG, GPIO_PIN_6, GPIO_PIN_RESET) ;
/*##-9- Close the open text file ####H#H#HH#HHHHFH#H#H#Y/
f_close(&MyFile) ;

BB BEDE

/*##-10- Unlink the micro SD disk I/O driver #########*/
FATFS_UnLinkDriver (SD_Path) ;

/* USER CODE END 2 */
/* Infinite loop */

/* USER CODE BEGIN WHILE */
while (1)

3
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8

8.1

Note:

3

Tutorial 3- Using PCC to optimize the embedded
application power consumption and more

Tutorial overview

This tutorial focuses on STM32CubeMX Power Consumption Calculator (PCC) feature and
its benefits to evaluate the impacts of power-saving techniques on a given application
sequence.

The key considerations to reduce a given application power consumption are:

e Reducing the operating voltage

¢ Reducing the time spent in energy consuming modes

It is up to the developer to select a configuration that will give the best compromise
between low-power consumption and performance.

e  Maximizing the time spent in non-active and low-power modes
e  Using the optimal clock configuration

The core should always operate at relatively good speed, since reducing the operating
frequency can increase energy consumption if the microcontroller has to remain for a
long time in an active operating mode to perform a given operation.

e  Enabling only the peripherals relevant for the current application state and clock-gating
the others

e  When relevant, using the peripherals with low-power features (e.g. waking up the
microcontroller with the 12C)

e  Minimizing the number of state transitions
e  Optimizing memory accesses during code execution
—  Prefer code execution from RAM to Flash memory
— When relevant, consider aligning CPU frequency with Flash memory operating
frequency for zero wait states.

The following tutorial will show how STM32CubeMX PCC feature can help to tune an
application to minimize its power consumption and extend the battery life.

PCC does not account for I/O dynamic current consumption and external board components
that can also affect current consumption. For this purpose, an “additional consumption” field
is provided for the user to specify such consumption value.
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8.2 Application example description

The application is designed using the NUCLEO-L476RG board based on a
STM32L476RGTx device and supplied by a 2.4 V battery.

The main purpose of this application is to perform ADC measurements and transfer the
conversion results over UART. It uses:

e  Multiple low-power modes: Low-power run, Low-power sleep, Sleep, Stop and Standby
e  Multiple peripherals: USART, DMA, Timer, COMP, DAC and RTC

— The RTC is used to run a calendar and to wake up the CPU from Standby when a
specified time has elapsed.

—  The DMA transfers ADC measurements from ADC to memory
— The USART is used in conjunction with the DMA to send/receive data via the
virtual COM port and to wake up the CPU from Stop mode.

The process to optimize such complex application is to start describing first a functional only
sequence then to introduce, on a step by step basis, the low-power features provided by the
STM32L476RG microcontroller.

8.3 Using the Power Consumption Calculator

8.3.1 Creating a PCC sequence

Follow the steps below to open PCC and create the sequence (see Figure 173):
1. Launch STM32CubeMX.
2. Click new project and select the Nucleo-L476RG board from the Board tab.

3. Click the Power Consumption Calculator tab to select the Power Consumption
Calculator view. A first sequence is then created as a reference.

4. Adapt it to minimize the overall current consumption. To do this:

a) Select2.4V Vpp power supply. This value can be adjusted on a step by step basis
(see Figure 174).

b) Select the Li-MnO2 (CR2032) battery. This step is optional. The battery type can
be changed later on (see Figure 174).

3
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Figure 173. Power Consumption Calculation example

N
© STM32CubeMX L4_testioc™; STM32L476RGTx NUCLEQ-L476RG . . . ‘ vy 5 bt =)
File Project Power Window Help

GoRUER &G s @9 $
[ Pinout | clod Configuration | Configuration | Power Consumption Calcuiator |
4 |r5tep Sequence Transitions Chedker
Microcontroller Selected () | P - A 1 ¥ ~ | { E E] 2 [ Fon 1
Series STM32L4 Sequence Table
Line STM32L4x6 Step Mode Range/Scale Memory ... ClockC... SrcFreq Periphe... Add.C... StepC... Duration DMIPS Voltag... TaMax  Category
McU STM32L476RGTx
Datasheet 025976_Rev3 1 RUN 2.4 |Rangei-High FLASH/A... |... HSE 24.0MHz |ADC1:fs... [0 mA 9.36mA  [1ms 30.0 Battery  [103.99  |Datasheet | o
2 STANDBY 2.4 |NoRange nfa .. LSIRTC |37.0kHz RTC* 0 mA 046 pA  [1ms 0.0 Battery 105 Datasheet ||
= 3 WU_FROM_ST... |2.4 [NoRange nfa ..MSIFAST 4.0 MHz 0 mA 1.7 mA 20.1ps 0.0 Battery 104.82 Datasheet
Parameter Selection "'_‘) 4 RUN 2.4 |Range1-High FLASH/A... |...HSE 16.0MHz RTC 0 mA 216mA  [1ms 20.0 Battery 104.77 Datasheet
5 RUN 2.4 [Range2-Medium  FLASHJA... |... HSE 16.0 MHz |ADC1:fs... |0 mA 1.92mA  [1ms 20.0 Battery  |104.79 Datasheet
Ambient Temp... [ 25 - & SLEEP 2.4 |Range2-Medium  [ON . [HSE 16,0 MHz |ADC1:fs... |0 mA 703.2pA (1ms 0.0 Battery 104,92 Datasheet | &
Vdd Power Su.., | 2.4 - 7 RUN 2.4 Range2-Medium  [FLASH/A... |...HSE 16.0MHz |DMALR... [0mA 192mA [Ims 20,0 Battery 104.79 Datasheet
8 STOP1 2.4 |NoRange nfa ..|ALLCLO... |DHz USART1* [0 mA 6.65pA  [1ms 0.0 Battery 105 InD5Ta...
9 WU_FROM_ST... |2.4 |NoRange nfa .|HSI16 16.0 MHz 0 mA 1.62mA  |5.3ps 0.0 Battery 104.83 Datasheet
Rattery Selactson ) 10 RUN 2.4 [Range2 Medium  |FLASH/A... |...|HSE 16.0MHz RTCUSA...[0mA 183mA  |ims 20.0 Battery  |104.3 Datasheet | —
- 1 STAMNDEY 2.4 INoRange nfa L LSIRTC  [37.0kHz |IRTC*® 0 mA 0460A  ims 0.0 Battery  |105 Datasheet | ™
Pt
Battery LiMnO2(CR2D... Flat: All Stzps
|| series 1= Consumption Profile by Step
Ml nPparale 1=
T
Capadity 225.0 mAh Z .5 L RUN
Self Discharge  0.12 %/manth :'
Nominal Voltage 3.0V E 50
2= LRUN SIRUN TIRUN 10:RUN
Max Cont Curr.... 3.0 mA E 3 wsT BY : ’ 5:WSTOP
z l 6:SLEEP l / l
Max Pulse Cur... 15.0mA 5 25 2STAND! 8:5TOP1 11.STANDRY
: ] 1 |
Information Not ® e
niarmation Hetes = 00 05 10 15 20 25 30 35 40 45 50 55 60 &5 70 75 &0 85 90
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Help ®
==1Idd by Step == Average Current|
Sequence Time / Ta Max 9ms /103.99 °C Average Consumption 1.99 mA
Baitery Life Estimation 4 days, 18 howrs (Battery compatibility not garanteed with defined step(s)) Average DMIPS 22.0 DMIPS
= — = =
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Figure 174. PCC Vpp and battery selection menu

Microcontroller Selected =)

Series: STM32L4

Line: STM32L4x6

MCL: STM32L476RGTx

Datasheet: 025576_Rev3

Parameter Selection 'é ]

Ambient Temperature (°C): j25 -

Vdd Power Supply (V): :2.4 -

Battery Selection 'é )
Select i

Battery: Li-MnO2{CR2032)

In Series: 1=

In Parallel: 1=

Capacity: 225.0 mah

Self Discharge: 0.12 %/month

MNominal Voltage: 6.0V

Max Cont Current: 3.0 mA

Max Pulse Current: 15.0 mA

5. Enable the Transition checker to ensure the sequence is valid (see Figure 174). This
option allows verifying that the sequence respects the allowed transitions implemented
within the STM32L476RG.

6. Click the Add button to add steps that match the sequence described in Figure 174.
— By default the steps last 1 ms each, except for the wakeup transitions that are

preset using the transition times specified in the product datasheet (see

Figure 175).

—  Some peripherals for which consumption is unavailable or negligible are
highlighted with *’ (see Figure 175).
Figure 175. PCC Sequence table

Sequence Table
Step Mode . Range/Scale Memory . Clock C... SrcFreq Periphe... Add. C,.. StepC,,, Duraton DMIPS Voltag... TaMax Category
1 RUN 2.4 |Range1-High FLASH/A... |...|HSE 24,0MHz |ADCL:fe... 0 mA 0.36mA  |ims 30.0 Battery  [103.99  [Datasheet | .
2 STANDBY 2.4 NoRange nfa .. lSIRTC  |37.0kHz RTC* 0 mA D.%6uA |[1ms 0.0 Battery 105 Datasheet
3 [WU_FROM_ST... [2.4 |NoRange n/a | MSTFAST |a.0MHz | oma [17ma " [20.1ps 0.0 Battery  [104.82  Datasheet |
4 RUN 2.4 Range 1-High FLASH/A... |...|HSE 16,0 MHz RTC 0 mA 2.16 mA 1ms 200 Battery 104.77 Datasheet
5 RUN 2.4 Range2-Medium  |FLASH/A... |...HSE [16.0MHz |ADCL:fs... OmA [192mA  [1ms 20.0 Battery |104.79  [Datasheet |
[ _SLEEP 2.4 _Raﬂge?_-Medium _ON HSE _16.0 MHz _ADC 1ifs... _D mA _703.2|.|A 1ms 0.0 Battery _104.92 _Datasheet | =
7 RN 2.4 Range2-Medium  FLASH/A... |...HSE 16,0 MHz DMA1R... OmA 1.92mA 1ms 20.0 Battery 104.79 Datasheet
8 STOP1 2.4 |NoRange Inja ... |ALL CLO... [0 Hz USART1® 0mA l6.650A |1ms 0.0 Battery  |105 InDS Ta...
9 [WU_FROM_ST... 2.4 NoRange In/a [As1zs  [16.0MHz | oma [L62mA  [6.3ps  [0.0 Battery  |104.83  |Datasheet |
10 RUN 2.4 Range2-Medium  FLASH/A... |...HSE 16.0MHz RTC USA... 0 mA 183mA |ims 20.0 Battery |104.8  Datasheet
11 [STANDEY 2.4 INoRange Infa LSTRTC [37.0kHz _RTC* oma D.46uA [ims 0.0 Battery 105 [Datasheet | ~
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7. Click the Save button to save the sequence as SequenceOne.

The application consumption profile is the generated. It shows that the overall sequence
consumes an average of 2.01 mA for 9 ms, and the battery lifetime is only 4 days (see
Figure 176).

Figure 176. PCC sequence results before optimization

rResults Charts

Consumption Profile by Step

& '1\hum

g
—_7
<
E6
=
2 5
a
=
24
=
=]
= ARUN S:RUN 7:RUN 10:RUN

3WU_FROM_STANDEY : ’ QAWU_FROM_STOP1
. Wl o
a:s§EEP
1 sk s astoet 11:STANDEY
e e
0
0.0 0.5 1.0 1L 2.0 25 3.0 245 4.0 4.5 5.0 ELE 6.0 8.5 7.0 T 2.0 85 9.0
Time (ms)
=== Tdd by Step == Average CLu'rent|
rResults Summary
Sequence Time/ TaMax 9ms/104.0°C Average Consumption 2.01 mA
Battery Life Estimation 4 days & 13 hours (Battery compatibility not garanteed with defined step(s}) Average DMIPS 22.0 DMIPS

8.3.2

3

Optimizing application power consumption

Let us now take several actions to optimize the overall consumption and the battery lifetime.
These actions are performed on step 1, 4, 5, 6, 7, 8 and 10.

The next figures show on the left the original step and on the right the step updated with
several optimization actions.

Step 1 (Run)

e Findings

All peripherals are enabled although the application requires only the RTC.
e Actions

—  Lower the operating frequency.

— Enable solely the RTC peripheral.

— To reduce the average current consumption, reduce the time spent in this mode.
e Results

The current is reduced from 9.05 mA to 2.16 mA (see Figure 177).
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Figure 177. Step 1 optimization

o Edit Step S o i step Co
) r)
§ L0 § L0
Power Memory Peripherals - Power Memary [ OPOARTT =
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Step 4 (Run, RTC)

e  Action:

Reduce the time spent in this mode to 0.1 ms.
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Tutorial 3- Using PCC to optimize the embedded application power consumption and

Step 5 (Run, ADC, DMA, RTC)

° Actions

—  Change to Low-power run mode.
—  Lower the operating frequency.

. Results

The current consumption is reduced from 6.17 mA to 271 pA (see Figure 178).

Figure 178. Step 5 optimization

15 Edit step

Iy

[

Without Peripherals:  2.16 mA

Without Peripherals: | 271 pA

% Edit Step
4 o 9 S0
Power/Memary Lotz - PowerMemory [ TOUTI-Bffer_ON- G,
W
OUT1-Buffer_ON-Worst_cc
Power Mode: RUN =T Power Mode: LOWPOWER _RUN - J Somz - _orr Mm;
; -Buffer_OFF- ¢
Power Range: _Rangelﬁgh GPIOB Power Range: MNoRange - [] ouUT2-Buffer_ON-Middle_ci
r GPIOC u -
Memory Fetch Type: | FLASH/ART fCache Memory Fetch Type: FLASH/ART Cache - B2 mafterd O Wags o
GPIOD ~-["] DFSDM h
vdd: 2.4 GPIOH I [ || veid: 24 - [ bMAL
Voltage Source: |Battery na Voltage Source: Battery = -] DMAZ
1202 [ FLASH E
Clocks =B Clocks [CFw
. WDG
- [] GPIOA
CPU Frequency: 16.0MHz D (cpu Frequency: ) E P08 L
Interpalation ranges LPTIML Interpolation ranges [[] eP10C
LPTIM2 =
User choice (Hz): User cholce (Hz): - [] GPIOD
! LPUART1 -] GPIOH
Clock Configuration: |HSE - OPAMP1 Clock Configuration: MSL - 1201
Clack Source Frequency: 16.0 MHz ---- OPAMP2 Clock Source Frequency: 2.0 MHz - [ 12€2
PVD/BOR - [0 1263
: PWR
Optional Setting: Optional Settings [ mame
) QUADSPT B --- LD
Step Duration: 1 ms RNG Step Duration: 1 L. [ Booster_OFF
Additional Consumption: o mA RTC Additional Consumption: o mA v ' [[] Booster ON
SAT1 w [I7] LPTIML
Results SAI2 Results -] reTIM2
SDMMCL
Step Consumption: | 6.17 mA ERUEE
SPI1 --- OPAMP1

The step consumption is higher than the max continuous
current (3 mA) of the battery selection.

Peripherals Part: 4.01mA (A: 296.25pA -D: 3.72mA) Peripherals Part: OpA (A: OpA -D: OpA)
SWPMIL
TaMax ("C): 104.33 - SY5-VREFBUF/COMP1 Ta Max (*0): 104.97 S
- »
Warnings Warning:

Cancel

Cancel

3

DoclD025776 Rev 15

189/231




Tutorial 3- Using PCC to optimize the embedded application power consumption and more

Step 6 (Sleep, DMA, ADC,RTC)

. Actions

—  Switch to Lower-power sleep mode (BAM mode)
— Reduce the operating frequency to 2 MHz.

. Results

The current consumption is reduced from 703 pA to 93 YA (see Figure 179).

Figure 179. Step 6 optimization
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Tutorial 3- Using PCC to optimize the embedded application power consumption and

Step 7 (Run, DMA, RTC, USART)

e Actions
—  Switch to Lower-power run mode.
—  Use the power-efficient LPUART peripheral.
—  Reduce the operating frequency to 1 MHz using the PCC interpolation feature.
e Results
The current consumption is reduced from 1.92 pA to 42 pA (see Figure 180).
Figure 180. Step 7 optimization
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Tutorial 3- Using PCC to optimize the embedded application power consumption and more

Step 8 (Stop 0, USART)

e Actions:
—  Switch to Stop1 low-power mode.
—  Use the power-efficient LPUART peripheral.
e Results
The current consumption is reduced from 110 pA to 6.65 pA (see Figure 181).
Figure 181. Step 8 optimization
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Tutorial 3- Using PCC to optimize the embedded application power consumption and

Step 10 (RTC, USART)

. Actions

—  Use the power-efficient LPUART peripheral.
— Reduce the operating frequency to 1 MHz.

. Results

The current consumption is reduced from 1.89 mA to 234 pA (see Figure 182).

The example given in Figure 183 shows an average current consumption reduction of

155 pA.

Figure 182. Step 10 optimization
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Tutorial 3- Using PCC to optimize the embedded application power consumption and more

See Figure 183 for the sequence overall results: 7 ms duration, about 2 month battery life,

and an average current consumption of 165.25 pA.

Use the compare button to compare the current results to the original ones saved as

SequenceOne.pcs.

Figure 183. PCC Sequence results after optimizations
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9 FAQ

9.1 On the Pinout configuration pane, why does STM32CubeMX
move some functions when | add a new peripheral mode?

You may have unselected || keep current Signals Placement . In this case, the tool performs an
automatic remapping to optimize your placement.

9.2 How can | manually force a function remapping?

You should use the Manual Remapping feature.

9.3 Why are some pins highlighted in yellow or in light green in
the Chip view? Why cannot | change the function of some
pins (when | click some pins, nothing happens)?

These pins are specific pins (such as power supply or BOOT) which are not available as
peripheral signals.

9.4 Why do | get the error “Java 7 update 45’ when installing
‘Java 7 update 45’ or a more recent version of the JRE?

The problem generally occurs on 64-bit Windows operating system, when several versions
of Java are installed on your computer and the 64-bit Java installation is too old.

During STM32CubeMX installation, the computer searches for a 64-bit installation of Java.

e If oneis found, the ‘Java 7 update 45’ minimum version prerequisite is checked. If the
installed version is older, an error is displayed to request the upgrade.

. If no 64-bit installation is found, STM32CubeMX searches for a 32-bit installation. If one

is found and the version is too old, the ‘Java 7 update 45’ error is displayed. The user
must update the installation to solve the issue.

To avoid this issue from occurring, it is recommended to perform one of the following
actions:

1.  Remove all Java installations and reinstall only one version (32 or 64 bits) (Java 7
update 45 or more recent).

2. Keep 32-bit and 64-bit installations but make sure that the 64-bit version is at least
Java 7 update 45.

Note: Some users (Java developers for example) may need to check the PC environment
variables defining hard-coded Java paths (e.g. JAVA_HOME or PATH) and update them so
that they point to the latest Java installation.

On Windows 7 you can check your Java installation using the Control Panel. To do this,
double-click £ v icon from Control Panel\All Control Panel to open the Java settings
window (see Figure 184):

3
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Figure 184. Java Control Panel
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You can also enter java —version’ as an MS-DOS command to check the version of your
latest Java installation (the Java program called here is a copy of the program installed
under C:\Windows\System32):

java version “1.7.0_45"
Java (TM) SE Runtime Environment (build 1.7.0_45-b18)
Java HotSpot (TM) 64-Bit Server VM (build 24.45-b08, mixed mode)

Why does the RTC multiplexer remain inactive on the Clock
tree view?

To enable the RTC multiplexer, the user shall enable the RTC IP in the Pinout view as
indicated in below:

Figure 185. Pinout view - Enabling the RTC

= & RIC
Alarm & Internal &larm -
Alarm B Disable v
Wakelp Disable -
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How can | select LSE and HSE as clock source and
change the frequency?

The LSE and HSE clocks become active once the RCC is configured as such in the Pinout
view. See Figure 186 for an example.

Figure 186. Pinout view - Enabling LSE and HSE clocks

RC

High Speed Clock (HSE) CrystalfCeramic Resonator b

Low Speed Clock (LSE) Crystal/Ceramic Resonator -
Master Clock Ouput 1

The clock source frequency can then be edited and the external source selected:

Figure 187. Pinout view - Setting LSE/HSE clock frequency

— | FLE SOOTCOR W |

T

i 5L
| — | H5E il T}

Why STM32CubeMX does not allow me to configure PC13,
PC14, PC15 and PI8 as outputs when one of them

is already configured as an output?

STM32CubeMX implements the restriction documented in the reference manuals as a
footnote in table Output Voltage characteristics:

“PC13, PC14, PC15 and PI8 are supplied through the power switch. Since the switch only
sinks a limited amount of current (3 mA), the use of GPIOs PC13 to PC15 and PI8 in output
mode is limited: the speed should not exceed 2 MHz with a maximum load of 30 pF and
these I/Os must not be used as a current source (e.g. to drive a LED).”
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Appendix A STM32CubeMX pin assignment rules

AA1

198/231

The following pin assignment rules are implemented in STM32CubeMX:

Rule 1:
Rule 2:
Rule 3:
Rule 4:
Rule 5:
Rule 6:
Rule 7:
Rule 8:
Rule 9:

Block consistency

Block inter-dependency

One block = one peripheral mode

Block remapping (only for STM32F 10x)

Function remapping

Block shifting (only for STM32F 10x)

Setting or clearing a peripheral mode

Mapping a function individually (if Keep Current Placement is unchecked)
GPIO signals mapping

Block consistency

When setting a pin signal (provided there is no ambiguity about the corresponding
peripheral mode), all the pins/signals required for this mode are mapped and pins are
shown in green (otherwise the configured pin is shown in orange).

When clearing a pin signal, all the pins/signals required for this mode are unmapped
simultaneously and the pins turn back to gray.

Example of block mapping with a STM32F107x MCU

If the user assigns 12C1_SMBA function to PB5, then STM32CubeMX configures pins and
modes as follows:

[2C1_SCL and I12C1_SDA signals are mapped to the PB6 and PB7 pins, respectively
(see Figure 188).

I12C1 peripheral mode is set to SMBus-Alert mode.
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Figure 188. Block mapping
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Example of block remapping with a STM32F107x MCU

If the user assigns GPIO_Output to PB6, STM32CubeMX automatically disables 12C1
SMBus-Alert peripheral mode from the peripheral tree view and updates the other 12C1 pins
(PB5 and PB7) as follows:

e If they are unpinned, the pin configuration is reset (pin grayed out).

e If they are pinned, the peripheral signal assigned to the pins is kept and the pins are
highlighted in orange since they no longer match a peripheral mode (see Figure 189).
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Figure 189. Block remapping
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For STM32CubeMX to find an alternative solution for the 12C peripheral mode, the user will
need to unpin 12C1 pins and select the 12C1 mode from the peripheral tree view (see
Figure 190 and Figure 191).
200/231 DoclD025776 Rev 15 ‘Yl




UM1718 STM32CubeMX pin assignment rules

Figure 190. Block remapping - example 1
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Figure 191. Block remapping - example 2
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A.2 Block inter-dependency
On the Chip view, the same signal can appear as an alternate function for multiple pins.
However it can be mapped only once.
As a consequence, for STM32F1 MCUs, two blocks of pins cannot be selected
simultaneously for the same peripheral mode: when a block/signal from a block is selected,
the alternate blocks are cleared.
Example of block remapping of SPI in full-duplex master mode with a
STM32F107x MCU
If SPI1 full-duplex master mode is selected from the tree view, by default the corresponding
SPI signals are assigned to PB3, PB4 and PB5 pins (see Figure 192).
If the user assigns to PA6 the SPI1_MISO function currently assigned to PB4,
STM32CubeMX clears the PB4 pin from the SPI1_MISO function, as well as all the other
pins configured for this block, and moves the corresponding SPI11 functions to the relevant
pins in the same block as the PB4 pin (see Figure 193).
(by pressing CTRL and clicking PB4 to show PAG alternate function in blue, then drag and
drop the signal to pin PAG)
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Figure 192. Block inter-dependency - SPI signals assigned to PB3/4/5
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Figure 193. Block inter-dependency - SPI1_MISO function assigned to PA6
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One block = one peripheral mode

When a block of pins is fully configured in the Chip view (shown in green), the related
peripheral mode is automatically set in the Peripherals tree.

Example of STM32F107x MCU

Assigning the 12C1_SMBA function to PB5 automatically configures 12C1 peripheral in
SMBus-Alert mode (see Peripheral tree in Figure 194).

Figure 194. One block = one peripheral mode - 12C1_SMBA function assigned to PB5
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Block remapping (STM32F10x only)

To configure a peripheral mode, STM32CubeMX selects a block of pins and assigns each
mode signal to a pin in this block. In doing so, it looks for the first free block to which the
mode can be mapped.

When setting a peripheral mode, if at least one pin in the default block is already used,
STM32CubeMX tries to find an alternate block. If none can be found, it either selects the
functions in a different sequence, or unchecks [ keep Current Signals Flacement , and remaps alll
the blocks to find a solution.
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Example

STM32CubeMX remaps USART3 hardware-flow-control mode to the (PD8-PD9-PD11-
PD12) block, because PB14 of USARTS3 default block is already allocated to the
SPI2_MISO function (see Figure 195).

Figure 195. Block remapping - example 2
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Function remapping

To configure a peripheral mode, STM32CubeMX assigns each signal of the mode to a pin.
In doing so, it will look for the first free pin the signal can be mapped to.

Example using STM32F415x

When configuring USART3 for the Synchronous mode, STM32CubeMX discovered that the
default PB10 pin for USART3_TX signal was already used by SPI. It thus remapped it to
PDS8 (see Figure 196).

Figure 196. Function remapping example
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Block shifting (only for STM32F10x and when
“Keep Current Signals placement” is unchecked)

If a block cannot be mapped and there are no free alternate solutions, STM32CubeMX tries
to free the pins by remapping all the peripheral modes impacted by the shared pin.

Example

With the Keep current signal placement enabled, if USART3 synchronous mode is set first,
the Asynchronous default block (PB10-PB11) is mapped and Ethernet becomes unavailable
(shown in red) (see Figure 197).

Unchecking [~ keep current Signals Flacement allows STM32CubeMX shifting blocks around
and freeing a block for the Ethernet MIl mode. (see Figure 198).

Figure 197. Block shifting not applied
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Figure 198. Block shifting applied
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Setting and clearing a peripheral mode

The Peripherals panel and the Chip view are linked: when a peripheral mode is set or
cleared, the corresponding pin functions are set or cleared.

Mapping a function individually

When STM32CubeMX needs a pin that has already been assigned manually to a function
(no peripheral mode set), it can move this function to another pin, only if
[ ] keep Current Signals Flacement iS unchecked and the function is not pinned (no pin icon).

GPIO signals mapping

I/0 signals (GPIO_Input, GPIO_Output, GPIO_Analog) can be assigned to pins either
manually through the Chip view or automatically through the Pinout menu. Such pins can
no longer be assigned automatically to another signal: STM32CubeMX signal automatic
placement does not take into account this pin anymore since it does not shift I/0 signals to
other pins.

The pin can still be manually assigned to another signal or to a reset state.
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Appendix B STM32CubeMX C code generation design
choices and limitations

This section summarizes STM32CubeMX design choices and limitations.

B.1 STM32CubeMX generated C code and user sections

The C code generated by STM32CubeMX provides user sections as illustrated below. They
allow user C code to be inserted and preserved at next C code generation.

User sections shall neither be moved nor renamed. Only the user sections defined by
STM32CubeMX are preserved. User created sections will be ignored and lost at next C
code generation.

/* USER CODE BEGIN 0 */
(..)
/* USER CODE END 0 */
Note: STM32CubeMX may generate C code in some user sections. It will be up to the user to

clean the parts that may become obsolete in this section. For example, the while(1) loop in
the main function is placed inside a user section as illustrated below:

/* Infinite loop */
/* USER CODE BEGIN WHILE */
while (1)
{
/* USER CODE END WHILE */

/* USER CODE BEGIN 3 */
}
/* USER CODE END 3 */

B.2 STM32CubeMX design choices for peripheral initialization

STM32CubeMX generates peripheral _Init functions that can be easily identified thanks to
the MX_ prefix:

static void MX_GPIO_Init (void);

static void MX_ <Peripheral Instance Name>_Init (void);

static void MX_I2S2 Init(void);

An MX_<peripheral instance name>_Init function exists for each peripheral instance
selected by the user (e.g, MX_[12S2_Init). It performs the initialization of the relevant handle

structure (e.g, &hi2s2 for I2S second instance) that is required for HAL driver initialization
(e.g., HAL I2S_Init) and the actual call to this function:

void MX_TI2S2 Init (void)

{

hi2s2.Instance = SPI2;
hi2s2.Init.Mode = I2S_MODE_MASTER_TX;
hi2s2.Init.Standard = I2S_STANDARD_PHILLIPS;

3

DoclD025776 Rev 15 209/231




STM32CubeMX C code generation design choices and limitations UM1718

B.3

B.3.1

210/231

hi2s2.Init.DataFormat = I2S_DATAFORMAT 16B;
hi2s2.Init.MCLKOutput = I2S_MCLKOUTPUT_DISABLE;
hi2s2.Init.AudioFreq = I2S_AUDIOFREQ_192K;
hi2s2.Init.CPOL = I2S_CPOL_LOW;
hi2s2.Init.ClockSource = I2S_CLOCK_PLL;
hi2s2.Init.FullDuplexMode = I2S_FULLDUPLEXMODE_ENABLE;
HAL_I2S_Init (&hi2s2);
}
By default, the peripheral initialization is done in main.c. If the peripheral is used by a

middleware mode, the peripheral initialization can be done in the middleware corresponding
.cfile.

Customized HAL <IP Name>_Msplnit() functions are created in the stm32f4xx_hal_msp.c
file to configure the low level hardware (GPIO, CLOCK) for the selected IPs.

STM32CubeMX design choices and limitations for
middleware initialization

Overview

STM32CubeMX does not support C user code insertion in Middleware stack native files
although stacks such as LwIP might require it in some use cases.

STM32CubeMX generates middleware Init functions that can be easily identified thanks to
the MX_ prefix:

MX_LWIP_Init(); // defined in lwip.h file
MX_USB_HOST_Init(); // defined in usb_host.h file
MX_FATFS_Init(); // defined in fatfs.h file

Note however the following exceptions:

e No /nit function is generated for FreeRTOS unless the user chooses, from the Project
settings window, to generate /nit functions as pairs of .c/.h files. Instead, a
StartDefaultTask function is defined in the main.c file and CMSIS-RTOS native function
(osKernelStart) is called in the main function.

e If FreeRTOS is enabled, the Init functions for the other middlewares in use are called
from the StartDefaultTask function in the main.c file.
Example:

void StartDefaultTask (void const * argument)

{

/* init code for FATFS */
MX_FATFS_Init();

/* init code for LWIP */
MX_LWIP_Init();

/* init code for USB_HOST */
MX_USB_HOST_Init () ;

/* USER CODE BEGIN 5 */

/* Infinite loop */

3
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3

for(;;)
{
osDelay (1) ;
}
/* USER CODE END 5 */
}

USB Host

USB peripheral initialization is performed within the middleware initialization C code in the
usbh_conf.c file, while USB stack initialization is done within the usb_host.c file.

When using the USB Host middleware, the user is responsible for implementing the
USBH_UserProcess callback function in the generated usb_host.c file.

From STM32CubeMX user interface, the user can select to register one class or all classes
if the application requires switching dynamically between classes.

USB Device

USB peripheral initialization is performed within the middleware initialization C code in the
usbd_conf.c file, while USB stack initialization is done within the usb_device.c file.

USB VID, PID and String standard descriptors are configured via STM32CubeMX user
interface and available in the usbd_desc.c generated file. Other standard descriptors
(configuration, interface) are hard-coded in the same file preventing support for USB
composite devices.

When using the USB Device middleware, the user is responsible for implementing the
functions in the usbd_<classname>_if.c class interface file for all device classes (e.g.,
usbd_storage_if.c).

USB MTP and CCID classes are not supported.

FatFs

FatFs configuration is available in the ffconf.h generated file.

The initialization of the SDIO peripheral for the FatFs SD Card mode and of the FMC
peripheral for the FatFs External SDRAM and External SRAM modes are kept in the main.c
file.

Some files need to be modified by the user to match user board specificities (BSP drivers in
STM32Cube embedded software package can be used as example):

e  bsp _driver_sd.c/.h generated files when using FatFs SD Card mode

e  bsp_driver_sram.c/.h generated files when using FatFs External SRAM mode

e  bsp_driver_sdram.c/.h generated files when using FatFs External SDRAM mode.
Multi-drive FatFs is supported, which means that multiple logical drives can be used by the
application (External SDRAM, External SRAM, SD Card, USB Disk, User defined). However

support for multiple instances of a given logical drive is not available (e.g. FatFs using two
instances of USB hosts or several RAM disks).
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NOR and NAND Flash memory are not supported. In this case, the user shall select the
FatFs user-defined mode and update the user_diskio.c driver file generated to implement
the interface between the middleware and the selected peripheral.

B.3.5 FreeRTOS

FreeRTOS configuration is available in FreeRTOSConfig.h generated file.

When FreeRTOS is enabled, all other selected middleware modes (e.g., LwIP, FatFs, USB)
will be initialized within the same FreeRTOS thread in the main.c file.

When GENERATE_RUN_TIME_STATS, CHECK_FOR_STACK_OVERFLOW,
USE_IDLE_HOOK, USE_TICK_HOOK and USE_MALLOC_FAILED_HOOK parameters
are activated, STM32CubeMX generates freertos.c file with empty functions that the user
shall implement. This is highlighted by the tooltip (see Figure 199).

Figure 199. FreeRTOS HOOK functions to be completed by user

F R
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Qf? Config parameters | q’q Indude parameters | q’q User Constants | Q?Tasks and Queues | Q:’?Tlmers and Semaphores | q/) FreeRTOS Heap Usage|
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= Versions -
CMSIS-RTOS version 1.02 I
FreeRTOS version 8.2.3
Kernel settings
=l Hook function related definitions
USE_IDLE_HOOK Disabled
USE_MALLOC_FAILED HOCK Dizabled
CHECK_FOR._STACK_OVERFLOW Disabled
=] Run time and task stats gathering related definitions
USE_TRACE_FACILITY Enabled
GEMERATE_RUM_TIME_STATS Disabled
[= Co-routine related definitions Il
USE_CO_ROUTIMES Dizabled
MAY_CO_ROUTINE_PRIORITIES 2
= Software timer definitions
USE_TIMERS Enabled -

USE_TICK_HOOK

configlSE_TICK_HOOK

Parameter Description:

The tick hook function is & hook (or callbadk) function that, if defined and configured, will be called during each tick interrupt.

-if USE_TICK_HOOK is set to 1 (Enabled) then the application must define a tick hook function: void vApplicationTickHook({void).

-if USE_TICK HOOK is set to 0 (Disabled) then the tick hook function will not be called, even if one is defined.
Note{when set to 1, an empty function is generated in the freertos.c file (to be completed by the user)

[ Apply ] [ Ok ] [ Cancel
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LwiIP

LwlIP initialization function is defined in Iwip.c, while LwIP configuration is available in
Iwipopts.h generated file.

STM32CubeMX supports LwIP over Ethernet only. The Ethernet peripheral initialization is
done within the middleware initialization C code.

STM32CubeMX does not support user C code insertion in stack native files. However, some
LwlIP use cases require modifying stack native files (e.g., cc.h, mib2.c): user modifications
shall be backed up since they will be lost at next STM32CubeMX generation.

Starting with release 1.5, STM32CubeMX LwIP supports IPv6 (see Figure 202).

DHCP must be disabled, to configure a static IP address.

Figure 200. LwIP 1.4.1 configuration
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Figure 201. LwIP 1.5 configuration
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STM32CubeMX generated C code will report compilation errors when specific parameters

are enabled (disabled by default). The user must fix the issues with a stack patch

(downloaded from Internet) or user C code. The following parameters generate an error:

e MEM_USE_POOLS: user C code to be added either in Iwipopts.h or in cc.h (stack file).
e PPP_SUPPORT, PPPOE_SUPPORT: user C code required
e MEMP_SEPARATE_POOLS with MEMP_OVERFLOW_CHECK > 0: a stack patch

required

e MEM_LIBC_MALLOC & RTOS enabled: stack patch required

e LWIP_EVENT_API: stack patch required

In STM32CubeMX, the user must enable FreeRTOS in order to use LwIP with the netconn
and sockets APIs. These APIs require the use of threads and consequently of an operating
system. Without FreeRTOS, only the LwIP event-driven raw API can be used.
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Appendix C STM32 microcontrollers naming conventions

STM32 microcontroller part numbers are codified following the below naming conventions:
e  Device subfamilies
The higher the number, the more features available.

For example STM32LO0 line includes STM32L051, L052, L053, L061, L062, L063
subfamilies where STM32L06x part numbers come with AES while STM32L05x do not.

The last digit indicates the level of features. In the above example:
— 1 =Access line
- 2=with USB
— 3 =with USB and LCD.
e Pin counts
—  F=20pins
- G =28pins
— K=32pins
— T =236 pins
— S =44pins
— C=48pins
— R =64 pins (or 66 pins)
- M=280pins
— 0=90pins
— V=100 pins
— Q=132 pins (e. g. STM32L162QDH®6)
- Z=144
-  1=176 (+25)
— B =208 pins (e. g.: STM32F429BIT6)
— N=216 pins
e  Flash memory sizes
— 4 =16 Kbytes of Flash memory
— 6 =32 Kbytes of Flash memory
— 8 =64 Kbytes of Flash memory
— B =128 Kbytes of Flash memory
—  C =256 Kbytes of Flash memory
— D = 384 Kbytes of Flash memory
— E =512 Kbytes of Flash memory
— F =768 Kbytes of Flash memory
— G =1024 Kbytes of Flash memory
— 1 =2048 Kbytes of Flash memory
e Packages
- B=SDIP
- H=BGA

3
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- M=SO0

- P=TSSOP
- T=LQFP

- U=VFQFPN
- Y=WLCSP

Figure 202 shows an example of STM32 microcontroller part numbering scheme.

Figure 202. STM32 microcontroller part numbering scheme

Example: STM32 F 439V 1| T 6 xxx

Device family
S5TM32 = ARM-based 32-bit microcontroller

Product type
F = general-purpose

Device subfamily

437= STM32F437xx, USB OTG FS/HS, camera interface,
Ethemet, cryptographic acceleration

439= STM32F439xx, USB OTG FS/HS, camera interface,
Ethemet, LCD-TFT, cryptographic acceleration

Pin count

V=100 pins
Z =144 pins
A =169 pins
| =176 pins
B = 208 pins
N =216 pins

Flash memory size
G = 1024 Kbytes of Flash memory
| = 2048 Kbytes of Flash memory

Package
T=LAQFP
H=BGA
Y = WLCSP

Temperature range
6 = Industrial temperature range, —40 to 85 °C.
7 = Industrial temperature range, —40 to 105 *C.

Options
xx¢ = programmed parts
TR = tape and reel

3
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Appendix D STM32 microcontrollers power consumption
parameters

This section provides an overview on how to use STM32CubeMX Power Consumption
Calculator (PCC).

Microcontroller power consumption depends on chip size, supply voltage, clock frequency
and operating mode. Embedded applications can optimize STM32 MCU power
consumption by reducing the clock frequency when fast processing is not required and
choosing the optimal operating mode and voltage range to run from. A description of STM32
power modes and voltage range is provided below.

DA Power modes

STM32 MCUs support different power modes (refer to STM32 MCU datasheets for full
details).

D11 STM32L1 series

STM32L1 microcontrollers feature up to 6 power modes, including 5 low-power modes:
e Run mode

This mode offers the highest performance using HSE/HSI clock sources. The CPU
runs up to 32 MHz and the voltage regulator is enabled.

e Sleep mode

This mode uses HSE or HSI as system clock sources. The voltage regulator is enabled
and the CPU is stopped. All peripherals continue to operate and can wake up the CPU
when an interrupt/event occurs.

e Low- power run mode
This mode uses the multispeed internal (MSI) RC oscillator set to the minimum clock
frequency (131 kHz) and the internal regulator in low-power mode. The clock frequency
and the number of enabled peripherals are limited.

e Low-power sleep mode
This mode is achieved by entering Sleep mode. The internal voltage regulator is in low-
power mode. The clock frequency and the number of enabled peripherals are limited. A
typical example would be a timer running at 32 kHz.

When the wakeup is triggered by an event or an interrupt, the system returns to the
Run mode with the regulator ON.

e  Stop mode

This mode achieves the lowest power consumption while retaining RAM and register
contents. Clocks are stopped. The real-time clock (RTC) an be backed up by using
LSE/LSI at 32 kHz/37 kHz. The number of enabled peripherals is limited. The voltage
regulator is in low-power mode.
The device can be woken up from Stop mode by any of the EXTI lines.

e Standby mode
This mode achieves the lowest power consumption. The internal voltage regulator is

switched off so that the entire Voorg domain is powered off. Clocks are stopped and
the real-time clock (RTC) can be preserved up by using LSE/LSI at 32 kHz/37 kHz.

3
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RAM and register contents are lost except for the registers in the Standby circuitry. The
number of enabled peripherals is even more limited than in Stop mode.

The device exits Standby mode upon reset, rising edge on one of the three WKUP pins,
or if an RTC event occurs (if the RTC is ON).

When exiting Stop or Standby modes to enter the Run mode, STM32L1 MCUs go through a
state where the MSI oscillator is used as clock source. This transition can have a significant
impact on the global power consumption. For this reason, STM32CubeMX PCC introduces
two transition steps: WU_FROM_STOP and WU_FROM_STANDBY. During these steps,
the clock is automatically configured to MSI.

STM32F4 series

STM32F4 microcontrollers feature a total of 5 power modes, including 4 low-power modes:

Run mode

This is the default mode at power-on or after a system reset. It offers the highest
performance using HSE/HSI clock sources. The CPU can run at the maximum
frequency depending on the selected power scale.

Sleep mode

Only the CPU is stopped. All peripherals continue to operate and can wake up the CPU
when an interrupt/even occurs. The clock source is the clock that was set before
entering Sleep mode.

Stop mode

This mode achieves a very low power consumption using the RC oscillator as clock
source. All clocks in the 1.2 V domain are stopped as well as CPU and peripherals.
PLL, HSI RC and HSE crystal oscillators are disabled. The content of registers and
internal SRAM are kept.

The voltage regulator can be put either in normal Main regulator mode (MR) or in Low-
power regulator mode (LPR). Selecting the regulator in low-power regulator mode
increases the wakeup time.

The Flash memory can be put either in Stop mode to achieve a fast wakeup time or in
Deep power-down to obtain a lower consumption with a slow wakeup time.

The Stop mode features two sub-modes:
—  Stop in Normal mode (default mode)

In this mode, the 1.2 V domain is preserved in nominal leakage mode and the
minimum V12 voltage is 1.08 V.

—  Stop in Under-drive mode

In this mode, the 1.2 V domain is preserved in reduced leakage mode and V12
voltage is less than 1.08 V. The regulator (in Main or Low-power mode) is in
under-drive or low-voltage mode. The Flash memory must be in Deep-power-
down mode. The wakeup time is about 100 ps higher than in normal mode.
Standby mode
This mode achieves very low power consumption with the RC oscillator as a clock
source. The internal voltage regulator is switched off so that the entire 1.2 V domain is
powered off: CPU and peripherals are stopped. The PLL, the HSI RC and the HSE
crystal oscillators are disabled. SRAM and register contents are lost except for
registers in the backup domain and the 4-byte backup SRAM when selected. Only RTC
and LSE oscillator blocks are powered. The device exits Standby mode when an
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external reset (NRST pin), an IWDG reset, a rising edge on the WKUP pin, or an RTC
alarm/ wakeup/ tamper/time stamp event occurs.

e Vpar Operation

It allows to significantly reduced power consumption compared to the Standby mode.
This mode is available when the Vgar pin powering the Backup domain is connected to
an optional standby voltage supplied by a battery or by another source. The Vgar
domain is preserved (RTC registers, RTC backup register and backup SRAM) and
RTC and LSE oscillator blocks powered. The main difference compared to the Standby
mode is external interrupts and RTC alarm/events do not exit the device from Vgar
operation. Increasing Vpp to reach the minimum threshold does.

STM32L0 series

STM32L0 microcontrollers feature up to 8 power modes, including 7 low-power modes to
achieve the best compromise between low-power consumption, short startup time and
available wakeup sources:

e  Run mode
This mode offers the highest performance using HSE/HSI clock sources. The CPU can
run up to 32 MHz and the voltage regulator is enabled.

e Sleep mode

This mode uses HSE or HSI as system clock sources. The voltage regulator is enabled
and only the CPU is stopped. All peripherals continue to operate and can wake up the
CPU when an interrupt/event occurs.

e Low-power run mode

This mode uses the internal regulator in low-power mode and the multispeed internal
(MSI) RC oscillator set to the minimum clock frequency (131 kHz). In Low-power run
mode, the clock frequency and the number of enabled peripherals are both limited.

e Low-power sleep mode

This mode is achieved by entering Sleep mode with the internal voltage regulator in
low-power mode. Both the clock frequency and the number of enabled peripherals are
limited. Event or interrupt can revert the system to Run mode with regulator on.

e  Stop mode with RTC

The Stop mode achieves the lowest power consumption with, while retaining the RAM,
register contents and real time clock. The voltage regulator is in low-power mode. LSE
or LSl is still running. All clocks in the Voore domain are stopped, the PLL, MSI RC,
HSE crystal and HSI RC oscillators are disabled.

Some peripherals featuring wakeup capability can enable the HSI RC during Stop
mode to detect their wakeup condition. The device can be woken up from Stop mode
by any of the EXTlI line, in 3.5 ys, and the processor can serve the interrupt or resume
the code.

e  Stop mode without RTC
This mode is identical to “Stop mode with RTC “, except for the RTC clock which is
stopped here.

e Standby mode with RTC

The Standby mode achieves the lowest power consumption with the real time clock
running. The internal voltage regulator is switched off so that the entire Voorg domain
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is powered off. The PLL, MSI RC, HSE crystal and HSI RC oscillators are also switched
off. The LSE or LSl is still running.

After entering Standby mode, the RAM and register contents are lost except for
registers in the Standby circuitry (wakeup logic, IWDG, RTC, LSI, LSE Crystal 32 KHz
oscillator, RCC_CSR register).

The device exits Standby mode in 60 ys when an external reset (NRST pin), an IWDG
reset, a rising edge on one of the three WKUP pins, RTC alarm (Alarm A or Alarm B),

RTC tamper event, RTC timestamp event or RTC Wakeup event occurs.

e Standby mode without RTC
This mode is identical to Standby mode with RTC, except that the RTC, LSE and LSI
clocks are stopped.

The device exits Standby mode in 60 ys when an external reset (NRST pin) or a rising
edge on one of the three WKUP pin occurs.

The RTC, the IWDG, and the corresponding clock sources are not stopped automatically by
entering Stop or Standby mode. The LCD is not stopped automatically by entering Stop
mode.

Power consumption ranges

STM32 MCUs power consumption can be further optimized thanks to the dynamic voltage
scaling feature: the main internal regulator output voltage V12 that supplies the logic (CPU,
digital peripherals, SRAM and Flash memory) can be adjusted by software by selecting a
power range (STM32L1 and STM32L0) or power scale (STM32 F4).

Power consumption range definitions are provided below (refer to STM32 MCU datasheets
for full details).

STM32L1 series feature 3 Vcoorg ranges

e High Performance Range 1 (Vpp range limited to 2.0-3.6 V), with the CPU running at
up to 32 MHz

The voltage regulator outputs a 1.8 V voltage (typical) as long as the Vpp input voltage
is above 2.0 V. Flash program and erase operations can be performed.

e  Medium Performance Range 2 (full Vpp range), with a maximum CPU frequency of
16 MHz

At 1.5V, the Flash memory is still functional but with medium read access time. Flash
program and erase operations are still possible.

e Low Performance Range 3 (full Vop range), with a maximum CPU frequency limited to
4 MHz (generated only with the multispeed internal RC oscillator clock source)

At 1.2V, the Flash memory is still functional but with slow read access time. Flash
Program and erase operations are no longer available.

3
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D.2.2 STM32F4 series feature several Vcorg scales

The scale can be modified only when the PLL is OFF and when HSI or HSE is selected as
system clock source.

e Scale 1 (V12 voltage range limited to 1.26-1.40 V), default mode at reset
HCLK frequency range = 144 MHz to 168 MHz (180 MHz with over-drive).
This is the default mode at reset.

e Scale 2 (V12 voltage range limited to 1.20 to 1.32 V)

HCLK frequency range is up to 144 MHz (168 MHz with over-drive)

e Scale 3 (V12 voltage range limited to 1.08 to 1.20 V), default mode when exiting Stop
mode

HCLK frequency <120 MHz.

The voltage scaling is adjusted to fyc k frequency as follows:
e STM32F429x/39x MCUs:
— Scale 1: up to 168 MHz (up to 180 MHz with over-drive)
—  Scale 2: from 120 to 144 MHz (up to 168 MHz with over-drive)
—  Scale 3: up to 120 MHz.
e STM32F401x MCUs:
No Scale 1
—  Scale 2: from 60 to 84 MHz
—  Scale 3: up to 60 MHz.
e STM32F40x/41x MCUs:
— Scale 1: up to 168 MHz
—  Scale 2: up to 144 MHz

D.2.3 STM32LO0 series feature 3 Vcoorg ranges

e Range 1 (Vpp range limited to 1.71 to 3.6 V), with CPU running at a frequency up to
32 MHz

e Range 2 (full Vpp range), with a maximum CPU frequency of 16 MHz
e Range 3 (full Vpp range), with a maximum CPU frequency limited to 4.2 MHz.

3
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Appendix E STM32Cube embedded software packages

Along with STM32CubeMX C code generator, embedded software packages are part of
STM32Cube initiative (refer to DB2164 databrief): these packages include a low level
hardware abstraction layer (HAL) that covers the microcontroller hardware, together with an
extensive set of examples running on STMicroelectronics boards (see Figure 203). This set
of components is highly portable across the STM32 series. The packages are fully
compatible with STM32CubeMX generated C code.

Figure 203. STM32Cube Embedded Software package
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STM32CubeF0, STM32CubeF1, STM32CubeF2, STM32CubeF3, STM32CubeF4,
STM32Cubel0 and STM32CubelL 1 embedded software packages are available on st.com.
They are based on STM32Cube release v1.1 (other series will be introduced progressively)
and include the embedded software libraries used by STM32CubeMX for initialization C
code generation.

The user should use STM32CubeMX to generate the initialization C code and the examples
provided in the package to get started with STM32 application development.
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Revision history

Table 16. Document revision history

Date

Revision

Changes

17-Feb-2014

1

Initial release.

04-Apr-2014

Added support for STM32CubeF2 and STM32F2 series in cover page,
Section 2.2: Key features, Section 4.12.1: IP and Middleware
Configuration window, and Appendix E: STM32Cube embedded
software packages.

Updated Section 6.1: Creating a new STM32CubeMX Project,
Section 6.2: Configuring the MCU pinout, Section 6.6: Configuring the
MCU initialization parameters.

Section “Generating GPIO initialization C code move to Section 8:
Tutorial 3- Generating GPIO initialization C code (STM32F1 series
only) and content updated.

Added Section 9.4: Why do | get the error “Java 7 update 45’ when
installing ‘Java 7 update 45’ or a more recent version of the JRE?.

24-Apr-2014

Added support for STM32CubelL0 and STM32LO0 series in cover page,
Section 2.2: Key features, Section 2.3: Rules and limitations and
Section 4.12.1: IP and Middleware Configuration window

Added board selection in Table 3: File menu functions, Section 4.4.3:
Pinout menu and Section 4.2: New project window. Updated Table 5:
Pinout menu.

Updated Figure 92: Power Consumption Calculator default view and
added battery selection in Section 4.14.1: Building a power
consumption sequence.

Updated note in Section 4.14: Power Consumption Calculator (PCC)
view

Updated Section 6.1: Creating a new STM32CubeMX Project.
Added Section 9.5: Why does the RTC multiplexer remain inactive on
the Clock tree view?, Section 9.6: How can | select LSE and HSE as
clock source and change the frequency?, and Section 9.7: Why
STM32CubeMX does not allow me to configure PC13, PC14, PC15
and PI8 as outputs when one of them is already configured as an
output?.
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Table 16. Document revision history (continued)

Date

Revision

Changes

19-jun-2014

Added support for STM32CubeF0, STM32CubeF3, STM32F0 and
STM32F3 series in cover page, Section 2.2: Key features, Section 2.3:
Rules and limitations,

Added board selection capability and pin locking capability in

Section 2.2: Key features, Table 2: Welcome page shortcuts,

Section 4.2: New project window, Section 4.4: Toolbar and menus,
Section 4.7: Set unused / Reset used GPIOs windows, Section 4.8:
Project Settings window, and Section 4.11: Pinout view. Added
Section 4.11.5: Pinning and labeling signals on pins.

Updated Section 4.12: Configuration view and Section 4.13: Clock tree
configuration view and Section 4.14: Power Consumption Calculator
(PCC) view.

Updated Figure 23: STM32CubeMX Main window upon MCU selection,
Figure 38: Project Settings window, Figure 44: About window,

Figure 45: STM32CubeMX Pinout view, Figure 46: Chip view,

Figure 92: Power Consumption Calculator default view, Figure 93:
Battery selection, Figure 94: Building a power consumption sequence,
Figure 96: Power consumption sequence: new step default view,
Figure 104: Power Consumption Calculator view after sequence
building, Figure 105: Sequence table management functions,

Figure 88: PCC Edit Step window, Figure 83: Power consumption
sequence: new step configured (STM32F4 example), Figure 102: ADC
selected in Pinout view, Figure 103: PCC Step configuration window:
ADC enabled using import pinout, Figure 107: Description of the
Results area, Figure 108: Peripheral power consumption tooltip,
Figure 173: Power Consumption Calculation example, Figure 155:
Sequence table and Figure 156: Power Consumption Calculation
results.

Updated Figure 58: STM32CubeMX Configuration view and Figure 39:
STM32CubeMX Configuration view - STM32F1 series titles.

Added STM32L1 in Section 4.14: Power Consumption Calculator
(PCC) view.

Removed Figure Add a new step using the PCC panel from

Section 8.1.1: Adding a step. Removed Figure Add a new step to the
sequence from Section 4.14.2: Configuring a step in the power
sequence.

Updated Section 8.2: Reviewing results.

Updated appendix B.3.4: FatFs and Appendix D: STM32
microcontrollers power consumption parameters. Added Appendix
D.1.3: STM32L0 series and D.2.3: STM32L0 series feature 3 VCORE
ranges.
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Table 16. Document revision history (continued)

Date

Revision

Changes

19-Sep-2014

Added support for STM32Cubel 1 series in cover page, Section 2.2:
Key features, Section 2.3: Rules and limitations,

Updated Section 3.2.3: Uninstalling STM32CubeMX standalone
version.

Added off-line updates in Section 3.5: Getting STM32Cube updates,
modified Figure 16: New library Manager window, and Section 3.5.2:
Downloading new libraries.

Updated Section 4: STM32CubeMX User Interface introduction,
Table 2: Welcome page shortcuts and Section 4.2: New project
window.

Added Figure 22: New Project window - board selector.

Updated Figure 40: Project Settings Code Generator.

Modified step 3 in Section 4.8: Project Settings window.

Updated Figure 39: STM32CubeMX Configuration view - STM32F1
series.

Added STM32L1 in Section 4.12.1: IP and Middleware Configuration
window.

Updated Figure 70: GPIO Configuration window - GPIO selection;
Section 4.12.3: GPIO Configuration window and Figure 76: DMA
MemToMem configuration.

Updated introduction of Section 4.13: Clock tree configuration view.
Updated Section 4.13.1: Clock tree configuration functions and
Section 4.13.2: Recommendations, Section 4.14: Power Consumption
Calculator (PCC) view, Figure 96: Power consumption sequence: new
step default view, Figure 104: Power Consumption Calculator view after
sequence building, Figure 83: Power consumption sequence: new step
configured (STM32F4 example), and Figure 103: PCC Step
configuration window: ADC enabled using import pinout. Added

Figure 106: Power Consumption: Peripherals Consumption Chart and
updated Figure 108: Peripheral power consumption tooltip. Updated
Section 4.14.4: Power sequence step parameters glossary.

Updated Section 5: STM32CubeMX C Code generation overview.

Updated Section 6.1: Creating a new STM32CubeMX Project and
Section 6.2: Configuring the MCU pinout.

Added Section 7: Tutorial 2 - Example of FatFs on an SD card using
STM324291-EVAL evaluation board and updated Section 8: Tutorial 3-
Generating GPIO initialization C code (STM32F1 series only).

Updated Section 4.14.2: Configuring a step in the power sequence.
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Table 16. Document revision history (continued)

Date

Revision

Changes

19-Jan-2015

Complete project generation, power consumption calculation and clock
tree configuration now available on all STM32 series.

Updated Section 2.2: Key features and Section 2.3: Rules and
limitations.

Updated Eclipse IDEs in Section 3.1.3: Software requirements.

Updated Figure 12: Updater Settings window, Figure 16: New library
Manager window and Figure 22: New Project window - board selector,
Updated Section 4.8: Project Settings window and Section 4.9: Update
Manager windows.

Updated Figure 44: About window.

Removed Figure STM32CubeMX Configuration view - STM32F1
series.

Updated Table 9: STM32CubeMX Chip view - Icons and color scheme.
Updated Section 4.12.1: IP and Middleware Configuration window.

Updated Figure 74: Adding a new DMA request and Figure 76: DMA
MemToMem configuration.

Updated Section 4.13.1: Clock tree configuration functions.

Updated Figure 93: Battery selection, Figure 94: Building a power
consumption sequence, Figure 88: PCC Edit Step window.

Added Section 5.2: Custom code generation.

Updated Figure 126: Clock tree view and Figure 131: Configuration
view.

Updated peripheral configuration sequence and Figure 133: Timer
3 configuration window in Section 6.6.2: Configuring the peripherals .

Removed Tutorial 3: Generating GPIO initialization C code (STM32F1
series only).

Updated Figure 137: GPIO mode configuration.

Updated Figure 173: Power Consumption Calculation example and
Figure 155: Sequence table.

Updated Appendix A.1: Block consistency, A.2: Block inter-dependency
and A.3: One block = one peripheral mode.

Appendix A.4: Block remapping (STM32F10x only): updated Section :
Example .

Appendix A.6: Block shifting (only for STM32F10x and when “Keep
Current Signals placement” is unchecked): updated Section : Example

Updated Appendix A.8: Mapping a function individually .
Updated Appendix B.3.1: Overview.
Updated Appendix D.1.3: STM32L0 series.
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Table 16. Document revision history (continued)

Date

Revision

Changes

19-Mar-2015

Section 2.2: Key features: removed Pinout initialization C code
generation for STM32F 1 series from; updated Complete project
generation.

Updated Figure 16: New library Manager window, Figure 22: New
Project window - board selector.

Updated IDE list in Section 4.8: Project Settings window and modified
Figure 38: Project Settings window.

Updated Section 4.13.1: Clock tree configuration functions. Updated
Figure 88: STM32F429xx Clock Tree configuration view.

Section 4.14: Power Consumption Calculator (PCC) view: added
transition checker option. Updated Figure 92: Power Consumption
Calculator default view, Figure 93: Battery selection and Figure 94:
Building a power consumption sequence. Added Figure 98: Enabling
the transition checker option on an already configured sequence - all
transitions valid, Figure 99: Enabling the transition checker option on an
already configured sequence - at least one transition invalid and
Figure 100: Transition checker option -show log. Updated Figure 104:
Power Consumption Calculator view after sequence building. Updated
Section : Managing sequence steps, Section : Managing the whole
sequence (load, save and compare). Updated Figure 88: PCC Edit
Step window and Figure 107: Description of the Results area.
Updated Figure 173: Power Consumption Calculation example,
Figure 155: Sequence table, Figure 156: Power Consumption
Calculation results and Figure 158: Power consumption results - IP
consumption chart.

Updated Appendix B.3.1: Overview and B.3.5: FreeRTOS.

28-May-2015

Added Section 3.2.2: Installing STM32CubeMX from command line and
Section 3.4.2: Running STM32CubeMX in command-line mode.

09-Jul-2015

Added STLM32F7 and STM32L4 microcontroller series.

Added Import project feature. Added Import function in Table 3: File
menu functions. Added Section 4.6: Import Project window. Updated
Figure 96: Power consumption sequence: new step default view,
Figure 88: PCC Edit Step window, Figure 83: Power consumption
sequence: new step configured (STM32F4 example), Figure 103: PCC
Step configuration window: ADC enabled using import pinout and
Figure 108: Peripheral power consumption tooltip.

Updated command line to run STM32CubeMX in Section 3.4.2:
Running STM32CubeMX in command-line mode.

Updated note in Section 4.12: Configuration view.

Added new clock tree configuration functions in Section 4.13.1.
Updated Figure 139: FatFs disabled.

Modified code example in Appendix B.1: STM32CubeMX generated C
code and user sections.

Updated Appendix B.3.1: Overview.

Updated generated .h files in Appendix B.3.4: FatFs.
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Date

Revision

Changes

27-Aug-2015

10

Replace UM1742 by UM1940 in Section : Reference documents.

Updated command line to run STM32CubeMX in command-line mode
in Section 3.4.2: Running STM32CubeMX in command-line mode.
Modified Table 1: Command line summary.

Updated board selection in Section 4.2: New project window.
Updated Section 4.12: Configuration view overview. Updated

Section 4.12.1: IP and Middleware Configuration window,

Section 4.12.3: GPIO Configuration window and Section 4.12.4: DMA
Configuration window. Added Section 4.12.2: User Constants
configuration window.

Updated Section 4.13: Clock tree configuration view and added reserve
path.

Updated Section 6.1: Creating a new STM32CubeMX Project,

Section 6.5: Configuring the MCU Clock tree, Section 6.6: Configuring
the MCU initialization parameters, Section 6.7.2: Downloading firmware
package and generating the C code, Section 6.8: Building and updating
the C code project. Added Section 6.9: Switching to another MCU.
Updated Section 7: Tutorial 2 - Example of FatFs on an SD card using
STM32429I-EVAL evaluation board and replaced STM32F429I-EVAL
by STM32429I-EVAL.

16-Oct-2015

11

Updated Figure 16: New library Manager window and Section 3.5.4:
Checking for updates.

Character string constant supported in Section 4.12.2: User Constants
configuration window.

Updated Section 4.13: Clock tree configuration view.
Updated Section 4.14: Power Consumption Calculator (PCC) view.
Modified Figure 173: Power Consumption Calculation example.

Updated Section 8: Tutorial 3- Using PCC to optimize the embedded
application power consumption and more.

Added Eclipse Mars in Section 3.1.3: Software requirements

03-Dec-2015

12

Code generation options now supported by the Project settings menu.
Updated Section 3.1.3: Software requirements.

Added project settings in Section 4.6: Import Project window. Updated
Figure 30: Automatic project import; modified Manual project import
step and updated Figure 31: Manual project import and Figure 32:
Import Project menu - Try import with errors; modified third step of the
import sequence.

Updated Figure 89: Clock Tree configuration view with errors.

Added mxconstants.h in Section 5.1: Standard STM32Cube code
generation.

Updated Figure 173: Power Consumption Calculation example to
Figure 182: Step 10 optimization.

Updated Figure 183: PCC Sequence results after optimizations.
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Table 16. Document revision history (continued)

Date

Revision

Changes

03-Feb-2016

13

Updated Section 2.2: Key features:

— Information related to .ioc files.

— Clock tree configuration

— Automatic updates of STM32CubeMX and STM32Cube.

Updated limitation related to STM32CubeMX C code generation in
Section 2.3: Rules and limitations.

Added Linux in Section 3.1.1: Supported operating systems and
architectures. Updated Java Run Time Environment release number in
Section 3.1.3: Software requirements.

Updated Section 3.2.1: Installing STM32CubeMX standalone version,
Section 3.2.3: Uninstalling STM32CubeMX standalone version and
Section 3.3.1: Downloading STM32CubeMX plug-in installation
package.

Updated Section 3.4.1: Running STM32CubeMX as standalone
application.

Updated Section 4.8: Project Settings window and Section 4.9: Update
Manager windows.

Updated Section 4.11.5: Pinning and labeling signals on pins.
Added Section 4.11.6: Setting HAL timebase source

Updated Figure 59: Configuration window tabs for GPIO, DMA and
NVIC settings (STM32F4 series).

Added note related to GPIO configuration in output mode in
Section 4.12.3: GPIO Configuration window; updated Figure 70: GPIO
Configuration window - GPIO selection.

Modified Figure 92: Power Consumption Calculator default view,
Figure 94: Building a power consumption sequence, Figure 95: Step
management functions, Figure 98: Enabling the transition checker
option on an already configured sequence - all transitions valid,
Figure 99: Enabling the transition checker option on an already
configured sequence - at least one transition invalid.

Added import pinout button icon in Section : Importing pinout.
Added Section : Selecting/deselecting all peripherals. Modified
Figure 104: Power Consumption Calculator view after sequence
building. Updated Section : Managing the whole sequence (load, save
and compare). Updated Figure 107: Description of the Results area
and Figure 108: Peripheral power consumption tooltip.

Updated Figure 173: Power Consumption Calculation example and
Figure 175: PCC Sequence table.

Updated Section 5.2: Custom code generation.

Updated Figure 118: Pinout view with MCUs selection and Figure 119:
Pinout view without MCUs selection window in Section 6.1: Creating a
new STM32CubeMX Project.

Updated Section 6.6.2: Configuring the peripherals .

Updated Figure 145: Project Settings and toolchain choice and

Figure 146: Project Settings menu - Code Generator tab in

Section 6.7.1: Setting project options, and Figure 147: Missing firmware
package warning message in Section 6.7.2: Downloading firmware
package and generating the C code.
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Table 16. Document revision history (continued)

Date

Revision

Changes

15-Mar-2016

14

Upgraded STM32CubeMX released number to 4.14.0.

Added import of previously saved projects and generation of user files
from templates in Section 2.2: Key features.

Added MacOS in Section 3.1.1: Supported operating systems and
architectures, Section 3.2.1: Installing STM32CubeMX standalone
version, Section 3.2.3: Uninstalling STM32CubeMX standalone version
and Section 3.4.3: Running STM32CubeMX plug-in from Eclipse IDE.
Added command lines allowing the generation of user files from
templates in Section 3.4.2: Running STM32CubeMX in command-line
mode.

Updated new library installation sequence in Section 3.5.1: Updater
configuration.

Updated Figure 26: Pinout menus (Pinout tab selected) and Figure 27:
Pinout menus (Pinout tab not selected) in Section 4.4.3: Pinout menu.
Modified Table 6: Window menu.

Updated Section 4.5: Output windows.

Updated Figure 38: Project Settings window and Section 4.8.1: Project
tab.

Updated Figure 55: NVIC settings when using systick as HAL
timebase, no FreeRTOS and Figure 56: NVIC settings when using
FreeRTOS and SysTick as HAL timebase in Section 4.11.6: Setting
HAL timebase source.

Updated Figure 61: User Constants window and Figure 62: Extract of
the generated mxconstants.h file in Section 4.12.2: User Constants
configuration window.

Section 4.12.3: GPIO Configuration window: updated Figure 71: GPIO
Configuration window - displaying GPIO settings, Figure 72: GPIO
configuration grouped by IP and Figure 73: Multiple Pins Configuration.
Updated Section 4.12.5: NVIC Configuration window.

18-May-2016

15

Import project function is no more limited to MCUs of the same series
(see Section 2.2: Key features, Section 4.4.1: File menu and
Section 4.6: Import Project window ).

Updated command lines in Section 3.4.2: Running STM32CubeMX in
command-line mode.

Table 1: Command line summary: modified all examples related to
config comands as well as set dest_path <path> example.

Added caution note for Load Project menu in Table 3: File menu
functions.

Updated Generate Code menu description in Table 4: Project menu.
Updated Set unused GPIOs menu in Table 5: Pinout menu.

Added case where FreeRTOS in enabled in Section : Enabling
interruptions using the NVIC tab view.

Added Section 4.12.6: FreeRTOS middleware configuration view.
Updated Appendix B.3.5: FreeRTOS and B.3.6: LwIP .
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